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Change History
DateSeeChange

February, 2020Initial Release of Document for Release 12.5

Cisco Webex Experience
Management Integration chapter

Information on how to configure Cisco Webex
Experience Management

Customer Virtual Assistant chapterInformation on how to configure CustomerVirtual
Assistant feature

About This Guide
This guide explains features you can use in conjunction with Cisco Hosted Collaboration Solution for Contact
Center for Contact Center. For each feature, there is a description, procedures for initial setup, and details on
the functionality the feature provides.

Audience
This document is prepared for:

• Contact center administrators who configure and run the contact center, manage agents and supervisors,
and address operational issues.
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• Contact center supervisors, who lead agent teams and are responsible for team performance

This document is written with the understanding that your system has been deployed by a partner or service
provider who has validated the deployment type, virtual machines, and database and has verified that your
contact center can receive and send calls.

Related Documents
LinkDocument or resource

https://www.cisco.com/c/en/us/support/unified-communications/
hosted-collaboration-solution-contact-center/
products-documentation-roadmaps-list.html

Documentation Guide for Cisco Hosted
Collaboration Solutions for Contact
Center

https://www.cisco.com/c/en/us/support/unified-communications/
hosted-collaboration-solution-contact-center/
products-implementation-design-guides-list.html

Solution Design Guide for Cisco Hosted
Collaboration Solutions for Contact
Center

https://www.cisco.com/c/en/us/support/unified-communications/
hosted-collaboration-solution-contact-center/
products-installation-guides-list.html

Configuration Guide for Cisco Hosted
Collaboration Solutions for Contact
Center

https://www.cisco.com/c/en/us/support/unified-communications/
hosted-collaboration-solution-contact-center/
products-release-notes-list.html

Release Notes for Cisco Hosted
Collaboration Solutions for Contact
Center

Communications, Services, and Additional Information
• To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.

• To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.

• To submit a service request, visit Cisco Support.

• To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit
Cisco Marketplace.

• To obtain general networking, training, and certification titles, visit Cisco Press.

• To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides
you with detailed defect information about your products and software.
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Field Notice
Cisco publishes Field Notices to notify customers and partners about significant issues in Cisco products that
typically require an upgrade, workaround, or other user action. For more information, see Product Field Notice
Summary at https://www.cisco.com/c/en/us/support/web/tsd-products-field-notice-summary.html.

You can create custom subscriptions for Cisco products, series, or software to receive email alerts or consume
RSS feeds when new announcements are released for the following notices:

• Cisco Security Advisories

• Field Notices

• End-of-Sale or Support Announcements

• Software Updates

• Updates to Known Bugs

For more information on creating custom subscriptions, see My Notifications at https://cway.cisco.com/
mynotifications.

Documentation Feedback
To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback@cisco.com

We appreciate your comments.

Conventions
This document uses the following conventions:

DescriptionConvention

Boldface font is used to indicate commands, such as user entries, keys, buttons,
folder names, and submenu names.

For example:

• Choose Edit > Find.

• Click Finish.

boldface font
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DescriptionConvention

Italic font is used to indicate the following:

• To introduce a new term. Example: A skill group is a collection of agents
who share similar skills.

• A syntax value that the user must replace. Example: IF (condition, true-value,
false-value)

• A book title. Example: See the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide.

italic font

Window font, such as Courier, is used for the following:

• Text as it appears in code or that the window displays. Example:
<html><title>Cisco Systems, Inc. </title></html>

window font

Angle brackets are used to indicate the following:

• For arguments where the context does not allow italic, such as ASCII output.

• A character string that the user enters but that does not appear on the window
such as a password.

< >

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
xvi

Preface
Preface



C H A P T E R 1
A-law Codec

• Configure Gateway, on page 1
• Configure Unified CVP, on page 3
• Configure Unified Communication Manager, on page 5

Configure Gateway
• Configure Ingress Gateway, on page 1

• Configure VXML Gateway, on page 2

Configure Ingress Gateway

Procedure

Step 1 Add the voice class codec 1 to set the codec preference in dial-peer:

Example:
voice class codec 1

codec preference 1 g729r8
codec preference 2 g711alaw
codec preference 3 g711ulaw

dial-peer voice 70021 voip
description Used for Switch leg SIP Direct
preference 1
max-conn 225
destination-pattern xxxx...... # Customer specific destination
session protocol sipv2
session target ipv4:###.###.###.### # IP Address for Unified CVP
session transport tcp
voice class codec 1
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
no vad

Step 2 Modify the dial-peer to specify the codec explicitly for a dial-peer:

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
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dial-peer voice 9 voip
description For Outbound Call for Customer
destination-pattern <Customer Phone Number Pattern>
session protocol sipv2
session target ipv4:<Customer SIP Cloud IP Address>
session transport tcp
voice-class sip rel1xx supported "100rel"
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 10 voip
description ***To CUCM Agent Extension For Outbound***
destination-pattern <Agent Extension Pattern to CUCM>
session protocol sipv2
session target ipv4:<CUCM IP Address>
voice-class sip rel1xx supported "100rel"
dtmf-relay rtp-nte
codec g711alaw

Configure VXML Gateway

Procedure

Modify the following dial-peer to specify the codec explicitly for a dial-peer:
dial-peer voice 919191 voip

description Unified CVP SIP ringtone dial-peer
service ringtone
incoming called-number 9191T
voice-class sip rel1xx disable
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 929292 voip
description CVP SIP error dial-peer
service cvperror
incoming called-number 9292T
voice-class sip rel1xx disable
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 7777 voip
description Used for VRU leg #Configure VXML leg where the incoming called
service bootstrap
incoming called-number 7777T
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 5 voip
description for SIP TTS Media Call
preference 1
session protocol sipv2
session target ipv4: <ASR primary server IP>
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destination uri tts
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 6 voip
description for SIP ASR Media Call
preference 1
session protocol sipv2
session target ipv4: <TTS primary server IP>
destination uri asr
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 7 voip
description for SIP TTS Media Call
preference 2
session protocol sipv2
session target ipv4: <ASR secondary server IP>
destination uri tts
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 8 voip
description for SIP ASR Media Call
preference 2
session protocol sipv2
session target ipv4: <TTS secondary server IP>
destination uri asr
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g711alaw
no vad

Configure Unified CVP
Unified CVP does not require any specific configuration in OAMP.

You must convert the following files to A-law:

1. C:\inetpub\wwwroot\en-us\app
2. C:\inetpub\wwwroot\en-us\app\ag_gr
3. C:\inetpub\wwwroot\en-us\sys
4. C:\Cisco\CVP\OPSConsoleServer\GWDownloads in OAMP server
5. C:\Cisco\CVP\VXMLServer\Tomcat\webapps\CVP\audio
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• After converting the files in the OAMP server, access the Unified CVP OAMP page to upload the newly
converted A-law files to the gateway.

• If gateways are previously used for u-law, then restart the gateway to clear the u-law files in the gateway
cache.

Note

Complete the following procedure to convert mu-law audio files to a-law format:

Procedure

Step 1 Copy the wav file from Unified CVP to your local desktop.
Step 2 Go to All programs > Accessories > Entertainment.
Step 3 Open the Sound Recorder.
Step 4 Select File and click Open.
Step 5 Browse for the mu-law audio file and click Open.
Step 6 Go to Properties.
Step 7 Click Convert Now.
Step 8 Select CCITT A-Law from Format.
Step 9 Click OK.
Step 10 Select Files > Save As and provide a filename.
Step 11 Copy the new a-law format file into the following directory of media server:

C:\inetpub\wwwroot\en-us\app

Enable Recording for Agent Greeting and Courtesy Callback
Complete the following procedure to enable recording for Agent Greeting and Courtesy Callback.

Procedure

Step 1 Open the call studio and go to the callback entry application.
Step 2 Double-click app.callflow.
Step 3 Go to Record Name element settings and change the File Type to other (default is wav).
Step 4 Set the MIME type to audio/x-alaw-basic.
Step 5 Set the File extension as wav

Step 6 Validate, save, and deploy the application.
Step 7 Restart the Unified CVP services.
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Configure Unified Communication Manager
Complete the following procedure to provision a-Law through Cisco Unified Communications Manager:

Procedure

Step 1 Login to the Cisco Unified Communication Manager Administration page.
Step 2 Navigate to System > Service Parameter.
Step 3 Choose publisher server from Server drop-down list.
Step 4 Choose Cisco CallManager (Active) from Service drop-down list.
Step 5 In ClusterWide Parameters (System - Location and region), choose Enabled for All Devices from G.711

A-law Codec Enabled drop-down list.
Step 6 Choose Disable from following drop-down lists:

• G.711 mu-law Codec Enabled

• G.722 Codec Enabled

• iLBC Codec Enabled

• iSAC Codec Enabled

Step 7 Click Save.
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C H A P T E R 2
Agent Request

• Agent Request Feature Description, on page 7
• Configure Unified CCE for Agent Request, on page 10
• Configure Customer Collaboration Platform for a Voice Callback Agent Request, on page 12
• Agent Request Script, on page 14
• Use the Sample Code to Create a Customer Callback Request, on page 16
• Agent Request Reporting, on page 17

Agent Request Feature Description
The Agent Request feature allows a customer to initiate a request on the web that results in a call from an
agent.

To use Agent Request, your solution requires the Cisco Customer Collaboration Platform optional component.
Cisco Customer Collaboration Platform works in a Contact Center Enterprise (Unified CCE) solution to
process the request from its inception through the delivery of the callback.

The Agent Request feature can be used only if the customer or a partner develops a custom application. There
is sample code on DevNet (formerly Cisco Developer Network) that you can use to understand how to start
building your custom application to submit callback requests to Customer Collaboration Platform.

Important

Customer Collaboration Platform and Agent Request

Customer Collaboration Platform provides the Callback API used by a custom application to request a phone
call from a contact center agent.

The API works in conjunction with Customer Collaboration Platform callback feeds, campaigns, and
notifications to pass callback requests to the contact center for routing.

The Callback API:

• Allows custom applications to initiate a callback.

• Forwards the callback request and callback details to Unified CCE using a notification mechanism (the
Connection to Unified CCE notification type) through a Media Routing (MR) connection.
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• Allows custom applications to retrieve the state of the callback as well as the estimated wait time (EWT)
until an agent becomes available.

• Allows custom applications to cancel a requested callback.

The Callback API supports the use of Call variables and ECC variables for callback requests. Call variables
and ECC variables send customer-specific information with the request. When you create a callback contact,
the social contact associated with the callback contact includes all of the specified variables as extension
fields.

Unified CCE and Agent Request

When it receives an Agent Request, Unified CCE performs these tasks:

• Process the callback request.

• Route the callback request to an agent and place a call from the agent's phone to the customer.

• Notify Customer Collaboration Platform that the agent has been selected.

Agent Desktops and Agent Request

Cisco Finesse supports Agent Request.

Enterprise Chat and Email and Agent Request

To configure prefixes and filters for dialed numbers in Enterprise Chat and Email, you must use the Unified
CCE Script Editor.

Agent Request Prerequisites
The customer or partner must build a custom application for the Agent Request feature. See Use the Sample
Code to Create a Customer Callback Request, on page 16.

Customer Collaboration Platform is always deployed in aDMZ. Remember to open the port you have configured
for the MR PG. See Set up the Media Routing PG and PIM, on page 11.

Agent Request Call Flow
The flow proceeds as follows:

1. The customer application initiates an agent request by requesting a callback.

2. A call is initiated from the agent's phone, on behalf of the agent, dialing the customer's phone number.

The agent does not control when the call is placed.Note
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Figure 1: Agent Request Call Flow

Agent Request Scenarios
1. From the web, the customer requests to speak to an agent.

2. The customer receives feedback that the request is accepted.

3. The customer receives feedback that the call is queued and the estimated wait time.

4. The customer receives feedback that a call is on its way.

5. The agent's phone places an outbound call.

6. The agent is presented with call context.

ThenIf

The customer receives and answers the call, and speaks to the
agent

The customer is available

The agent receives a busy toneThe customer is busy when the callback
occurs

The agent hears ringingThe customer does not answer when the
callback occurs
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ThenIf

There is no impact on the agentThe customer cancels the callback before
an agent is selected

Configure Unified CCE for Agent Request
The following information describes how to configure Agent Request for a Unified CCE deployment.

Configure Unified CCE before you configure Customer Collaboration Platform.Important

Configuration Manager
Use these Configuration Manager tools and procedures to configure Agent Request.

Configure Network VRU and Network VRU Script

Procedure

Step 1 In the Configuration Manager, use the Network VRU Explorer tool to configure and save a type 2 VRU. The
Network VRU is used to queue voice callback tasks if an agent is not available to handle them.

Step 2 In the Configuration Manager, use the Network VRU Script List tool to add a Network VRU Script that
references the Network VRU that you configured in Step 1.
The Network VRU Script is used for Estimated Wait Time.

Configure the Media Routing PG and PIM

Procedure

Step 1 In Configuration Manager, open the PG Explorer tool to configure a media routing PG.
Step 2 Create a media routing PIM and routing client for Customer Collaboration Platform.

Write down the Logical Controller ID and the Peripheral ID. You will use them when you set up the PG.

Step 3 On the Peripheral tab in the PG Explorer tool, check the Enable post routing check box.
Step 4 On the Routing Client tab in the PG Explorer tool, select the Multichannel option from the Routing Type

drop-down list box.
Step 5 On the Advanced tab in the PG Explorer tool, select the type 2 Network VRU that you created.
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Configure Call Type

Procedure

Open the Call Type List tool, and create a call type to handle calls from an agent request voice callback.

Configure Dialed Number/Script Selector

Procedure

Step 1 Open the Dialed Number/Script Selector List tool, and create a script selector on the routing client that you
configured. Customer Collaboration Platform uses this script selector to request agents for voice callback.
(The script selector configured here must be the same as the one entered in the Customer Collaboration
Platform notification.)

Step 2 On the Attributes tab, select Cisco_Voice from the Media routing domain drop-down list box.
Step 3 On the Dialed Number Mapping tab, map the script selector to the call type you created.

Configure ECC Variables

Procedure

Step 1 Open the Expanded Call Variable List tool.
Step 2 Add one or more ECC Variables for the callback request.

Arrays are not supported with the Agent Request feature.

CCE solutions support the Latin 1 character set only for Expanded Call Context variables and
Call variables when used with CVP, Finesse, and Customer Collaboration Platform. CCE also
supports the use of multi-byte character sets in limited usage for ECC and call variables when
setting them in Script Editor using double quotes.

Note

Set up the Media Routing PG and PIM

Procedure

Step 1 From Cisco Unified CCE Tools, select Peripheral Gateway Setup.
Step 2 In the Peripheral Gateways Properties screen, click Media Routing. Click Next.
Step 3 Click Yes at the prompt to stop the service.
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Step 4 From the Peripheral Gateway Component Properties screen, click Add, select the next PIM, and configure
with the Client Type of Media Routing as follows.
a) Check Enabled.
b) In the Peripheral Name field, enter MR.
c) For Application Hostname (1), enter the hostname or IP address of Customer Collaboration Platform.

The system does not support IP address change. Use the hostname if you foresee a change
in IP address. This is applicable for all the Hostname/ IP Address fields.

Note

d) By default, Customer Collaboration Platform accepts the MR connection on Application Connection
Port 38001. The Application Connection Port setting on Customer Collaboration Platform must match
the setting on the MR PG; if you change the port on one side of the connection, you must change it on
the other side.

e) Leave the Application Hostname (2), field blank.
f) Keep all other values.
g) Click OK.

Step 5 Accept defaults and click Next until the Setup Complete screen opens.
Step 6 At the Setup Complete screen, check Yes to start the service. Click Finish.
Step 7 Click Exit Setup.
Step 8 Repeat from Step 1 for Side B.
Step 9 Navigate to Unified CCE Administration > Infrastructure Settings > Inventory.
Step 10 Add Customer Collaboration Platform as an external machine.

a) Select Customer Collaboration Platform from the drop-down list.
b) Enter the required information.
c) Click Save.
The system automatically enables and completes theCCE Configuration for Multichannel Routing settings
in Customer Collaboration PlatformAdministration, including theApplication Connection Port you specified.

Configure Customer Collaboration Platform for a Voice Callback
Agent Request

To support a callback request, Customer Collaboration Platform must be configured with:

• A callback feed

• A campaign

• A Connection to CCE notification configured for the campaign mentioned above that will be triggered
by incoming callback requests with a matching tag.
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Create Feed

Procedure

Step 1 Sign in to Customer Collaboration Platform.
Step 2 Click Configuration.
Step 3 On the Manage Feeds panel, click New.
Step 4 For Type, select Callback.
Step 5 Name the feed.
Step 6 For Reply Template, retain the default, No reply template.
Step 7 Configure the feed to automatically tag all callback requests that come in on that feed. For example, autotag

with 'sendtocontactcenter'.
Make a note of the tag. It is used to trigger the notification to CCE.

Step 8 Click Save.

Create Campaign

Procedure

Step 1 Sign in to Customer Collaboration Platform.
Step 2 Click Configuration.
Step 3 On the Manage Campaigns panel, click New.
Step 4 Name the campaign.
Step 5 Enter an optional description.
Step 6 Make no selection in the Chat Invitation Feed drop-down list.
Step 7 Locate the Callback feed in the Available panel and move it to Selected.
Step 8 Click Save.

Create Notification

Procedure

Step 1 Sign in to Customer Collaboration Platform.
Step 2 Click Administration.
Step 3 On the Manage Notifications panel, click New.
Step 4 For Type, select Connection to CCE.
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Step 5 Name the notification.
Step 6 From the Campaigns drop-down list, select the campaign that you created for the callback.
Step 7 In the Tags field, enter the tag that is automatically applied to callback requests by the feed. In our example

'sendtocontactcenter'.
Step 8 For Request Type, select Callback.
Step 9 In the Dialed Number/Script Selector field, enter the dialed number string that you have configured.

Step 10 Click Save.

Agent Request Script
The Agent Request Script is used to implement an optional dial-plan, queue a call to the skill group node, and
calculate the estimated wait time for a voice callback to a customer.

A customer who requests a voice callback might want to know approximately how long it will be before the
call is returned. You can configure voice callback to provide an estimate of the wait time back to the customer.
The estimated wait time is calculated once, when the call enters the queue. The time is not updated as the
position in the queue changes.

The default estimated wait time algorithm is based on a running five minute window of the rate of calls leaving
the queue. Any calls that are routed or abandoned during the first five minutes are taken into account as part
of the rate leaving queue. For Precision Queues, the rate leaving queue represents the rate at which calls are
delivered or abandoned from the entire Precision queue, not any individual Precision Queue steps. The
algorithm computes the wait time for each of the queues against which the call is queued (Skill Groups or
Precision Queues) and then returns the minimum estimated wait time. Queue to Agent is not supported.

While the queue builds, the small number of calls in the queue makes the estimated wait time less accurate
and the value fluctuates rapidly. As the queue operates with more calls over time, the estimated wait time is
more accurate and consistent.

The built-in function also applies to inbound calls that queue.Note
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Create Agent Request Script
To create a Agent Request script:

Procedure

Step 1 Start node: Create the Start node by selecting a new Routing Script from the Script Editor.
Step 2 Set Variable (Call.Calling Line ID) node: (optional). If required, you can set the CallingLineID (CLID/

ANI) variable to implement a "dial-plan," pre-pending a set of digits to the phone number provided by the
customer so that it can be correctly routed. For example, it is often necessary to add 9 to the phone number
to reach an outside line. In other cases, more pre-pended digits may be required to reach the end customer.

You can also set up Unified Communications Manager Route Patterns to respond to a certain set of digits by
routing the call to an outside line with a specified area code. To implement a dial-plan, add a Set Variable
node before the queue, as shown in this example. In this case, a 9 is pre-pended to the customer phone number
using the built-in concatenate function.

Step 3 Queue to Skill Group node: The Agent Request call can be queued against one or more Skill Groups,
Precision Queues, or a queue-to-agent node. In the example script, the call is queued against a single skill
group.

Step 4 Set Variable (Call.Estimated Wait Time) node: Set the Call Wait time as follows:
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a) From the Set Variable node, select Call from the Object type drop-down menu.
b) From the Variable drop-down menu, choose Estimated Wait Time(). You can then work with the

Formula Editor to use the default estimated wait value or create a formula and use your own value.
c) Click Formula Editor. You can either use the default estimated wait value, by clicking the Built-In

Functions tab and choosing EstimatedWaitTime() . Or to create a formula and use your own estimated
time value, click the Variables tab, and choose an entry in the Object type list and Object list. Then
double-click a variable in the Variable list.

Step 5 Run Ext Script node: Apply the Network VRU script as follows:
a) Click the Queue tab.
b) Click Run External Script.
c) Click inside the script. A Run External Script node appears.
d) Double-click the node and choose the Network VRU script from the list and then click OK. The call

variable Estimated Wait Time now contains a value in the EstimatedWaitTime field and can be passed
to peripherals.

Note that a Run External Script node is required to send the EstimatedWaitTime to Customer Collaboration
Platform.

Step 6 Wait node: The wait period for an agent becomes available.
Step 7 End node: The script ends if no agent becomes available.

Use the Sample Code to Create a Customer Callback Request
Cisco Systems has made sample callback application code available to use as a baseline in building your own
application. This sample includes retrieving and displaying the estimated wait time, assuming it has been
configured in Unified CCE. You can find the sample code on DevNet.

You cannot copy and paste this code to achieve a working application. It is a only a guideline.Note

For more information about how to use the Callback API, see the Cisco Customer Collaboration Platform
Developer Guide.

Procedure

Step 1 Retrieve the feed id by entering this URL in a browser: https://<Customer Collaboration
Platform_Hostname_or_Ip>/ccp-webapp/ccp/feed.

In the example output below, note that the value in the <name> field is "Callback." Look for the number of
the feed id identified at the end of the refURL path (in this case, it is 100000) just before the </refURL> tag.
Copy this number.

<feeds>
<Feed>
<changeStamp>0</changeStamp>
<name>Callback</name>
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<pushFeedURL>https://128.107.81.27/ccp/callback/feed/100000</pushFeedURL>
<refURL>https://128.107.81.27/ccp-webapp/ccp/feed/100000</refURL>
<status>1</status>
<tags>
<tag>trial</tag>
</tags>
<type>10</type>
</Feed>
</feeds>

Step 2 Access the sample application from DevNet: https://developer.cisco.com.
Step 3 Enter values in the fields:

• Title: A title or subject for the callback request.

• Author: The name of the person submitting the callback request.

• Phone: The phone number to call back.

• Feed Id: The value from the refURL above.

Step 4 Click Call me back.

Agent Request Reporting
Cisco Unified Intelligence Center CCE reports include data for Agent Requests

Agent requests that fail before being routed to CCE will not be included in the CCE solution-level reports.
The Customer Collaboration Platform search function can be used to identify these requests.

Note

Call Type and Call Type Skill Group Metrics

• Calls Offered — Incremented when Call Type is entered (through Script Selector or Call Type node).

• Calls Abandoned in Queue —Incrementedwhen aQueued Callback request is canceled by the customer
prior to when an Agent is selected to handle the Voice Callback call.

• Calls Answered — Incremented if the call is placed from the agent and represents work accepted by the
agent.

• Calls Handled — Incremented if the customer answers the call. Calls Answered minus Calls Handled
indicates how many calls failed to reach the intended customer.

• Service Level Offered—Incremented for all routed calls, including voice callback calls initiated through
the agent request API.

• ServiceLevelCalls — Incremented if the call is presented to the agent within a service level.

• Answer Intervals (1 - 10) — The appropriate bucket is incremented based on how long the call was in
the queue.
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Skill Group Metrics

Call Type Skill Group and Skill Group metrics are not counted in the same way. The skill group metric treats
each call as agent-initiated; therefore, Calls Answered and Calls Handled are not incremented.
AgentOutCallsTime, AgentOutCalls, AgentOutCallsTalkTime, AgentOutCallsOnHold, and
AgentOutCallsOnHoldTime are incremented.

Agent Real Time

The direction in the Agent Real Time table is listed as Outbound.

Termination Call Detail

For custom reporting, the Termination Call Detail records contain a PeripheralCallType of 41 -Voice Callback.

Calls which do not successfully connect to a customer have a call disposition of 10 - Disconnect/Drop no
answer. This includes agent request calls to busy numbers.
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C H A P T E R 3
Agent Greeting

• Capabilities, on page 19
• Configure Agent Greeting, on page 22
• Reporting, on page 33
• Serviceability, on page 34

Capabilities
With Agent Greeting, you can play a configurable, automated greeting to callers. Every caller receives a clear,
well-paced, language-appropriate, and enthusiastic introduction from the answering agent. Agent Greeting
relieves your agents from speaking opening scripts. Instead, your agents can spends the time reviewing the
desktop screen pop-ups while the greeting plays.

Recording a greeting is much the same as recording a message for voice mail. Depending on how you set up
the call center, agents record different greetings that play for different types of callers (for example, an English
greeting for English speakers or an Italian greeting for Italian speakers).

Agent Greeting is available to agents and supervisors who use IP Phones with Built-in-Bridge (BiB) that are
controlled by the Unified CCE and Unified CM.

Figure 2: Agent Greeting
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Agent Greeting Phone Requirements for Local Agents
Agent Greeting is available to agents and supervisors who use IP Phones with Built-In Bridge (BIB). These
agents are typically located within a contact center. Phones used with Agent Greeting must meet these
requirements:

• The phones must have the BIB feature.

If you disable BIB, the system attempts to use a conference bridge for agent
greeting call flow and raises a warning event.

Note

• Ensure that the phone's firmware is up to date. (Usually, phone firmware upgrades automatically when
you upgrade your Unified CM installation.)

• For a list of supported phones for contact center enterprise solutions, see the Compatibility Matrix for
your solution at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-device-support-tables-list.html.

Agent Greeting Call Flows
Figure 3: Agent Greeting Call Flow

1. The incoming call arrives from CUBE or a TDM gateway at CVP.

2. CVP sends the incoming call to Unified CCE.

3. Unified CCE instructs CVP to queue the call.
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4. CVP sends the call to the Voice Browser for VRU treatment.

5. When an agent is available, Unified CCE sends the agent number to CVP.

6. CVP sends the call to Unified CM.

7. Unified CM establishes the connection to the agent phone.

8. The caller connects to the agent phone and stops hearing the ringback.

9. Unified CCE determines which CVP to invoke, and instructs Unified CM to tell the phone BIB to open
a stream to CVP.

10. Unified CCE and CVP shake hands to set the trigger for CVP to let it know which greeting to play.

11. CVP instructs the Voice Browser to have the Media Server play the greeting.

12. The phone's BIB mixes the greeting. After the greeting plays, CVP disconnects and the agent speaks
with the caller.

Agent Greeting Considerations
Consider these points when you add Agent Greeting to your solution:

• Agent Greeting does not support outbound calls made by an agent. The announcement plays for inbound
calls only.

• Only one Agent Greeting file plays per call.

• Supervisors cannot listen to agent recorded greetings.

• Agent Greetings do not play when the router selects the agent through a label node.

• Agent Greeting supports Unified CM-based Silent Monitoring with this exception: Supervisors cannot
hear the greetings themselves. If a supervisor starts a silent monitoring session while a greeting plays, a
message appears that a greeting is playing and to try again shortly.

• Use either G.711 a-law or mu-law for the VRU leg on the Voice Browser dial-peer. Do not use the
voice-class codec.

• In general, Agent Greeting feature requires shorter latency across the system. For example, the public
network has a maximum round-trip latency of 100 ms to support Agent Greeting feature as designed.

Agent Greeting requires the following:

• The phones have the BIB feature.

• The phones must run the latest firmware version delivered with Unified Communications Manager.

• The phones must be have BIB enabled in Unified Communications Manager.

Agent Greeting with Whisper Announcement

You can use Agent Greeting with theWhisper Announcement feature. Consider these points when using them
together:

• The Whisper Announcement always plays first.
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• To shorten your call-handling time, use shorter Whisper Announcements and Agent Greetings than if
you were using either feature by itself. A longWhisper Announcement followed by a long Agent Greeting
equals a long wait before an agent actively handles a call.

• If you use a Whisper Announcement, your agents probably handle different types of calls: for example,
“English-Gold Member-Activate Card,” “English-Gold Member-Report Lost Card,” “English-Platinum
Member-Account Inquiry.” Ensure that greetings your agents record are generic enough to cover the
range of call types.

Configure Agent Greeting
This section describes how to deploy and configure the Agent Greeting feature.

Initial Setup

Configuration Requirements
The following configuration components must be in place to deploy Agent Greeting.

WhatWhere

For phones that use Agent Greeting, you must set the Built-in-Bridge option to On or Default (if the value of Default is On). To verify, in Unified CM
Administration, select Device > Phone > Built in Bridge.

Unified Communications Manager

Agent Greeting is supported with Type 10 Network VRUs only. (Type 10 is required to allow CVP to control the call). If your current Unified CCE deployment
is not configured for a Type 10 VRU, you must modify it accordingly.

Agent Greeting requires at minimum three expanded call variables.

• user.microapp.ToExtVXML: This is used twice in an Agent Greeting record script: the first time is to queue the Unified CVP RecordAgentGreeting
application; the second time is to tell the recording application where to save greeting files. Configure it as an array with size 3.

Use the Unified CCE Administration tool to ensure this variable includes these settings: Maximum Length - 100 and Enabled.

• user.microapp.app_media_lib:This is required in Agent Greeting record and play scripts to specify the dedicated directory on the media server where your
greeting audio files are stored. Maximum Length - 100 and Enabled.

• user.microapp.input_type: This is required in Agent Greeting record scripts to limit the allowable input type to DTMF.MaximumLength - 100 and Enabled.

No other ECC (Expanded Call Variable) are needed if you serve your files from the Unified CVP default media server, and your files are in the media server
default locale directory ("<web_server_root>\en-us\app"). However, if you store your files in a location other than these defaults, you must use one or more of
the ECC in the next row in your scripts.

Unified CCE

To make these variables available to your script authors, confirm that they are defined in the Unified CCE Administration tool. For instructions about defining
ECC variables for CVP, see the Administration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-customer-voice-portal/tsd-products-support-series-home.html.

• user.microapp.media_server: Use to identify the Unified CVP media server if it is other than the default.

• user.microapp.locale: Use to specify the name of the locale directory on the media server if it is other than the default (“en-us”).

• user.microapp.UseVXMLParams: Required in your record script if you include the user.microapp.media_server variable. It tells the external VXML
recording script to use the name/value pair of the application that you pass in the user.microapp.ToExtVXML variable.

Unified CCE (optional variables, used to override
defaults)
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WhatWhere

Unified CVP Server must be installed and configured. as described in the Installing and Upgrading Guide for Cisco Hosted Collaboration Solution for Contact
Center at https://www.cisco.com/c/en/us/support/unified-communications/hosted-collaboration-solution-contact-center/products-installation-guides-list.html

Unified CVP

Agent Greeting Deployment Tasks

Procedure

Step 1 Ensure your system meets the baseline requirements for software, hardware, and configuration described in
the System Requirements and Limitations section.

Step 2 Configure IIS and FTP on Media Server.
Step 3 In Unified CVP, add media servers, configure FTP connection information, and deploy the media servers.
Step 4 Configure a Unified CVP media server, if you have not already done so. See Configure Unified CVP Media

Server, on page 26.
Step 5 In Unified CVP Operations Console, republish the VXML Gateway.tcl scripts with updated Agent Greeting

support. See Republish the tcl scripts to VXML Gateway, on page 23 for Agent Greeting support.
Step 6 Set the cache size on the VXML Gateway. See Set Cache Size on VXML Gateway, on page 24.
Step 7 Record the voice prompts to play to agents when they record a greeting and to deploy the audio files to your

media server, see Create Voice Prompts for Recording Greetings, on page 25.
Step 8 Configure Call Types, on page 30 to record and play agent greetings.
Step 9 Configure Dialed Numbers, on page 30 to record and play agent greetings.
Step 10 Schedule the Script, on page 31
Step 11 In Script Editor:

• To use the installed scripts to record and play agent greetings, see Import the Example Agent Greeting
Scripts, on page 29.

• To create your own scripts, see Import the Example Agent Greeting Scripts, on page 29.

Step 12 Modify the Unified CCE call routing scripts to use Play Agent Greeting script, on page 31.

Configure Gateway

Republish the tcl scripts to VXML Gateway
The .tcl script files that ship with Unified CVP include updates to support Agent Greeting. You must republish
these updated files to your VXML Gateway.

Republishing scripts to the VXML Gateways is a standard task in CVP upgrades. You must republish the
scripts before you can use Agent Greeting.
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Procedure

Step 1 In the Unified CVP Operation Console, select Bulk Administration > File Transfer > Scripts and Media.
Step 2 Set Device to Gateway.
Step 3 Select the gateways you want to update. Typically you would select all of them unless you have a specific

reason not to.
Step 4 Select Default Gateway Files.
Step 5 Click Transfer.

Set Cache Size on VXML Gateway
To ensure adequate performance, set the size of the cache on the VXML Gateway to the maximum allowed.
The maximum size is 100 megabytes; the default is 15 kilobytes. Failure to set the VXML Gateway cache to
its maximum can result in slowed performance to increased traffic to the media server.

Use the following Cisco IOS commands on the VXML Gateway to reset the cache size:
conf t
http client cache memory pool 100000
exit
wr

For more information about configuring the cache size, see theConfiguration Guide for Cisco Unified Customer
Voice Portal at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/
tsd-products-support-series-home.html.

Configure Unified CVP
Complete the following procedures for Unified CVP configuration:

• Configure FTP Enabled in Server Manager, on page 24

• Configure Unified CVP Media Server, on page 26

• Configure the Call Studio Scripts for Record Agent Greeting, on page 26

Configure FTP Enabled in Server Manager
Complete the following procedure to configure the FTP enabled in server manager.

Procedure

Step 1 Right- Click Roles in the left navigation page of server manager.
Step 2 Select Add Roles.
Step 3 Click Next.
Step 4 Check the checkbox Web Server (IIS) and click Next.
Step 5 Check the checkbox FTP Server and click Next.
Step 6 After the successful installation, click Close.
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Step 7 Make sure that the FTP and the IIS share the same root directory, because the recording application writes
the file to the media server directory structure, and the greeting playback call uses IIS to fetch the file. The
en-us/app directory should be under the same root directory for FTP and IIS.

Step 8 Create a dedicated directory on the server to store your greeting files.

This lets you specify a lower cache timeout of 5 minutes for your agent greeting files that does not affect other
more static files you may be serving from other directories. By default, the Record Greeting application posts
the .wav file to the en-us/app directory under your web/ftp root directory. You may create a dedicated directory
such as ag_gr under the en-us/app directory, and then indicate this in the Unified CCE script that invokes the
recording application. Use the array for the ECC variable call.user.microapp.ToExtVXML to send the
ftpPath parameter to the recording application. Make sure the ECC variable length is long enough, or it may
get truncated and fail.

Step 9 In IISManager, set the cache expiration for the dedicated directory to a value that allows re-recorded greetings
to replace their predecessor in a reasonable amount of time, while minimizing requests for data to the media
server from the VXML Gateway.

The ideal value varies depending on the number of agents you support and how often they re-record their
greetings. Two minutes may be a reasonable starting point.

Step 10 Find the site you are using, go to the agent greeting folder you created (ag_gr), and then selectHTTP Response
Headers .

Step 11 Select Add, then Set Common Headers .

Create Voice Prompts for Recording Greetings

You must create audio files for each of the voice prompts that agents hear as they record a greeting. The
number of prompts you require can vary, but a typical set can consist of:

• Awelcome followed by a prompt to select which greeting to work with (this assumes you support multiple
greetings per agent)

• A prompt to select whether they want to hear the current version, record a new one, or return to the main
menu

• A prompt to play if a current greeting is not found.

To create voice prompts for recording greetings:

Procedure

Step 1 Create the files using the recording tool of your choice. When you record your files:

• The media files must be in .wav format. Your .wav files must match Unified CVP encoding and format
requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono).

• Test your audio files. Ensure that they are not clipped and that they are consistent in volume and tone.

Step 2 After recording, deploy the files to your Unified CVP media server. The default deployment location is to the
<web_server_root>\en-us\app directory.
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Step 3 Note the names of the files and the location where you deployed them on the media server. Your script authors
need this information for the Agent Greeting scripts.

Built-In Recording Prompts

The Unified CVPGet Speech micro-application used to record Agent Greetings includes the following built-in
prompts:

• A prompt that agents can use to play back what they recorded

• A prompt to save the greeting, record it again, or return to the main menu

• A prompt that confirms the save, with an option to end the call or return to the main menu

You can replace these .wav files with files of your own. For more information, see the Unified Customer
Voice Portal Call Studio documentation at https://www.cisco.com/c/en/us/support/unified-communications/
unified-call-studio/tsd-products-support-series-home.html.

Configure Unified CVP Media Server

Procedure

Step 1 In the CVP Operations Console, navigate to Device Management > Media Server.
Step 2 Click Add New.
Step 3 On the General tab, configure the following.

a) Enter the IP address and the hostname of the Unified CVP server.
b) Check FTP Enabled.
c) Either Check Anonymous Access or enter the credentials.
d) Click Test SignIn to validate the FTP access.

Step 4 Click Save.
Step 5 Repeat Step 1 through 4 for all Media Servers.
Step 6 After you configure all Media Servers, click Deploy.
Step 7 Click Deployment Status to make sure that you applied the configuration.
Step 8 In the CVP Operations Console, navigate to Device Management > Media Server.
Step 9 Change Default Media Server from None to any one of the Unified CVP servers. Then click Set.
Step 10 Click Deploy.

Configure the Call Studio Scripts for Record Agent Greeting
The Record Agent Greeting is controlled by a combination of Call Studio script and ICM script. Complete
the following procedure to configure the Call Studio script:
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Procedure

Step 1 Access the .zip file from the CVP OAMP machine from the location
C:\Cisco\CVP\OPSConsoleServer\StudioDownloads\RecordAgentGreeting.zip.

Step 2 Extract the example Call Studio Record Agent Greeting scripts contained in RecordAgentGreeting.zip to a
folder of your choice on the computer running CallStudio. The folder contains a CallStudio project having
the same name as the folder.

Step 3 Start Call Studio by selecting Start > Programs > Cisco > Cisco Unified Call Studio.
Step 4 Select File > Import.

The Import dialog box displays.
Step 5 Expand the Call Studio folder and select Existing Call Studio project Into Workspace.
Step 6 Click Next.

The Import Call Studio Project From File System displays.
Step 7 Browse to the location where you extracted the call studio projects. Select the folder and select Finish.

Example:

RecordAgentGreeting
Step 8 Follow the below steps, to save the file in a defined path:

a) In theCall Studio Navigator panel, open theRecordAgentGreeting project and double click app.callflow
to display the application elements in the script window.

b) Select the Record Greeting With Confirm node.
c) In the Element Configuration panel, choose the Setting tab and modify the default path settings to

c:\inetpub\wwwroot\en-us\app\ag_gr. Save the project after you modify it.
d) Validate the project associated with the Record Agent Greeting and deploy them to your VXML Server.

Step 9 Right-click on Record Agent Greeting project in the Navigator window and select Validate.
Step 10 Right-click on the Record Agent Greeting project and click Deploy.
Step 11 In the Deploy Destination area, select Archive File and click Browse.
Step 12 Navigate to the archive folder that you have set up:

Example:

C:\Users\Administrator\Desktop\Sample.
Step 13 Enter the name of the file.

Example:

Samplefile.zip
Step 14 Click Save.
Step 15 In the Deploy Destinationarea click Finish.
Step 16 Log in to OAMP and choose Bulk Administration\File Transfer\VXMLApplications.
Step 17 Select the VXML Server to which you want to deploy the applications.
Step 18 Select the zip file that contains the applications.

Example:

Samplefile.zip
Step 19 Click Transfer.
Step 20 Right-click on the project and click Deploy, then click Finish.
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Step 21 Using windows explorer, navigate to
%CVP_HOME%\VXMLServer\applications\RecordAgentGreeting, open the project's admin
folder and double-click deployApp.bat to deploy the application to the VXML Server.

Step 22 Verify that the application is running in the following path
%CVP_HOME%\VXMLServer\applications\RecordAgentGreeting\admin and double-click
status.bat. The application should display under Application Name and with the status Running.

Configure Unified CCE
Complete the following procedures forUnified CCE configuration:

• Create Agent Greeting Play Script, on page 28

• Create Agent Greeting Recording Script, on page 28

• Import the Example Agent Greeting Scripts, on page 29

Create Agent Greeting Play Script
A dedicated routing script plays the Agent Greeting. This script is invoked by the PlayAgent Greeting dialed
number on the specific routing client. You must create the dialed number and associate it with a call type that
executes the script.

Figure 4: Agent Greeting Play Script

Create Agent Greeting Recording Script
The Agent Greeting Recording script lets agents record a greeting. The agent desktop calls the script when
an agent clicks the Record Agent Greeting button, prompting the agent to select which greeting to play or
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record. Create the dialed number RecordAgentGreeting for the specific routing client and associate it with a
call type that then executes this script.

Figure 5: Agent Greeting recording script

Unified CCE Configuration for Record Agent Greeting

• user.microapp.ToExtVXML : This is used twice in an Agent Greeting record script, the first time is to
queue the Unified CVP Record Agent Greeting application and the second time is to tell the recording
application where to save greeting files. Configure it as an array with size 3. Use the Unified CCE
Administration tool to ensure this variable includes Maximum Length as 100 and Enabled.

• user.microapp.app_media_lib :This is required in Agent Greeting record and play scripts to specify
the dedicated directory on the media server where your greeting audio files are stored. Maximum Length
is 100 and Enabled.

• user.microapp.input_type: This is required in Agent Greeting record scripts to limit the allowable
input type to DTMF. Maximum Length is 100 and Enabled.

For more information on how to enable the ECC variables, see the Cisco Hosted Collaboration Solution for
Contact Center Configuration Guide at
https://www.cisco.com/c/en/us/support/unified-communications/hosted-collaboration-solution-contact-center/products-installation-and-configuration-guides-list.html.

Note

Import the Example Agent Greeting Scripts
To view or use the example Agent Greeting scripts, you must first import them into theUnified CCE Script
Editor. Complete the following procedure to import the example Agent Greeting scripts:
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Procedure

Step 1 Launch Script Editor.
Step 2 Select File > Import Script and select a script to import.

The scripts are located in the icm\bin directory on the data server (DS) node.
Step 3 In addition to importing the script, Script Editor maps imported objects. You must manually create some

objects referenced in the example scripts, such as the external Network VRU scripts or the skill group, or
change these references to point to existing scripts and skill groups in your system.

Step 4 Repeat for the remaining scripts.

For Small Contact Center DeploymentModel, Default Routing Scripts are available in the partners
Community. Download the Routing Scripts to the Desktop where ISE is Installed and Login as
the Sub Customer User into the ISE to perform the Step 2 and 3. To Download the Routing Script,
see https://communities.cisco.com/docs/DOC-35245.

Note

For Small Contact Center Deployment Model ensure the resources used in this Routing script,
like Network VRU Scripts , ECC variables etc are specific to the sub customer.

Note

Configure Call Types

Procedure

Step 1 Sign-in to Unified CCDM Portal as Tenant or Sub Customer user.
Step 2 Click the burger icon and select Provisioning > Resource Manager

Step 3 Select the folder where you want to create the call type.
Step 4 Click Resource, then click Call Types.
Step 5 Create a call type to record agent greetings and enter RecordAgentGreeting as the name.
Step 6 Create a call type to play agent greetings and enter PlayAgentGreeting as the name.

Configure Dialed Numbers

Procedure

Step 1 Sign-in to Unified CCDM Portal as Tenant or Sub Customer user.
Step 2 Click the burger icon and select Provisioning > Resource Manager

Step 3 Select the folder where you want to create the dialed number.
Step 4 Click Resource, then click Dialed Number.
Step 5 Create a dialed number to record agent greetings and enter RecordAgentGreeting as the name.
Step 6 Create a dialed number to play agent greetings and enter PlayAgentGreeting as the name.
Step 7 Complete the following for each dialed number:

a) Select Internal Voice for the Routing type.
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b) Retain the default domain value.
c) Select the call type appropriate to the dialed number.

This helps to associate each number to its call type and to a script that executes.

Schedule the Script

Procedure

Step 1 In the Script Editor, select Script > Call Type Manager.
Step 2 From the Call Type Manager screen, select the Schedules tab.
Step 3 From the Call type drop-down list, select the call type to associate with the script; for example,

PlayAgentGreeting.
Step 4 Click Add and select the script you want from the Scripts box.
Step 5 Click OK twice to exit.

Modify the Unified CCE call routing scripts to use Play Agent Greeting script
For an Agent Greeting play script to run, you must add an AgentGreetingType Set Variable node to your
existing Unified CCE call routing scripts: This variable's value is used to select the audio file to play for the
greeting. Set the variable before the script node that queues the call to an agent (that is, the Queue [to Skill
Group or Precision Queue], Queue Agent, Route Select, or Select node).

Specify AgentGreetingType Call Variable

To include Agent Greeting in a script, insert a Set Variable node that references the AgentGreetingType call
variable. The AgentGreetingType variable causes a greeting to play and specifies the audio file it should use.
The variable value corresponds to the name of the greeting type for the skill group or Precision Queue. For
example, if there is a skill group or Precision Queue for Sales agents and if the greeting type for Sales is '5',
then the variable value should be 5.

You can use a single greeting prompt throughout a single call type. As a result, use one AgentGreetingType
set node per script. However, as needed, you can set the variable at multiple places in your scripts to allow
different greetings to play for different endpoints. For example, if you do skills-based routing, you can specify
the variable at each decision point used to select a particular skill group or Precision Queue.

Only one greeting can play per call. If a script references and sets the AgentGreetingType variable more than
once in any single path through a script, the last value to be set is the one that plays.

Note

Use these settings in the Set Variable node for Agent Greeting:

• Object Type: Call.

• Variable: Must use the AgentGreetingType variable.

• Type: Must use the PersonID_AgentGreetingType type.
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• Value: Specify the value that corresponds to the greeting type you want to play. For example: “2” or
“French”

• You must enclose the value in quotes.

• The value is not case-sensitive.

• The value cannot include spaces or characters that require URL encoding.

Scripting Agent Greeting for Multiple Customers

In the out-of-box method for deploying Agent Greeting, Unified CCE uses the customer information from
the built-in “PlayAgentGreeting” dialed number to choose the correct network VRU to play the greeting. If
your deployment has multiple customers configured within your Unified CCE instance and you want to use
Agent Greeting with all of them, you must configure things differently to work around customer associations.

Configure Custom Dialed Number for Agent Greeting Play

To play Agent Greetings for multiple customer instances, configure the built-in PlayAgentGreeting dialed
number for each Unified CM routing client, but do not associate it with a specific customer. The Unified CM
peripheral uses this number to initiate Agent Greeting play. If you want your greetings to be played from a
different network VRU, use the TranslationRouteToVRU node in your routing scripts to explicitly choose
the network VRU.

Configure Custom Dialed Number for Agent Greeting Record

To record Agent Greetings when you have multiple customers, you must create your own custom dialed
number for recording. Youmaywant to create different dialed numbers for different customers. As with Agent
Greeting play, if you want to use different network VRUs to record Agent Greetings for different customers,
use the TranslationRouteToVRU node in your routing script to explicitly select the network VRU.

Create your own custom button or have your agents enter the record dialed number using the dial pad on their
desktops.

Configure Unified Communications Manager

Built-in-Bridge
Built-in-Bridge (BIB) is not enabled by default for the phones. It is disabled at the system level as it is not
used by all the customer by default. It is used only by the customers having Contact Center.

The provider has to perform the following procedures to enable BIB for the customers having contact center.

Create a new Field Display Policies at the customer level and add Built-in Bridge to the list.Note

• Configure the Built-in-Bridge , on page 33

• Enable or Disable the Built-in-Bridge , on page 33
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Configure the Built-in-Bridge

Procedure

Step 1 Login to Cisco Unified Communication Domain Manager as provider.
Step 2 Navigate Role Management > Field Display Policies.
Step 3 Ensure that hierarchy is set to the appropriate customer.
Step 4 Select the SubscriberPhoneMenuItemProvider.
Step 5 In the details page, go to Action menu and click Clone.
Step 6 Enter SubscriberPhoneMenuItemProvider as the name.
Step 7 Select relation/SubscriberPhone from the Target Model Type drop-down list.
Step 8 Expand Groups section and enter Phone for Title.
Step 9 Select builtInBridgeStatus from the Available list and click Select.
Step 10 Click Save.

Enable or Disable the Built-in-Bridge

Before you begin

Ensure that you configure Built-in-Bridge. See, Configure the Built-in-Bridge , on page 33.

Procedure

Step 1 Login to Cisco Unified Communication Domain Manager as a provider.
Step 2 Ensure that hierarchy is set to the appropriate customer.
Step 3 Navigate Subscriber Management > Phones and select the appropriate phone.
Step 4 In the Phone tab:

• To enable BIB choose On from the Built in Bridge drop-down list.

• To disable BIB choose Off from the Built in Bridge drop-down list.

Step 5 Click Save.

Reporting
In agent, skill group, and precision queue reports, greeting time is not specifically broken out. The period
during which the greeting plays is reported as talk time. Record time is counted as an internal call by the
default skill group.

Calls that involve Agent Greeting consist of two call legs: the inbound call from the customer and the call to
Unified CVP for the greeting. Both of these legs have the same RouterCallKeyDay and RouterCallKey values
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in the TCD and RCD tables in the database. You can use these values to link the two legs together for reporting
purposes.

Greeting Call Statistics
To view greeting call statistics, create a separate call type and associate it with the routing script that plays
agent greeting. New Cisco Unified Intelligence Center templates for the agent greeting call type are created
based on the data in the existing Call_Type_Real_Time and Call_Type_Interval table in the database.

Peripheral Call Types for Agent Greeting
There are two peripheral call types specific to Agent Greeting that you can use to track and report on the
feature.

• Call Type 39: Play Agent Greeting. Route request to play an Agent Greeting.

• Call Type 40: Record Agent Greeting. Agent call for recording an Agent Greeting.

Extra TCDs and RCDs are generated for the agent greeting call leg, and they can be linked to the first call leg
by the same RouterCallKeyDay and RouterCallKey.

Serviceability
Serviceability for Agent Greeting includes SNMP events captured by your Network management software
that indicate reasons for greeting failures and counters to track the number of failed greeting events.

There is no counter for the number of failed agent greeting calls.Note

When system components fail, Agent Greeting may be impacted. For example, if a requested greeting audio
file cannot be found for any reason, the call proceeds without the Agent Greeting.
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C H A P T E R 4
Bussines Hours

• Business Hours Overview, on page 35
• Business Hours Use Cases, on page 36
• Set the Principal AW for Business Hours, on page 36
• Business Hours Set Up Workflow, on page 37

Business Hours Overview
The Business Hours feature lets you create schedules for regular working hours and extra working hours, and
to close the contact center for holidays or emergencies. It provides the mechanism for routing these contacts
to specific support teams based on the configured work hour schedules, holidays, emergency closures, or extra
working hours. You can create Business Hour schedules for various scenarios for various contact center teams.
This feature helps you create and apply several Business Hour schedules to the same team. On the other hand,
you could apply the same Business Hour schedule to several support teams.

When a customer contacts the contact center, the response by the contact center is based on the status of the
support team. This status is evaluated using the Business Hour configured for the team.

Use this feature to:

• Configure default working hours (regular hours) for contact center teams for each day of the week. This
option is not applicable to 24x7 support teams.

• Configure the special hours for the contact center team or teams for any special days such as Sale days
or holidays.

• Force Close the contact center for any emergency such as a natural calamity.

• Force Open the contact center on a holiday or a non-working day to cater to specific business requirements
such as Sale days.

• Create and deploy customer notifications that are based on Business Hour status.

Define the status reasons for business hours and assign codes for each status reason. Status reason is required
when you force open or force close a business hour, and when you add special hours and holidays.

Contact Center Enterprise Reference Design Support for Business Hours

• 2000 Agents
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• 4000 Agents

• 12000 Agents

• 24000 Agents

Business Hours can be configured only through Unified CCE Administration console.

Small Contact Center deployments do not support the Business Hours feature.

Note

Business Hours Use Cases
Use the Business Hours feature to manage the incoming customer calls or digital channel contacts to your
teams , by routing these contacts based on the Business Hours you configure.

Use the Business Hour status in an IF node in scripts to control the call and digital channel contacts, such as
email and chat, and notify the customers accordingly.

You can have Business Hours scripts for the following treatments:

• When the business is open, route calls and digital contacts to the applicable skill groups and precision
queues.

• When the business is closed, play the message for the closed status with the appropriate Status Reason
and terminate the call. Route the digital contacts to the appropriate queues.

• When the business is not open 24x7, route the calls to skill groups and precision queues for after-hours
support or play the after-hours message.

• When the business is open 24x7, at a predefined time before the end of each shift, route the calls and
digital contacts to the appropriate queues for the next shift.

• When the business is closed for an emergency on a working day, notify the customers contacting your
contact center appropriately about the emergency closing.

Based on reason code and status, the customers will hear appropriate prompts on the call.

Set the Principal AW for Business Hours
You must specify and set the Principal AW before configuring the Business Hours.

Procedure

Step 1 In Unified CCE Administration, go to Infrastructure > Inventory.
Step 2 Click the AW that you want to set as Principal AW.

The Edit CCE AW window opens.
Step 3 Select the Principal AW check box.
Step 4 Enter the Unified CCE Diagnostic Framework Service domain, username, and password.
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Step 5 Click Save.
Step 6 Restart Tomcat service on Principal AW machine.

Business Hours Set Up Workflow
This section provides information necessary to set up the Business Hours feature.

Table 2: Business Hours Set Up Workflow

DocumentationTasks

Business Hours Variables and Dynamic Formula for Business Hours in the
Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center
Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html

Scripting for Business Hours

Cisco Hosted Collaboration Solution for Contact Center Configuration Guide
at https://www.cisco.com/c/en/us/support/unified-communications/
hosted-collaboration-solution-contact-center/
products-installation-and-configuration-guides-list.html

Business Hours Configuration

Scripting for Business Hours

To enable scripting for Business Hours, use the following variables:

• Business Hour Status—The real time status based on the configured Business Hours.

• Reason Code— The reason code associated with the current status.

These variables must be used in the CCE script IF node to route the customer contacts.

Business Hours Configuration

Business hours can be configured by defining the following:

• Default Open/Close (as per Business Calendar): The status of the regular hours.

• Force Open: Force the status of Business Hours to Open with a reason code.

• Force Closed: Force the status of Business Hours to Closed with a reason code.

• 24x7 setting: Set the schedules for 24x7 working. Status is Always Open.

• Special Hours & Holiday: Configure a holiday or special day. On a holiday, you can close the Business
Hours for the whole day or open it for specific hours. On a special day, you can configure extra working
hours (in cases where 24x7 working is not set), the evaluation stops when the Special Hours & Holiday
step is evaluated and the status is derived from this step. Further Business Hours setting for that day will
not be evaluated.

• Custom: Configure the regular working hours for a weekday and, if necessary, specify the working hours
for each day in a week.
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The following variables control this feature:

• Time Zone: The line of Business or team’s operational time zone.

• Reason Code: Reason code for special days and Force Open/Close status.

Apply the appropriate reason codes when you configure a Business Hour with Force Open, Force Close,
and Special Hours & Holidays. When these Business Hour schedules are in effect, the associated reason
code is available in the scripting environment and the real time reports. Reason Code configuration is
not available for regular weekdays. In such cases, the system reports the default open and default close
reason codes.

Configure Yearly Schedules

You can configure and maintain a Business hours calendar for the whole year.

• Configure the regular working hours for weekdays.

• Configure Special Hours & Holidays schedules for whole year by doing the following:

• Add the Special Hours & Holidays details for all the special hours and holidays for the whole year
into the CSV template file.

• On the Import Special Hours & Holidays page, clickChoose File and browse to the special hours
and holidays file.

Click Import to upload the file.

After you import the configuration file, the configurations are loaded on the Business Hours page.
Validate the configurations.

• Click Save.

When you update the configured Business Hours, remove any elapsed schedules and then update the new
schedules for any new special hours or holidays in a Business Hour configuration.

Note

Daylight Saving Time

The Business Hours feature uses Time Zone to determine the status based on the Business Hours configured.
Time Zone is set based on the local time. When the daylight saving time (DST) settings are applicable to
any Time Zone, the status is automatically adjusted for DST.

When time zones are added or updated, the DST information changes. Apply all the Operating System (OS)
updates related to time zones and DST, to both sides A and B of the deployment.

Business Hours Status Evaluation

The status is evaluated using the following order of the configured Business Hour settings:

1. Open/Close as per Business Calendar

2. Force Open or Close

3. Special Hours and Holiday schedule
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4. 24x7 setting

5. Regular hour schedules

The evaluation terminates at the step at which the status is determined.

For example, if Special Hours & Holidays is configured, the evaluation stops when the Special Hours &
Holiday step is evaluated and the status is derived from this step.

If any configuration is changed, the status is re-evaluated and updated to reflect the change.
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C H A P T E R 5
Unified CM-based Silent Monitoring

• Capabilities of Silent Monitoring , on page 41
• Configure Silent Monitoring , on page 42

Capabilities of Silent Monitoring

Silent Monitoring
Silent monitoring allows supervisors to monitor the conversations of agents within their team. Supervisors
cannot participate actively in the conversations and agents and callers are not aware that they are being
monitored. Cisco Finesse provides solution support for silent monitoring.

Cisco Finesse supports Unified Communications Silent Monitoring only. You configure silent monitoring on
Unified Communications Manager. No additional configuration is required on the Cisco Finesse server.

Even for regions that are configured to use G.711, Unified CCE uses G.722 as the default codec for devices
that support G.722. However G.722 is not supported with Silent Monitoring and Call Recording based on
Unified CommunicationsManager. To disable this default, in Unified CommunicationsManager Administration,
go to Enterprise Parameters and set Advertise G.722 Codec to disabled.

Note

If voice streams are encrypted, silent monitoring does not work correctly. Although the voice streams can still
be captured, the silent monitoring service cannot decode them correctly.

Note

Unified CM-Based Silent Monitoring
Unified Communications Manager accomplishes silent monitoring with a call between the supervisor
(monitoring) device and the agent (monitored) device. The agent phonemixes and sends the agent's conversation
to the supervisor phone, where it is played out to the supervisor.

Unified CCE supports the Silent Monitoring functionality available in Unified CM. Unified CM Silent
Monitoring supports only one silent monitoring session and one recording session for the same agent phone.
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Unified CM Silent Monitoring does not support mobile agents.Note

Unified CM Silent Monitoring can monitor any Unified CCE agent desktop, including Siebel, if the following
conditions exist:

• The monitored agents use a compatible Cisco Unified IP phone or Cisco IP Communicator. For details,
see the Compatibility Matrix for your solution at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html

• The contact center uses a compatible version of Cisco Unified CM. For more information, see the
Compatibility Matrix for your solution.

• The contact center uses a compatible version of Cisco Unified CM.

Unified CM Silent Monitoring works the same as other call control functionality provided by Unified CM
(such as conference and transfer). When the silent monitoring session begins, the desktop sends a message
through Unified CCE, through Unified CM, and out to the phones where silent monitoring is executed.

Messaging through Unified CCE and Unified CM impacts Unified CCE performance.

Configure Silent Monitoring

Add Monitoring Calling Search Space

Before you begin

Ensure that agent phones are added.

During CTIOS Server installation, for IPCC Silent Monitor Type, select CCM Based.Note

Procedure

Step 1 Log in to Unified Communication Domain Manager as provider, reseller or customer.
Step 2 Add Calling Search Space for monitoring purpose.
Step 3 Edit Lines, choose newly added Calling Search Space from the drop-down list.
Step 4 Click Save.

Example

For information on how to perform on any of the tasks listed in this section, see Cisco Hosted
Collaboration Solution for Contact Center Configuration Guide at
https://www.cisco.com/c/en/us/support/unified-communications/hosted-collaboration-solution-contact-center/products-installation-and-configuration-guides-list.html.
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C H A P T E R 6
Courtesy Callback

• Courtesy Callback, on page 43
• Configure Courtesy Callback, on page 45

Courtesy Callback
Courtesy Callback gives a caller the option to have an agent return their call. This option limits the time a
caller waits on the phone for an agent to answer.

Each call has a calculated Estimated Wait Time (EWT). When a caller's EWT approaches zero, the script
places a call back to the caller. When the caller answers, the script inserts the caller back into the queue with
their original order. The caller reaches an agent in the same time as if they had stayed on the phone.

Figure 6: Courtesy Callback

Courtesy Callback Call Flows
If the caller opts for a callback, they leave their name and phone number. Their request remains in the system.
The system places a callback to the caller when the Estimated Wait Time (EWT) reaches the correct value.
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The caller answers the call and confirms that they are the original caller, and the system connects the caller
to the agent after a short wait.

Courtesy Callback is also supported for IP-originated calls.Note

A typical call flow for this feature follows this pattern:

1. The call arrives at Unified CVP and the call is treated in the VRU environment.

2. The Call Studio and Unified CCECourtesy Callback scripts determine if the caller is eligible for a callback
based on your rules.

3. If the caller is eligible, the system announces the EWT and offers the caller a callback when an agent is
available.

4. The caller chooses what to do:

a. If the caller chooses not to use the callback feature, queuing continues.

b. If the caller chooses to receive a callback, the system prompts the caller to record their name and to
key in their phone number.

5. The system writes a database record to log the callback information.

If the database is not accessible, the system does not offer a callback to the caller.Note

6. The caller disconnects from the TDM side of the call. However, the IP side of the call in Unified CVP
and Unified CCE is still active. This keeps the call in the same queue position. No queue music plays, so
Voice Browser resources used during this time are less than for a caller actually in the queue.

7. When an appropriate agent is close to being available (as determined by your callback scripts), then the
system calls the person back. The system announces the recorded name when the callback is made to
ensure that correct person accepts the call.

8. A VRU session asks the caller to confirm that they are the correct person and that they are ready for the
callback.

If the system cannot reach the callback number (for example, busy lines, RNA, or network problems),
then the call is not sent to an agent. The call also does not go to the agent if the caller does not confirm
that they are the correct person. The agent is guaranteed that someone is waiting when they take the call.
The system assumes that the caller is already on the line by the time the agent gets the call.

This feature is called preemptive callback because the system assumes that the caller waits a minimal
time for the agent and the caller is on the line when the agent answers.

9. The system presents the call context on the agent screen-pop.

If the system cannot reach the caller after a configurable number and frequency of retries, the callback cancels
and the database status updates appropriately. You can run reports to determine if any manual callbacks are
necessary based on your business rules.
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See the Configuration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/en/US/
products/sw/custcosw/ps1006/products_installation_and_configuration_guides_list.html for a call flow
description of the scripts providing the Courtesy Callback feature.

Configure Courtesy Callback

Configure Gateway

Configure the VXML Gateway for Courtesy Callback
Complete the following procedure to configure the VXML gateway for Courtesy Callback:

Procedure

Step 1 Copy cvp_ccb_vxml.tcl from the CVP Operations Console to the flash memory of the gateway, as follows:
a) Select Bulk Administration > File Transfer > Scripts and Media.
b) In Device Association, select Gateway for Device Type.
c) Select the required gateway from the Available list.
d) Click the right arrow icon to move the available gateway to the Selected list.
e) From the default gateway files, highlight cvp_ccb_vxml.tcl.
f) Click Transfer.

Step 2 Log on to VXML gateway.
Step 3 Add the cvp_cc service to the configuration service cvp_cc flash:cvp_ccb_vxml.tcl.

This service does not require any parameters.

Step 4 Enter the following command to load the application:

call application voice load cvp_cc

Step 5 On the VoIP dial-peer that defines the VRU fromUnified CCE, verify that the codec can be used for recording.

Example:

The following example verifies that g711ulaw can be used for recording in Courtesy Callback:
dial-peer voice 123 voip
service bootstrap
incoming called-number 123T
dtmf-relay rte-nte
h245-signal
h245-alphanumeric
codec g711ulaw
no vad!

Step 6 Configure the following to ensure that SIP is setup to forward SIP INFO messaging:
voice service voip
signaling forward unconditional

Step 7 To play the beep to prompt the caller to record their name in the BillingQueue example script add the following
text to the configuration:
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vxml version 2.0

Whenever you enable vxml version 2.0 on the gateway, vxml audioerror is off by default. When
an audio file cannot be played, error.badfetch will not generate an audio error event.

To generate an error in the gateway, enable vxmlaudioerror.

Note

Example:

The following example uses config terminal mode to add both commands:
config t
vxml version 2.0
vxml audioerror
exit

Configure the Ingress Gateway for Courtesy Callback
Complete the following procedure to configure the ingress gateway for courtesy callback:

Procedure

Step 1 Copy surviability.tcl from the Operations Console to the flash memory of the gateway, as follows:
a) Select Bulk Administration > File Transfer > Scripts and Media.
b) In Device Association, select Gateway for Device Type.
c) Select the required gateway from the Available list.
d) Click the right arrow icon to move the available gateway to the Selected list.
e) From the default gateway files, highlight survivability.tcl.
f) Click Transfer.

Step 2 Log onto the ingress gateway.
Step 3 Add the following to the survivability service:

param ccb id:<host name or ip of this gateway>;loc:<location name>;trunks:<number of callback

trunks>

• id - A unique identifier for this gateway and is logged to the database to show which gateway processed
the original callback request.

• loc - An arbitrary location name specifying the location of this gateway.

• Trunks - The number of DS0's reserved for callbacks on this gateway. Limit the number of T1/E1 trunks
to enable the system to limit the resources allowed for callbacks.

Example:

The following example shows a basic configuration:
service cvp-survivability flash:survivability.tcl
param ccb id:10.86.132.177;loc:doclab;trunks:1!

Step 4 Create the incoming POTS dial peer, or verify that the survivability service is being used on your incoming
POTS dial peer.

Example:
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For example,
dial-peer voice 978555 pots
service cvp-survivability
incoming called-number 9785551234
direct-inward-dial!

Step 5 Create outgoing POTS dial peers for the callbacks. These are the dial peers that place the actual call back out
to the PSTN.

Example:

For example,
dial-peer voice 978555 pots
destination-pattern 978555....
no digit-strip port 0/0/1:23!

Step 6 Use the following configuration to ensure that SIP is set up to forward SIP INFO messaging:

voice service voip signaling forward unconditional

Configure CUBE-E for Courtesy Callback

If you are using CUBE-E then you need sip profile configuration and apply it on outgoing dial-peer through
cvp. See the below the example:

Note

A "sip-profile¨ configuration is needed on ISR CUBE E for the courtesy callback feature. To configure the
"sip-profile", the following must be added

voice class sip-profiles 103

request INVITE sip-header Call-Info add "X-Cisco-CCBProbe: <ccb param>"

where "<ccb param>" is the "ccb" parameter defined in the survivability service. Add this "sip-profile" to the
outgoing dial-peer to the CVP.

The following is a configuration example

voice class sip-profiles 103

request INVITE sip-header Call-Info add "X-Cisco-CCBProbe: id:10.10.10.180;sydlab;trunks:4"

dial-peer voice 5001 voip

description Comprehensive outbound route to CVP

destination-pattern 5001

session protocol sipv2

session target ipv4:10.10.10.10

dtmf-relay rtp-nte

voice-class sip profiles 103

codec g711ulaw
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no vad

In the above example, 10.10.10.180 is the CUBE IP and 10.10.10.10 is the CVP Call Server IP.

If CUBE E is used for Courtesy Call Back then under voice service voip class in CUBE E must have media
flow-through for Courtesy Call Back to work.

Note

Configure Unified CVP

Configure the Reporting Server for Courtesy Callback
A reporting server is required for the Courtesy Callback feature. Complete the following procedure to configure
a reporting server for Courtesy Callback:

Before you begin

Install and configure the Reporting Server.

Procedure

Step 1 In the Operations Console, select System > Courtesy Callback.

The Courtesy Callback Configuration page displays.

Step 2 Choose the General tab.
Step 3 Click the Unified CVP Reporting Server drop-down, and select the Reporting Server to use for storing

Courtesy Callback data.
Step 4 If required, select Enable secure communication with the Courtesy Callback database.
Step 5 Configure allowed and disabled dialed numbers.

These are the numbers that the system should and should not call when it is making a Courtesy Callback to
a caller.

Initially, there are no allowed dialed numbers for the Courtesy Callback feature. AllowUnmatched
Dialed Numbers is de-selected and, the Allowed Dialed Numbers window is empty.

Note

Step 6 Adjust the Maximum Number of Calls per Calling Number to the desired number.

By default, this is set to 0 and no limit is imposed. This setting allows you to limit the number of calls that
are eligible to receive a callback from the same calling number.

If this field is set to a positive number (X), then the Courtesy Callback Validate element only allows X callbacks
per calling number to go through the preemptive exit state at any time.

If there are already X callbacks offered for a calling number, new calls go through the none exit state of the
Validate element.

In addition, if no calling number is available for a call, the call always goes through the none exit state of the
Validate element.
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Step 7 Choose the Call Server Deployment tab and move the Call Server you want to use for Courtesy Callbacks
from the Available box to the Selected box.

Step 8 Click Save.

The configuration becomes active (is deployed) the next time the Reporting Server is restarted.

Step 9 You can also deploy the new Reporting Server configuration immediately by clicking Save & Deploy.

After all the updates are configured, restart the Reporting Server to update the configuration.Note

Configure the Call Studio Scripts for Courtesy Callback
The Courtesy Callback feature is controlled by a combination of Call Studio scripts and ICM scripts. Complete
the following procedure to configure the Call Studio scripts:

Procedure

Step 1 Access the .zip file from the CVP OAMP machine from the location
C:\Cisco\CVP\OPSConsoleServer\StudioDownloads\CourtesyCallbackStudioScripts.zip.

Step 2 Extract the example Call Studio Courtesy Callback scripts contained in CourtesyCallbackStudioScripts.zip
to a folder of your choice on the computer running CallStudio.

Each folder contains a Call Studio project having the same name as the folder. The five individual project
comprise the Courtesy Callback feature.

Do not modify the scripts CallbackEngine and CallbackQueue.Note

Step 3 Modify the scripts BillingQueue, CallbackEntry, and CallbackWait to suit your business needs.
Step 4 Start Call Studio by selecting Start > All Programs > Cisco > Cisco Unified Call Studio.
Step 5 Select File > Import.

The Import dialog box displays.

Step 6 Expand the Call Studio folder and select Existing Call Studio Project Into Workspace.
Step 7 Click Next .

The Import Call Studio Project From File System displays.

Step 8 Browse to the location where you extracted the call studio projects. For each of the folders that were unzipped,
select the folder (for example BillingQueue) and select Finish.

The project is imported into Call Studio.

Step 9 Repeat the action in previous step for each of the five folders.

The five projects display in the upper-left of the Navigator window.

Step 10 Update the Default Audio Path URI field in Call Studio to contain the IP address and port value for your
media server.

Step 11 For each of the Call Studio projects previously unzipped, complete the following steps:
a) Select the project in the Navigator window of Call Studio.
b) Choose Project > Properties > Call Studio > Audio Settings.
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c) On the Audio Settings window, modify the Default Audio Path URI field to http://<media-server
>/en-us/VL/.

d) Click Apply then click OK.

Step 12 Under CallbackEntry Project, if required, modify the caller interaction settings in the SetQueueDefault_01
node.
a) In the Call Studio Navigator panel, open the CallBackEntry project and double-click app.callflow to

display the application elements in the script window.
b) Open the Start of Call page of the script using the tab at the bottom of the script display window.
c) Select the SetQueueDefault_01 node.
d) In the Element Configuration panel, choose the Setting tab and modify the default settings as required.

Step 13 In the CallbackEntry project, on the Wants Callback page, configure the following:
a) Highlight the Record Name node and choose the Settings tab.
b) In the Path setting, change the path to the location where you want to store the recorded names of the

callers.
c) Highlight the Add Callback to DB 1node.
d) Change the Recorded name file setting to match the location of the recording folder that you created in

the previous step.
e) Ensure the keepalive Interval(in seconds) is greater than the length of the queue music being played. In

the Start of Call page.

The default is 120 seconds for the SetQueueDefaults_01 node.

f) Save the CallbackEntry project.
g) In the CallbackWait Project, modify values in the CallbackWait application.

In this application, you can change the IVR interaction that the caller receives at the time of the actual
callback. The caller interaction elements in CallbackWait > AskIfCallerReady page may be modified.
Save the project after you modify it.

h) Validate each of the five projects associated with the Courtesy Callback feature and deploy them to your
VXML Server.

Step 14 Right-click each Courtesy Callback project in the Navigator window and select Validate.
Step 15 Right-click each of the projects and click Deploy, then click Finish.
Step 16 Using windows explorer, navigate to %CVP_HOME%\VXMLServer\applications.
Step 17 For each of the five Courtesy Callback applications, open the project's admin folder,

in%CVP_Home%\VXMLServer\applications, and double-click deployApp.bat to deploy the application to
the VXML Server.

Step 18 Verify that all the applications are running by going into %CVP_HOME%\VXMLServer\admin and
double-clicking status.bat. All five applications should display under Application Name and with the status
Running.

Step 19 Click Deploy.
Step 20 In the Deploy Destination area, select Archive File and click Browse.
Step 21 Navigate to the archive folder that you have set up.

Example:

C:\Users\Administrator\Desktop\Sample.
Step 22 Enter the name of the file.
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Example:

For example Samplefile.zip.
Step 23 Click Save.
Step 24 In the Deploy Destination area click Finish.
Step 25 Log in to OAMP and choose Bulk Administration\File Transfer\VXMLApplications.
Step 26 Select the VXML Server to which you want to deploy the applications.
Step 27 Select the zip file that contains the applications.

Example:

Samplefile.zip.
Step 28 Click Transfer.

Configure the Media Server for Courtesy Callback
Several Courtesy Callback specific media files are included with the sample scripts for Courtesy Callback.
Complete the procedure to configure the Media Server for Courtesy Callback:

Procedure

Step 1 During the Unified CVP installation, the media files are copied as:
%CVP_HOME%\OPSConsoleServer\CCBDownloads\CCBAudioFiles.zip.

Step 2 Unzip the special audio files and copy to yourmedia serverVXMLServer\Tomcat\webapps\CVP\audio.

The sample scripts are set up to use the default location "\CVP\audio" for the audio files.

Step 3 Change the default location of the audio files in the sample scripts to be your media server path.

Configure Unified CCE

Configure the ICM Script for Courtesy Callback
Following figure shows the sample Courtesy Callback ICM script.
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Figure 7: Sample Courtesy Callback ICM script

Complete the following procedure to configure ICM to use the sample Courtesy Callback ICM script:

Procedure

Step 1 Copy the CCE example script, CourtesyCallback.ICMS to the CCE Admin Workstation.
The example CCE script is available in the following locations:

• On the CVP install media in \CVP\Downloads and Samples\.
• From the Operations Console in %CVP_HOME%\OPSConsoleServer\ICMDownloads.
• In the Import Script - Manual Object Mapping window, map the route and skill group to the route and
skill group available for courtesy callback.

For Small Contact Center Deployment Model, copy the CourtesyCallback.ICMS Routing
Script on the desktop where Internet Script editor is installed.

Note

Step 2 In Script Editor, select File > Import Script...

For Small Contact Center Deployment Model follow the below steps.Note

a. Log In to ISE by sub customer user and Click on File>Import Script.
b. Select the Routing script which is copied in the desktop CourtesyCallback.ICMS.
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Step 3 In the script location dialog, select the CourtesyCallback.ICMS script and click Open.

You can bypass the set variable "Set media server" Highlighted as number 1 node in the Figure
57: Sample Courtesy Callback ICM script , as VXML Server, Call Server, and Media Server
are collocated.

Note

Step 4 Define a new ECC variable for courtesy callback.

A new ECC variable is used to determine if a caller is in a queue and can be offered a callback.

Step 5 Navigate to ICM Admin Workstation > ICM Configuration Manager > Expanded Call Variable List
tool to create the ECC Variable user.CourtesyCallbackEnabled specific to Courtesy Callback.

Step 6 Set up the following parameters that are passed to CallbackEntry (VXML application):

Example:

• ToExtVXML[0] =concatenate("application=CallbackEntry",";ewt=",Call.user.microapp.ToExtVXML[0])

• ToExtVXML[1] = "qname=billing";

• ToExtVXML[2] = "queueapp=BillingQueue;"

• ToExtVXML[3] = concatenate("ani=",Call.CallingLineID,";");

CallbackEntry is the name of the VXML Server application that will be executed:

ewt is calculated in Block #2.

qname is the name of the VXML Server queue into which the call will be placed. There must be a unique
qname for each unique resource pool queue.

queueapp is the name of the VXML Server queuing application that will be executed for this queue.

ani is the caller's calling Line Identifier.

Step 7 Create Network VRU Scripts.
Step 8 Navigate to ICM Configuration Manager > Network VRU Script List tool, create the following Interruptible

Script Network VRU Scripts.

Name: VXML_Server_Interruptible

Network VRU: Select your Type 10 CVP VRU

VRU Script Name: GS,Server,V,interrupt

Timeout: 9000 seconds

Interruptible: Checked

Step 9 Choose ICM Configuration Manager > Network VRU Script List tool to create the following
Non-Interruptible Script Network VRU Scripts.

Name - VXML_Server_NonInterruptible

Network VRU - Select your Type 10 CVP VRU

VRU Script Name - GS,Server,V, nointerrupt

Timeout - 9000 seconds ( must be greater than the maximum possible call life in Unified CVP)

Interruptible: Not Checked
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Step 10 Verify that the user.microapp.ToExtVXMLECC variable is set up for an array of five items with a minimum
size of 60 characters and the user.microapp.FromExtVXML variable is set up for an array of four with a
minimum size of 60 characters.

Note

Verify that you have at least one available route and skill group to map to the route and skillgroup in the
example script.

Step 11 Save the script, then associate the call type and schedule the script.

For Small Contact Center Deployment Model ensure the resources used in this Routing Script,
like Network VRU Scripts , ECC variables etc are specific to the sub customer.

Note
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C H A P T E R 7
Customer Virtual Assistant

• Feature Overview, on page 55
• Getting Started, on page 55
• Feature Overview, on page 59
• Getting Started, on page 59

Feature Overview
Customer Virtual Assistant (CVA) feature enables the IVR platform to integrate with cloud-based speech
services. This feature supports human-like interactions that enable customers to resolve issues quickly and
more efficiently within the IVR, thereby, reducing the calls directed towards agents.

In a traditional IVR, customers can interact with the IVR in the following ways:

• VVB Media Services-Based Interaction: Prompts are played locally by VVB by downloading WAV
files. User inputs are captured using DTMF grammar.

• ASR-Based and TTS-Based Interactions: Prompts are played by the external media server overMRCP
Synthesis command for Text-to-Speech (TTS) functionality. The responses are recognized by external
media server based on predefined grammar provided by Asynchronous Speech Recognition (ASR).

CVA-based IVR enables a newmechanism to leverage cloud-based-AI-enabled speech services. CVA provides
the following speech services:

• Text-to-Speech: Integration with cloud-based TTS services in your application for Speech Synthesis
operations. CVA currently supports Google Text to Speech service.

• Speech-to-Text: Integration with cloud-based ASR services in your application for Speech Recognition
operations. CVA currently supports Google Speech to Text service.

• Speech-to-Intent: CVA provides capability of identifying the intent of customer utterances by processing
the text received from Speech-to-Text operations. CVA offers this service by using cloud-based Natural
Language Understanding (NLU) services. CVA currently supports Google Dialogflow service.

Getting Started
This section explains the prerequisites and the documentation resources for CVA.
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Prerequisites
• CVP 12.5(1) and VVB 12.5(1).

• CVP/VVB configuration:

• Enable access to cloud-based services from CVP and VVB directly or via proxy.

For details, see the Cisco Unified Customer Voice Portal > Operations Console (NOAMP) >
Integration > Cloud Connect > Configure CVP or VVB Devices for Cloud Connect section in the
Administration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/c/en/us/
support/customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

• Synchronize the date/time in CVP, VVB, and proxy with a common NTP server.

• Configure access to DNS server in CVP/VVB.

For more information on NTP and DNS server configurations in CVP, refer to the Microsoft Windows
platform documentation.

For more information on NTP and DNS server configurations in VVB, refer to the Command Line
Interface Reference Guide for Cisco Unified Communications Solutions at https://www.cisco.com/c/en/
us/support/unified-communications/unified-communications-manager-callmanager/
products-maintenance-guides-list.html.

• Non-OEM users must enable speech services and generate JSON key. To know more about enabling
speech services, see Enable Speech Services (for Non-OEM Users), on page 56. To know more about
generating JSON key, see Generate JSON Key (for Non-OEM Users), on page 56.

• OEM users must provision Google Contact Center AI (CCAI) for Cisco Contact Center Enterprise. To
know more about provisioning Google CCAI, see Provision Google CCAI with Unified Contact Center
Enterprise (for OEM Users), on page 57.

Enable Speech Services (for Non-OEM Users)
To enable speech services, follow these steps:

1. Log in to your Dialogflow account at https://dialogflow.cloud.google.com/.

2. Scroll down on the homepage and click Project ID of your Dialogflow agent.

This takes you to the Google Cloud Platform (GCP) homepage.

3. Select APIs & Services from the left pane (through the hamburger menu).

4. Select the API services (such as Cloud Text-to-Speech, Cloud Speech-to-Text, and Dialogflow) to be
enabled.

5. Click Enable to enable the selected API for the given Project ID.

Generate JSON Key (for Non-OEM Users)
To generate the JSON key, follow these steps:
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1. In the GCP homepage, select IAM & Admin from the left pane (through the hamburger menu).

2. Select Service accounts which shows the list of your enabled services.

3. Select the service account for which the JSON key is to be generated.

4. Click the ellipsis menu on the right and click +Create Key.

5. Select JSON as Key type and then click Create.

The key is downloaded.

For best results:

• Migrate your Dialogflow Agent to Enterprise Essential (Console Left Bar > Migrate from Standard
to Enterprise Essential).

• Enable the enhanced Speech Model in Dialogflow console (Settings > Speech > Enable Enhanced
Speech Model and Data Logging).

If this option is enabled, speech recognition data is shared with Google. For more information see
https://cloud.google.com/speech-to-text/docs/enhanced-models.

Provision Google CCAI with Unified Contact Center Enterprise (for OEM Users)
To provision Google CCAI with Cisco Unified Contact Center Enterprise, follow these steps:

Procedure

Step 1 Log in to the Cisco CommerceWorkspace (CCW) portal https://apps.cisco.com/Commerce/ using your Cisco
ID and place the order for Google CCAI.

Step 2 Complete the CCAI provisioning form and submit to get a CCAI account with Cisco.

When the CCAI provisioning request is approved, an email (CCAI Onboarding Provision Status
Update) is triggered to the user. This email includes the account details and theCCAI Provisioning
Document which explains the steps to configure the CCAI account and services.

Note

Step 3 Configure the CCAI account and integrate the CCAI services with the Contact Center application by following
the CCAI Provisioning Document. For any further assistance, contact the Cisco CCAI onboarding team or
send an email to: cisco-ccai-onboarding@cisco.com.

The service account provided by Cisco allows the CCAI customers to leverage the following APIs to integrate
with the Contact Center applications:

• Dialogflow API

• Text-to-Speech API

• Speech-to-Text API
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Documentation Resources
The following table lists the reference documents for CVA.

ResourceInformation

See https://github.com/CiscoDevNet/cvp-sample-code/tree/
master/CustomerVirtualAssistant.

Sample CVA Application

Design Considerations for Integrated Features > Customer
Virtual Assistant Considerations section in Solution Design
Guide

Design Considerations

at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/
products-implementation-design-guides-list.html.

Operations Console (NOAMP) section in CVP Administration
Guide at https://www.cisco.com/c/en/us/support/

CVA configuration in UCCE/HCS
Deployment

customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

VVB Operations Guide at https://www.cisco.com/c/en/us/
support/customer-collaboration/virtualized-voice-browser/
products-maintenance-guides-list.html.

TTS Prompt Cache Management and proxy
setting for Speech Server

See the VXML Server Configuration > Proxy Settings in VXML
Server for Customer Virtual Assistant section in CVP

Proxy settings for VXML Server

Configuration Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

The following chapters in CVP Element Specification Guide
at https://www.cisco.com/c/en/us/support/

Configuration of Call Studio elements for
CVA

customer-collaboration/unified-customer-voice-portal/
products-programming-reference-guides-list.html:

• Dialogflow Element

• DialogflowIntent Element

• DialogflowParam Element

• Transcribe Element

See CVA Speech Configuration section in VVB Developer
Guide at https://developer.cisco.com/site/customer-voice-portal/
documents/virtual-voice-browser/.

CVA Speech Configuration APIs
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Feature Overview
Customer Virtual Assistant (CVA) feature enables the IVR platform to integrate with cloud-based speech
services. This feature supports human-like interactions that enable customers to resolve issues quickly and
more efficiently within the IVR, thereby, reducing the calls directed towards agents.

In a traditional IVR, customers can interact with the IVR in the following ways:

• VVB Media Services-Based Interaction: Prompts are played locally by VVB by downloading WAV
files. User inputs are captured using DTMF grammar.

• ASR-Based and TTS-Based Interactions: Prompts are played by the external media server overMRCP
Synthesis command for Text-to-Speech (TTS) functionality. The responses are recognized by external
media server based on predefined grammar provided by Asynchronous Speech Recognition (ASR).

CVA-based IVR enables a newmechanism to leverage cloud-based-AI-enabled speech services. CVA provides
the following speech services:

• Text-to-Speech: Integration with cloud-based TTS services in your application for Speech Synthesis
operations. CVA currently supports Google Text to Speech service.

• Speech-to-Text: Integration with cloud-based ASR services in your application for Speech Recognition
operations. CVA currently supports Google Speech to Text service.

• Speech-to-Intent: CVA provides capability of identifying the intent of customer utterances by processing
the text received from Speech-to-Text operations. CVA offers this service by using cloud-based Natural
Language Understanding (NLU) services. CVA currently supports Google Dialogflow service.

Getting Started
This section explains the prerequisites and the documentation resources for CVA.

Prerequisites
• CVP 12.5(1) and VVB 12.5(1).

• CVP/VVB configuration:

• Enable access to cloud-based services from CVP and VVB directly or via proxy.

For details, see the Cisco Unified Customer Voice Portal > Operations Console (NOAMP) >
Integration > Cloud Connect > Configure CVP or VVB Devices for Cloud Connect section in the
Administration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/c/en/us/
support/customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

• Synchronize the date/time in CVP, VVB, and proxy with a common NTP server.

• Configure access to DNS server in CVP/VVB.

For more information on NTP and DNS server configurations in CVP, refer to the Microsoft Windows
platform documentation.
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For more information on NTP and DNS server configurations in VVB, refer to the Command Line
Interface Reference Guide for Cisco Unified Communications Solutions at https://www.cisco.com/c/en/
us/support/unified-communications/unified-communications-manager-callmanager/
products-maintenance-guides-list.html.

• Non-OEM users must enable speech services and generate JSON key. To know more about enabling
speech services, see Enable Speech Services (for Non-OEM Users), on page 56. To know more about
generating JSON key, see Generate JSON Key (for Non-OEM Users), on page 56.

• OEM users must provision Google Contact Center AI (CCAI) for Cisco Contact Center Enterprise. To
know more about provisioning Google CCAI, see Provision Google CCAI with Unified Contact Center
Enterprise (for OEM Users), on page 57.

Documentation Resources
The following table lists the reference documents for CVA.

ResourceInformation

See https://github.com/CiscoDevNet/cvp-sample-code/tree/
master/CustomerVirtualAssistant.

Sample CVA Application

Design Considerations for Integrated Features > Customer
Virtual Assistant Considerations section in Solution Design
Guide

Design Considerations

at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/
products-implementation-design-guides-list.html.

Operations Console (NOAMP) section in CVP Administration
Guide at https://www.cisco.com/c/en/us/support/

CVA configuration in UCCE/HCS
Deployment

customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

VVB Operations Guide at https://www.cisco.com/c/en/us/
support/customer-collaboration/virtualized-voice-browser/
products-maintenance-guides-list.html.

TTS Prompt Cache Management and proxy
setting for Speech Server

See the VXML Server Configuration > Proxy Settings in VXML
Server for Customer Virtual Assistant section in CVP

Proxy settings for VXML Server

Configuration Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

The following chapters in CVP Element Specification Guide
at https://www.cisco.com/c/en/us/support/

Configuration of Call Studio elements for
CVA

customer-collaboration/unified-customer-voice-portal/
products-programming-reference-guides-list.html:

• Dialogflow Element

• DialogflowIntent Element
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ResourceInformation

• DialogflowParam Element

• Transcribe Element

See CVA Speech Configuration section in VVB Developer
Guide at https://developer.cisco.com/site/customer-voice-portal/
documents/virtual-voice-browser/.

CVA Speech Configuration APIs
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C H A P T E R 8
DB Integration

• Database Integration, on page 63
• Configure Database Integration , on page 63

Database Integration
You can integrate your contact center with an external database. Database integration provides create, update,
and retrieve operations on tables in the external database. Database integration uses the Database Element in
the CVP Call Studio.

Configure Database Integration

Configure Unified CCE

Configure ICM Database Lookup
Complete the following procedure to configure ICM Database Lookup.

Procedure

Step 1 Select Enable Database Routing in Router options to edit Router setup for database lookup changes.
Step 2 Configure Database Lookup explorer:

a) Click Start > All programs > Cisco Unified CCE Tools > Administration Tools > Configuration
Manager.

b) Open Tools > Explorer Tools > Database Lookup Explorer.
c) Configure Script Table and Script Table Column as shown in the following example:

Script Table:

Name: AccountInfo

Side A: \\dblookup1\DBLookup.AccountInfo

Side B: <Update Side B of database here>
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Description: <Provide description here>

dblookup1 is external database server name, DBLookup is external database name, and AccountInfo is
the table name.

Script Table Column:

Column name: AccountNo

Description: <Provide description here>

Step 3 Use the CCEDataProtect Tool to configure the registry settings in Unified CCE. For more information, see
Configure External DBLookUp Registry Value using CCEDataProtect Tool procedure in theAdministration
Guide for Cisco Unified Contact Center Enterprise at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-maintenance-guides-list.html

Step 4 Create the ICM script with the database lookup node with the respective table and lookup value.

The following figure shows AccountInfo as the table name and Call.CallingLineID as the lookup value.
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Figure 8: Example ICM Database Look Up

Configure Unified CVP

Configure VXML Database Element
You need to configure Java Database Connectivity (JDBC) for VXML Database Element configuration.

Complete the following procedures for JDBC configuration:

• Install JDBC driver, on page 66

• Add JNDI Context, on page 66
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• Configure VXML Studio Script, on page 67

• Create ICM Script, on page 67

Install JDBC driver

Complete the following procedure to install the JDBC driver:

Procedure

Step 1 Download the .exe file for Microsoft JDBC Driver for SQL Server

Example:

1033\sqljdbc_3.0.1301.101_enu.exe

Step 2 Run the executable and install the .exe file in the location C:\temp\
Step 3 Copy the fileC:\temp\sqljdbc_3.0\enu\sqljdbc4.jar to the Unified CVPVXML servers' folder

C:\Cisco\CVP\VXMLServer\Tomcat\common\lib

Add JNDI Context

Complete the following procedure to add the JavaNaming andDirectory Interface (JNDI) context configuration:

Procedure

Step 1 Go to the context.xml file located at C:\Cisco\CVP\VXMLServer\Tomcat\conf\context.xml file.
Step 2 Enter the JNDI name, SQL server address, SQL database name, username and password.

The following is an example of the SQL authentication context.xml file:

<Context>

<WatchedResource>WEB-INF/web.xml</WatchedResource>

<Manager pathname="" />

<Resource name="jdbc/dblookup"

auth="Container"

type="javax.sql.DataSource"

DriverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"

url="jdbc:sqlserver://<dblookupnode_ipaddress>:1433;databaseName=DBLookup;user=sa;password=sa"

>

</Context>

Step 3 Perform following steps to restart VXML server services:
a) Goto Run window and enter services.msc command.
b) Select Cisco CVP VXML Server option.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
66

DB Integration
Install JDBC driver



c) Right-click and select Restart option.

Configure VXML Studio Script

Complete the following procedure to configure the VXML studio script:

Procedure

Step 1 Configure the following to create the VXML application with the database element.
a) Select single under Type.
b) Enter the database lookup name in JNDI Name.
c) Query SQL:

For example, select AccountNo from AccountInfo where CustomerNo = {CallData.ANI}

Where AccountNo - Value to be retrieved

AccountInfo - Table name

CustomerNo - condition to be queried

Data:

Create a database element with the following values:

Name - AccountNo

Value - {Data.Element.Database_01.AccountNo}

Step 2 Deploy the script to the local computer or to the remote computer (VXML call server directly) to create CVP
Subdialog return element.

Step 3 If you saved this to the local machine, copy the whole folder to the following location:

<Install dir>:\Cisco\CVP\VXMLServer\applications and deploy it using deployAppwindows batch file located
inside the admin folder of applications.

Create ICM Script

Create an ICM script similar to the one shown in the following figure:
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Figure 9: Sample Script with ICM database Lookup
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C H A P T E R 9
Mobile Agent

• Capabilities, on page 69
• Initial Setup, on page 84
• Administration and Usage, on page 94
• Serviceability , on page 96

Capabilities

Cisco Unified Mobile Agent Description
Mobile Agent enables an agent to use any PSTN phone and a broadband VPN connection (for agent desktop
communications). The agent has the same capabilities as an agent in your call center using a Cisco IP Phone.

Unified Mobile Agent supports call center agents using phones that your contact center enterprise solution
does not directly control. You can deploy a Mobile Agent as follows:

• Outside the contact center, by using an analog phone or a mobile phone in the home.

• On an IP phone connection that is not CTI-controlled by HCS-CC or by an associated Unified
Communications Manager.

• On any voice endpoint of any ACD (including endpoints on other Unified Communication Managers)
that the contact center Unified Communication Manager can reach by a SIP trunk.

A Mobile Agent can use different phone numbers at different times; the agent enters the phone number at
login time. An agent can access the Mobile Agent functionality using any phone number that is included in
the Unified Communications Manager dial plan.

Unified Mobile Agent Extends Unified CCE Capabilities
Before Mobile Agent, Unified CCE used a JTAPI interface to Unified CM to connect customer calls arriving
on a voice gateway to an agent's IP phone. Mobile Agent enables the Unified CCE architecture to connect
customer calls to an agent phone that Unified CCE does not directly control.

Mobile Agent uses a pair of CTI ports that function as proxies for the Mobile Agent phone and the caller
phone. Every logged-in Mobile Agent requires two CTI ports (local and remote). The two CTI ports take the
place of the Cisco IP Phone monitored and controlled by Unified CM JTAPI. The agent at login uses the local
CTI port DN. When this agent is selected, the router transfers the caller to that CTI port. The remote CTI port
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calls the agent either at login for a nailed (permanent) connection or upon being selected for a call-by-call
connection.

Cisco Unified Contact Center functionality remains intact whether an agent is mobile or local:

• Mobile Agents have the same capabilities and functionality that local agents have.

• Mobile Agents do not need any specialized equipment; they can receive calls on an analog or mobile
phone.

• Unified Mobile Agent supports Cisco Finesse.

• Mobile Agent activity is recorded in the same contact center reports as local agent activity.

• Mobile Agent CTI and application data uses the same security mechanisms as local agent data.

Unified Mobile Agent Provides Agent Sign-In Flexibility
Agents can be either local agents or Mobile Agents, depending on how they sign in at various times.

Regardless of whether agents sign in as local or Mobile Agents, their skill groups do not change. Because
agents are chosen by existing selection rules and not by how they are connected, the same routing applies
regardless of how the agents log in. If you want to control routing depending on whether agents are local or
mobile, assign the agents to different skill groups and design your scripts accordingly.

Connection Modes
Cisco Unified Mobile Agent allows system administrators to configure agents to use either call by call dialing
or a nailed connection, or the administrator can configure agents to choose a connection mode at login time.

Mobile Agents are defined as agents using phones not directly controlled by Unified CC, irrespective of their
physical location. (The term local agent refers to an agent who uses a phone that is under control of Unified
CC, irrespective of physical location.)

You can configure Mobile Agents using either of two delivery modes:

• Call by Call—In this mode, the Mobile Agent's phone is dialed for each incoming call. When the call
ends, the Mobile Agent's phone is disconnected before being made ready for the next call.

• Nailed Connection—In this mode, the agent is called at login time and the line stays connected through
multiple customer calls.

The administrator can select the Agent chooses option, which allows an agent to select a call delivery mode
at login.

Note

Call by Call

In a call by call delivery mode, theMobile Agent's phone is dialed for each incoming call. When the call ends,
the Mobile Agent's phone disconnects before is it made ready for the next call.

The call by call call flow works as follows:

1. At login, the agent specifies an assigned extension for a CTI port.
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2. A customer call arrives in the system and, through normal Unified ICM configuration and scripting, is
queued for a skill group or an agent. (This is no different than existing processing for local agents.)

3. The system assigns an agent to the call. If the agent's Desk Setting is Unified Mobile Agent-enabled and
configured for either call by call or Agent chooses mode, the router uses the extension of the agent's CTI
port as a label.

4. The incoming call rings at the agent's CTI port. The JTAPI Gateway and PIM notice this but do not answer
the call.

5. A call to the agent is initiated on another CTI port chosen from a preconfigured pool. If this call fails,
Redirect on No Answer processing is initiated.

In call by call mode, the Answer Wait Time is 3 to 15 seconds longer than in a local agent inbound call
scenario. Specify a Redirect on No Answer setting large enough to accommodate the extra processing time.

Note

6. When the agent takes the remote phone off-hook to answer the call, the system directs the customer call
to the agent's call media address and the agent's call to the customer's call media address.

7. When the call ends, both connections are terminated and the agent is ready to accept another call.

To configureMobile Agent in call by call delivery mode, you must set the wrap-up timer to at least one second
using the Agent Desktop Settings List tool in the Configuration Manager.

In call by call delivery mode, callers often perceive a longer ring time compared to nailed connection delivery
mode. This is because callers hear the ringtone during the call flow; ringing stops only after the agent answers.
From the Unified CCE reporting perspective, aMobile Agent in call by call delivery mode has a longer Answer
Wait Time for the same reason.

Note

Nailed Connections

In nailed connection delivery mode, the agent is called once, at login, and the phone line remains connected
through multiple customer calls. See the following figure.

Figure 10: Nailed Connection Call Flow

The nailed connection call flow works as follows:
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1. At login, the agent enters the directory number of the local CTI port (LCP) in the Instrument Number
field and the remote phone number in CTI OS Desktop. The remote phone number can be any phone
number reachable by Unified CM.

When the agent clicks the Login button, a call is initiated to the agent's remote CTI port (RCP) and the
agent's remote phone rings.

2. When the agent answers the call, the call is then nailed up. This means that the agent will remain on this
call until the agent logs out or ends the call.

3. A customer's call arrives in the system , and scripting, is queued for a skill group/precision queue. (This
is no different than existing processing for local agents.)

4. When the agent clicks the Answer button, the voice path between the agent and the customer phone is
established, and the two parties can talk.

5. When the system assigns an agent to the call, the call is routed to the agent's LCP port. The agent then
hears the connect tone on the headset.

6. When the call ends, the customer connection is terminated and the agent state returns to Ready.

Connect Tone

The Connect Tone feature in the nailed connection mode enables the system to play a tone to the Mobile
Agent through the agent's headset to let the agent know when a new call is connected.

Connect Tone is particularly useful when Auto Answer is enabled or the agent is an Outbound agent. Here
are its features:

• An audible tone (two beeps) is sent to the Mobile Agent headset when the call to the nailed connection
Mobile Agent is connected. It is a DTMF tone played by Unified CM and cannot be modified.

• The Connect Tone plays only when the nailed connectionMobile Agent receives a call, as in the following
examples:

• The agent receives a consultation call.

• The agent receives an outbound call.

• The Connect Tone does not play when the Mobile Agent initiates a call, as in the following examples:

• The agent makes a call.

• The agent makes the consultation call.

• Outbound direct preview call is made.

• Supervisor barge-in call is made.

Related Topics
Enable Mobile Agent Connect Tone, on page 93

Agent Greeting and Whisper Announcement
TheAgent Greeting andWhisper Announcement features are available to UnifiedMobile Agents. The following
sections explain more about how these features apply to Unified Mobile Agents.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
72

Mobile Agent
Connect Tone



Agent Greeting

You can use the Agent Greeting feature to record a message that plays automatically to callers when they
connect to you. Your greeting message can welcome the caller, identify you, and include other useful
information.

Limitations

The following limitations apply to the Agent Greeting feature for Mobile Agents.

• A supervisor cannot barge in when an Agent Greeting is playing.

• If a Peripheral Gateway (PG), JTAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting
plays for a Mobile Agent, the call fails.

• If a Mobile Agent ends the call when an Agent Greeting plays, the customer still hears the complete
Agent Greeting before the call ends.

In the Agent Greeting Call Type Report, this call does not appear as a failed agent
greeting call.

Note

For more information about Agent Greeting, see Capabilities, on page 19.

Whisper Announcement

WithWhisper Announcement, agents can hear a brief prerecorded message just before they connect with each
caller. The announcement plays only to the agent; the caller hears ringing (based on existing ringtone patterns)
while the announcement plays. The announcement can contain information about the caller, such as language
preference or customer status. This information helps the agent prepare for the call.

Configuration Requirement

For the Whisper Announcement feature for Unified Mobile Agents, you require a Media Termination Point
(MTP) resource on an incoming SIP device.

Feature Requirements

Hardware and Software Requirements
Hardware and software requirements for the Unified Mobile Agent are identical to those of Unified CCE. For
more information on feature requirements, consult these documents:

• Solution Design Guide for Cisco Unified Contact Center Enterprise at https://www.cisco.com/c/en/us/
support/customer-collaboration/unified-contact-center-enterprise/
products-implementation-design-guides-list.html

• Virtualization for Unified Contact Center Enterprise at https://www.cisco.com/c/dam/en/us/td/docs/
voice_ip_comm/uc_system/virtualization/cisco-collaboration-virtualization.html

• Contact Center Enterprise Compatibility Matrix at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html
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Phone Requirements
A Unified Mobile Agent can use an analog, digital, or IP phone to handle calls.

Conference Requirements
To use Agent Greeting forMobile Agents, youmust configure external conference-bridge (hardware) resources.
To estimate the number of required resources, you can use the following formula:

Number of conference bridge resources = Mobile Agent call rate × Average greeting time (in seconds)

For information about configuring external conference-bridge resources, see the dspfarm profile 1
for conference configuration section in the sample configuration gateway, listed in Media Termination
Points Configuration, on page 89.

CTI Port Requirements
You need two CTI ports (local and remote) for every logged-in Mobile Agent.

Unified Mobile Agent uses Unified CM CTI Port as a proxy for the agent's phone. When this proxy is set up,
whenever a Mobile Agent is selected to handle a customer call, the following happens:

• The call is directed to the CTI port extension.

• intercepts the call arriving on the CTI Port and directs Unified CM to connect the call to the Mobile
Agent.

For Unified Mobile Agent to work properly, you must configure two CTI ports:

• One port to serve as the agent's virtual extension.

• The other port to initiate calls to the agent.

You must assign these CTI ports to the application. The ports are recognized by when receiving the Unified
CM configuration.

For these CTI ports in IPv6 enabled deployments, you have to set IP Addressing Mode to IPv4 Only. You
do this by creating a Common Device Configuration and referencing it to these CTI ports.

Supported Unified CCE/Unified CCH Features
The following features are supported:

• Unified CCE supports temporary uninstallation while preserving Mobile Agent data.

For more information about temporary uninstallation, see the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide.

• Mobile Agents can participate in outbound campaigns, but they must use a nailed-up connection for all
outbound dialing modes.

• Unified Mobile Agent supports Redirect on No Answer (RONA). If the Mobile Agent fails to answer,
the agent is made Not Ready, and the call is redirected to a RANA DN route point.

• Unified Mobile Agent supports G.711A-law, G.711u-law, and G.729 codecs.
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• There is no direct interaction between Unified Mobile Agent and multichannel applications. Email and
Chat are IP applications that continue to operate, assuming the Mobile Agent has a desktop with enough
bandwidth on the broadband connection to support them.

• Unified Mobile Agent supports Cisco Unified Customer Voice Portal (Unified CVP) and Cisco Unified
IP-IVR (Unified IP IVR).

Related Topics
Silent Monitoring, on page 77

Fault Tolerance Support
Fault tolerance for the Unified Mobile Agent follows the behavior of Unified CCE:

• The JTAPI Gateway, Unified CCE PIM, and CTI components record key events related to UnifiedMobile
Agent as part of the logging process.

• As with standard Unified CCE calls, if a Peripheral Gateway (PG) component such as the JTAPI Gateway
fails, the phone call is not lost, but subsequent call control (transfer, conference, or hold) might not be
possible after a failover. The Mobile Agent is notified of a failure (on the desktop), but they must log in
again after a Unified CM or Unified ICM failure occurs.

• Where CTI data is delivered for screen pops, CTI data is preserved.

Unified Mobile Agent can experience many of the same failure cases as Unified CCE:

• Side A/B failure

• VRU failure

• Unified CM failure

• CTI server failure

There are also some failure cases that are unique to Unified Mobile Agent:

• A situation where a Mobile Agent is using a cellular phone and the connection is dropped due to
non-availability of a signal, is deemed as external failure. The agent must call back and log-in again.

• If a Mobile Agent's phone line disconnects while using nailed connection mode, the agent must log in
again to receive new calls.

Important Considerations
Before you proceed, consider the following Unified Mobile Agent limitations and considerations:

Failover
• During a failover, if an agent in call by call mode answers an alerting call, the call can drop. This occurs
because the media cannot be bridged when there is no active PG.

• During a prolonged Peripheral Gateway (PG) failover, if an agent takes call control action for a Unified
Mobile Agent-to-Unified Mobile Agent call, the call can drop. This occurs because the activating PG
may not have information for all agents and calls at that point.
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• Unified Communications Manager failover causes a Mobile Agent call to be lost.

• If a call by call Mobile Agent initiates a call (including a supervisor call) and does not answer the remote
leg of the call before PG failover, the call fails. The agent must disconnect the remote agent call leg and
reinitiate the call.

Performance
•
• Because Unified Mobile Agent adds processing steps to Unified CCE default functionality, Mobile
Agents may experience some delay in screen popup windows.

• From a caller's perspective, the call by call deliverymode has a longer ring time compared with the nailed
connection delivery mode. This is because Unified CCE does not start to dial the Mobile Agent's phone
number until after the call information is routed to the agent desktop. In addition, the customer call media
stream is not connected to the agent until after the agent answers the phone.

The caller hears a repeated ringtone while Unified CCE makes these connections.

Codec
The codec settings on the Peripheral Gateway andVoice Gatewaymust match. Perform the following procedure:

1. Launch the Peripheral Gateway Setup.

2. In the Peripheral Gateway Component Properties, select the UCM PIM and click Edit.

3. In the CallManager Parameters section, select the appropriate codec from the Mobile Agent Codec drop
down list.

Figure 11: Mobile Agent Codec Selection
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Silent Monitoring
Unified Mobile Agent provides the following silent monitoring support:

• Unified Mobile Agent requires that caller and agent voice gateways be on separate devices if silent
monitoring is to be used.

• Unified Mobile Agent does not support desktop monitoring.

• Whenever silent monitoring is used on Unified Mobile Agent, caller and agent voice gateways must be
on separate devices. Similarly, if MTP is enabled when silent monitoring is used, MTP resources for
caller and agent must also be on separate devices.

Mobile Agent Scalability
Mobile Agent scalability may be contingent on specific Unified CM versions. For more information, see the
Solution Design Guide for Cisco Unified Contact Center Enterprise at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-implementation-design-guides-list.html.

Unsupported Features
The following is a list of unsupported features for Mobile Agent:

• Web Callback

• Blended Collaboration

• Unified CM-based Silent Monitoring

• Agent Request

Unified Mobile Agent Call Flows
This section provides sample Unified Mobile Agent call flows for:

• Inbound calls

• Local consultation calls

• Remote consultation calls

• Remote conference calls

In all Unified Mobile Agent call flows, the JTAPI Gateway maintains the signaling association between the
inbound and outbound calls and, if necessary, performs further operations on the call. JTAPI Gateway, however,
does not terminate media; it uses CTI to deliver the customer call from the inbound gateway port to the
outbound gateway port.

This means that a Mobile Agent must use an agent desktop application to log in, change agent state, log out,
send dual-tone multifrequency (DTMF) digits, and perform call control.

About Figures in This Section
The figures in this section:
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• Show a caller and a Mobile Agent in a cellular network. However, the same concepts apply whether the
Mobile Agent is using an enterprise desk phone, an IP Phone spanning another Unified CM cluster,
standard analog phone, or a third-party ACD phone.

• Focus solely on call media flow; a Mobile Agent must use a CTI Desktop with broadband access to
perform agent state and call control.

• Show only a sampling of the call flows possible with Unified Mobile Agent.

Inbound Call Flow
The following figure shows an inbound call flow.

Figure 12: Mobile Agent Inbound Call Flow

Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

Note

The following describes an inbound call flow:

1. The Mobile Agent becomes available to answer calls by:

• Logging in to the corporate domain using VPN over the ADSL/Cable connection

• Launching the agent desktop interface and logging in with their remote phone information

• Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.
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4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. The JTAPI Gateway places a call on a network CTI port to the agent's cell phone.

6. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the
call from the inbound (caller) gateway port to the outbound (agent) gateway port.

Local Consult Calls
The following figure shows a consult call flow between a Mobile Agent and a local agent.

Figure 13: Mobile Agent Consult Call Flow

Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

Note

The following describes a local consult call flow:

1. The Mobile Agent becomes available to answer calls by:

• Logging in to the corporate domain using VPN over the ADSL/Cable connection

• Launching the agent desktop interface and logging in with their remote phone information

• Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.
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4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. The JTAPI Gateway places Agent Connection Call 1 on a network CTI port to the agent's cell phone.

6. TheMobile Agent places the customer call on hold and consults a local Unified CCE/Unified CCH agent.

7. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the
call from the IP hard phone to the outbound gateway port.

Remote Consult Calls
The following figure shows a remote consult call flow between two Mobile Agents.

Figure 14: Mobile Agent Remote Consult Call Flow

Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

Note

The following describes a remote consult call flow:

1. The Mobile Agent becomes available to answer calls by:

• Logging in to the corporate domain using VPN over the ADSL/Cable connection

• Launching the agent desktop interface and logging in with their remote phone information

• Entering the Ready mode

2. A customer call arrives at the Unified CC.
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3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. The JTAPI Gateway places Agent Connection Call 1 on a network CTI port to the agent's cell phone.

6. Mobile Agent 1 puts the customer call on hold and consults Mobile Agent 2.

7. The JTAPI Gateway uses the network CTI port of Mobile Agent 1 and the network CTI port of Mobile
Agent 2 to stream the media for the call from the outbound gateway port on Agent Gateway 1 to the
outbound gateway port on Agent Gateway 2.

Remote Conference Calls
The following figure shows a remote conference call flow between two Mobile Agents.

Figure 15: Mobile Agent Remote Conference Call Flow

Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

Note

The following describes a remote conference call flow:

1. The Mobile Agent becomes available to answer calls by:
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• Logging in to the corporate domain using VPN over the ADSL/Cable connection

• Launching the agent desktop interface and logging in with their remote phone information

• Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. Unified CM redirects the media stream 1 from inbound gateway on the Caller Gateway to the conference
bridge during call merging process.

6. The JTAPI Gateway uses local and network CTI ports of Mobile Agent 1 to loop the Media Stream 2 for
the call from the outbound gateway port on the Agent Gateway 1 to the conference bridge.

7. The JTAPI Gateway uses local and network CTI ports of Mobile Agent 2 to loop the Media Stream 3 for
the call from the outbound gateway port on the Agent Gateway 2 to the conference bridge.

Outbound Option Call Flow
The following figure shows a Outbound Option call flow between a customer and a Mobile Agent.

Unified Mobile Agent supports Outbound Option calls in nailed connection delivery mode only.Note

Figure 16: Mobile Agent Outbound Call Flow
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Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

Note

The following describes an Outbound Option call flow:

1. The Mobile Agent becomes available to answer calls by:

• Logging in to the corporate domain using VPN over the ADSL/Cable connection

• Launching the agent desktop interface and logging in with their remote phone information

• Entering the Ready mode

2. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

3. Outbound Option dials the customer number and, after reaching a live customer, the Dialer redirects the
customer call to the local CTI Port of an Outbound Option Mobile Agent.

4. The JTAPI Gateway places a call on a network CTI port to the agent's cell phone.

5. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the
call from the inbound gateway port to the outbound gateway port.

Unified Mobile Agent Reporting
UnifiedMobile Agent-specific call data is contained in the following Cisco Unified Intelligence Center reports:
Agent TeamHistorical, Agent Real Time, and Agent Skill Group Historical. These “All Field” reports contain
information in multiple fields that show what kind of call the agent is on (nonmobile, call by call, nailed
connection) and the Unified Mobile Agent phone number.

Notes about Mobile Agents and reporting:

• The Mobile Agent must be logged in through the agent desktop for call data to be recorded in Unified
CC reports.

• Service level for Mobile Agent calls might be different than local agent calls, because it takes longer to
connect the call to the agent.

For example, a call by call Mobile Agent might have a longer Answer Wait Time Average than a local
agent. This is because Unified CCE/Unified CCH does not start to dial the Mobile Agent phone number
until after the call information is routed to the agent desktop. In addition, the customer call media stream
is not connected to the agent until after the agent answers the phone.

For more information about Unified Mobile Agent fields in the database schema, see Database Schema
Handbook for Cisco Unified Contact Center Enterprise.
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Initial Setup

Summary of Unified Mobile Agent System Configuration Tasks
The following table describes system configuration tasks for Unified Mobile Agent.

Table 3: Unified Mobile Agent System Configuration Tasks

SeeTask

Unified CM CTI Port Configuration and Mapping for Unified Mobile
Agent, on page 84

Configure Unified CM CTI Port
pools

Maximum Call Duration Timer Configuration, on page 87ConfigureUnified CMCall Duration
Timer

Agent Desk Setting Configuration for Unified Mobile Agent, on page
88

Configure Agent Desk Settings

Device Configuration for Unified Mobile Agent, on page 89Configure Devices

Media Termination Points Configuration, on page 89ConfigureMedia Termination Points

Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent
This section describes the CTI Port Pool configuration tasks specific to Mobile Agent Option configuration.
It does not discuss installation or configuration of Unified CCE.

For more information about installing and configuring Unified CM with Unified CCE, see the Cisco Unified
Contact Center Enterprise Installation and Upgrade Guide.

Note

Unified Mobile Agent must have two CTI ports configured on Unified CM:

• A local CTI port, which Unified Mobile Agent uses as the agent's virtual extension.

• A remote CTI port, which Unified Mobile Agent uses to initiate a call to the Mobile Agent's phone.

Naming Conventions for Local and Network Ports

• The local port must begin with the string LCP.

• The remote port must begin with the string RCP.

• The remaining characters in the device names for the LCP and RCP pair must match. For example an
LCP port named LCP0000 has a corresponding RCP port named RCP0000.

• For example, you can use the following naming convention:
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• For a local CTI Port pool name, configure a name in the format LCPxxxxFyyyy, where LCP identifies
a local CTI Port Pool, xxxx is the peripheral ID for the Unified CM PIM, and yyyy is the number of
local CTI Port.

Example: LCP5000F0000 represents CTI Port: 0 in a local CTI Port pool for the Unified CM PIM
with the peripheral ID 5000.

• For a network CTI Port pool name, use the same format, except substitute RCP as the first three
characters.

While you do not require a naming convention, the substrings identifying the
Unified CM PIM peripheral ID and the CTI Port must match for each
local/network pair.

Note

CTI Port configuration consists of the following steps:

1. Add the CTI port as you would for an IP Phone.

2. Use the naming convention described above to map the local and network CTI ports.

Each local CTI port must have a corresponding network CTI port.Note

3. Add a directory number for the local CTI port (that is, the agent's virtual extension).

4. Map the local and network CTI ports with the PG user.

Music on Hold Design
If you want callers to hear music when a Mobile Agent places the caller on hold, you must assign Music on
Hold (MoH) resources to the ingress voice gateway or trunk that is connected to the caller (as you do with
traditional agents). In this case, the user or network audio source is specified on the local CTI port configuration.
Similarly, if a Mobile Agent must hear music when the system puts the agent on hold, you must assign MoH
resources to the ingress voice gateway or trunk that is connected to the Mobile Agent. In this case, the user
or network audio source is specified on the remote CTI port configuration.

Do not assign MoH resources to local ports and remote CTI ports, because it might affect the system
performance.

If a remote Mobile Agent calls over a nailed connection and if there is no active call to the agent, the agent
is put on hold. Enable MoH to the Mobile Agent phone for nailed connection calls. If MoH resources are an
issue, consider multicast MoH services.

If a remote Mobile Agent calls over a nailed connection, and if MoH is disabled, the hold tone plays to the
agent phone during the hold time. Because the hold tone is similar to the connect tone, it is difficult for the
agent to identify if a call arrived from listening to the Mobile Agent connect tone. The hold tone prevents the
agent from hearing the connect tone.

Configure Unified CM CTI Port Pools for Unified Mobile Agent
Perform the following steps to configure CTI Ports.
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Procedure

Step 1 In Unified CM Administration, select Device > Phone.
Step 2 Click Add a New Phone.
Step 3 From Phone Type, select CTI Port.
Step 4 Click Next.
Step 5 In Device Name, enter a unique name for the local CTI Port pool name; click OK when finished.

Using the naming convention format LCPxxxxyyyy:

• LCP identifies the CTI Port as a local device.

• xxxx is the peripheral ID for the Unified CM PIM.

• yyyy is the local CTI Port.

The name LCP5000F0000 would represent CTI Port: 0 in a local CTI Port pool for the Unified CM PIM with
the peripheral ID 5000.

The name LCP0000 represents the local port.

Step 6 In Description, enter text that identifies the local CTI port.
Step 7 Use the Device Pool drop-down list to choose the device pool to which you want to assign the network CTI

port pool. Do not select Default. (The device pool defines sets of common characteristics for devices.)
Step 8 Click Save.
Step 9 Highlight a record and select Add a New DN.
Step 10 Add a unique directory number for the CTI port you just created.
Step 11 In Maximum Number of Calls, enter 2.
Step 12 In Busy Trigger, enter 1.
Step 13 When finished, click Save, and click Close.
Step 14 Repeat the preceding steps to configure the network CTI port pool.

In Device Name, using the naming convention format RCPxxxxyyyy, where:

• RCP identifies the CTI port as the Remote CTI port where the call between the agent's remote device
and the Unified CM Port is nailed up at agent login time.

• xxxx is the peripheral ID for the Unified CM PIM.

• yyyy is the network CTI port.

The name RCP5000F0000 represents CTI Port: 0 in a network CTI Port pool for the Unified CM PIM with
the peripheral ID 5000.

Step 15 In Description, enter text that identifies the network CTI port pool.
Step 16 Use the Device Pool drop-down list to choose the device pool to which you want to assign the network CTI

port. Do not select Default. pool. (The device pool defines sets of common characteristics for devices.)
Step 17 Click Save.
Step 18 Highlight a record and select Add a New DN.
Step 19 Add a unique directory number for the CTI port you just created.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
86

Mobile Agent
Configure Unified CM CTI Port Pools for Unified Mobile Agent



The extension length can be different from the extension length of the LCP Port if your dial plan requires it.

Step 20 When finished, click Save, and click Close.

Map Local and Remote CTI Ports with Peripheral Gateway User
After you define the CTI Port pool, you must associate the CTI Ports with PG users.

Procedure

Step 1 In Unified CM Administration, select Application User.
Step 2 Select a username and associate ports with it.
Step 3 When finished, click Save, and then click Close.

If CTI ports for Unified Mobile Agent are disassociated at the Unified CMwhile a Mobile Agent
is on an active call, the call can drop.

Note

Maximum Call Duration Timer Configuration
By default, Mobile Agents in nailed connection mode log out after 12 hours. This happens because a Unified
CM Service Parameter—the Maximum Call Duration Timer—determines the amount of time an agent phone
can remain in the Connected state after login.

If you anticipate that nailed connection agents in your Unified Mobile Agent deployment will be logged on
longer than 12 hours, use the following instructions to either:

• Increase the Maximum Call Duration Timer setting.

• Disable the timer entirely.

Configure Maximum Call Duration Timer

This procedure applies only to UnifiedMobile Agent deployments where agents logged in to nailed connection
mode are to remain connected longer than 12 hours. Also, if your Mobile Agent deployment uses intercluster
trunks, you must perform the following steps on both local and network Unified CM clusters.

Note

Procedure

Step 1 In Unified CM Administration, choose System > Service Parameters.
Step 2 In the Server drop-down list, choose a server.
Step 3 In the Service drop-down list, choose a server .

The Service Parameters Configuration windowappears.
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Step 4 In the Cluster-wide Parameters section, specify a Maximum Call Duration Timer setting.

The default is 720 minutes (12 hours); the maximum setting allowed is 35791 minutes.

To disable the timer, enter 0.Note

Step 5 Click Save.

Agent Desk Setting Configuration for Unified Mobile Agent

Configure Agent Desk Settings with Configuration Manager
This section describes Agent Desk Settings configuration settings you should specify in Unified ICM
Configuration Manager to accommodate Unified Mobile Agent features.

The following instructions describe how to configure one Agent Desk Setting. Repeat this process for each
different Agent Desk Setting in your deployment.

Procedure

Step 1 From the Unified ICMConfigurationManager, chooseConfigure ICM >Enterprise >Agent Desk Settings
List.

The Unified ICM Agent Desk Settings List dialog box opens.

Step 2 Click Retrieve.
Step 3 Click Add.
Step 4 Fill in the following Attributes tab information, making sure to include settings for the following fields and

check boxes:

• Ring no answer time. The system allows a call to ring at the agent's station before redirecting the call.
This can be from 1 to 120 seconds.

If you use call by call mode, the answer wait time will be longer than in a local agent inbound
call scenario, so specify a value in this field to accommodate the extra processing time.

Note

• Logout non-activity time. The number of seconds of agent inactivity while in the not ready state before
the system logs out the agent. A blank entry disables the timer.

• Cisco Unified Mobile Agent (check box). Enables the Mobile Agent feature so that the agent can log
in remotely and take calls from any phone.

• Mobile Agent mode. Select how call connections are made to the Mobile Agent's phone:

• Agent chooses. Agent selects call by call or nailed connection at login.

• Call by call. Agent's phone is dialed for each incoming call. When a call ends, the connection is
terminated before the agent is made ready for next call.

• Nailed connection. Agent is called once, at login. The line stays connected throughmultiple customer
calls.
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Step 5 Click Save.

For more information about configuring Agent Desk Settings in Unified CCE, see Cisco Unified Contact
Center Enterprise Installation and Upgrade Guide.

Note

Device Configuration for Unified Mobile Agent
Use the Agent Targeting Rules (ATR) mechanism described in the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide to configure a device as you would for a phone, but using the LCP Port in
place of the agent's phone extension.

Media Termination Points Configuration
If you use SIP trunks, you must configure Media Termination Points (MTPs). You must also configure MTPs
if you use TDM trunks to create an interface with service providers.

Additionally, MTPs are required for Mobile Agent call flows that involve a Cisco Unified Customer Voice
Portal (CVP) solution. Because in DTMF signaling mode the Mobile Agent uses out-of-band signaling,
whereas Unified CVP supports in-band signaling, the conversion from out-of-band to in-band signaling
requires an MTP resource.

MTPsmay be allocated as required in deployments that use a mix of IPv4 and IPv6 connections.MTP resources
are allocated provided that the Media Resource Group List is configured on the IPV4 endpoint.

MTPs are available in the following forms, but not all are supported in Mobile Agent environments:

• Software-based MTPs in Cisco IOS gateways—use these MTPs for Mobile Agent as they provide codec
flexibility and improved scalability compared with other MTP options. The following is a sample
configuration on a gateway.
sccp local GigabitEthernet0/0
sccp ccm 10.10.10.31 identifier 1 priority 1 version 7.0
sccp ccm 10.10.10.131 identifier 2 priority 2 version 7.0
sccp
!
sccp ccm group 1
associate ccm 1 priority 1
associate ccm 2 priority 2
associate profile 3 register gw84xcode
associate profile 1 register gw84conf
associate profile 2 register gw84mtp
!
dspfarm profile 3 transcode
codec g729abr8
codec g729ar8
codec g711alaw
codec g711ulaw
codec g729r8
codec g729br8
maximum sessions 52
associate application SCCP
!
dspfarm profile 1 conference
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codec g729br8
codec g729r8
codec g729abr8
codec g729ar8
codec g711alaw
codec g711ulaw
maximum sessions 24
associate application SCCP
!
dspfarm profile 2 mtp
codec g711ulaw
maximum sessions software 500
associate application SCCP

• Hardware-basedMTPs in Cisco IOS gateways—TheseMTPs are supported. If you choose these, consider
the extra cost, codec restrictions, and scalability constraints.

• Software-based MTPs using the Cisco IP Voice Media Streaming Application—These MTPs are not
supported with Mobile Agents.

Because Unified CM-based software MTPs are used implicitly, you must add a special configuration to avoid
using thcce-in10360-01-pcceucceipv6support-1101em. Create a new Media Resource Group (MRG) as a
place holder, and place the software MTPs in that MRG. For instructions, refer to the Unified CM help
documentation.

Note

Configure Media Termination Points in Unified CM

Add MTP Resources to Unified CM

Perform these steps to add media termination points (MTPs) to Unified CM.

Procedure

Step 1 In Unified CM Administration click Media Resources > Media Termination Point.
Step 2 Click Add New.
Step 3 Choose Cisco IOS Enhanced Software Media Termination Point from the Media Termination Point

Type drop-down list.
Step 4 Enter anMTP name. This name must match the device name you chose in IOS. In the example in the previous

section, the MTP was called gw84mtp, as from the config line: associate profile 2 gw84mtp.
Step 5 Choose the appropriate device pool.
Step 6 Click Save and then click Apply config.
Step 7 Navigate back to Media Termination Point and ensure the newly added MTP is listed as being registered

with <Unified CM subscriber IP address> in the Status column.
Step 8 Repeat steps 1 through 7 for each sccp ccm group you configured on each of your gateways.

Configure Media Termination Point Resources in Unified CM

This section explains how to create media resource groups and media resource group lists.
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Procedure

Step 1 Navigate to Media Resources > Media Resource Group in Unified CM Administration.
Step 2 Click Add New.
Step 3 Specify a name and description.
Step 4 From the Available Media Resources that you just created, move the those devices from the Available to the

Selected list by clicking the down arrow. Ensure that you do not include Unified CM Software resources. For
example, type anything that starts with ANN_, MTP_, or MOH_ .

Step 5 Navigate to Media Resources > Media Resource Group List.
Step 6 Click Add New.
Step 7 Move the Media Resource Group you just created from the Available Media Resource Groups to the Selected

Media Resource Groups.
Step 8 Click Save.

Associate Media Resource Group List with Device Pools

Procedure

Step 1 Navigate to System > Device Pool and click on the device pool that contains the CTI ports for Mobile Agent.
If there are multiple pools, perform the next step for each device pool that applies.

Step 2 In the Media Resource Group List drop-down list, select the Media Resource Group List that you just created,
click Save and then click Apply config.

Quarantine Unified CM Software-Based Resources

Unified CM-based software MTPs are used by default. However, Cisco contact center deployments do not
support these resources because they may cause performance problems in call processing. Youmust quarantine
them with a special configuration. Perform the following steps:

Procedure

Step 1 Create a new Media Resource Group (MRG) as a place holder.
Step 2 Place the software MTPs in that MRG.

For further instructions, refer to the Unified CM help documentation.

Insert MTPs

If you use SIP trunks, you must configure MTPs. This also applies if you use TDM trunks to interact with
service providers. Mobile Agent cannot use an MTP with codec pass through. When you configure the MTP,
you must select No pass through. KPML is not supported with Mobile Agent.
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Procedure

Step 1 Log in to Unified CM Administration and select Device > Trunk.
Step 2 Select the trunk on which you want to configure MTPs.
Step 3 Depending on the scenario listed below, perform the corresponding step listed in the Description column.

Note that if you configure Trunk Groups to dynamically insert MTPs, only the calls that require MTPs use
them.

• If you want to always insert MTPs for inbound and outbound calls through a given trunk: In the Trunk
Configuration settings, select the Media Termination Point Required check box.

• If you want to dynamically insert MTPs when Unified ICM detects media or signaling incompatibility
between the caller and called endpoints: In the Trunk Group Configuration settings, in DTMF Signaling
Method, select RFC2833.

Enable Call Progress Tones for Agent-Initiated Calls

Procedure

When MTP Required is not enabled, extra configuration is required to enable an agent to hear call progress
tones for agent initiated calls. If instead you have dynamic MTP allocation by forcing mismatched DTMF
settings, then configure the Unified Communications Manager to enable Early Offer.

For information on configuring the Unified Communications Manager, see the Unified Communications
Manager product documentation at https://www.cisco.com/c/en/us/support/unified-communications/
unified-communications-manager-callmanager/tsd-products-support-series-home.html. The CiscoAnnunciator
does not generate ringback and other call progress tones, as it does for regular phones and softphones. Instead,
Mobile Agent relies on the called party generating these tones (and the early offer setting triggers sending
these tones to the agent).

This selection does not affectMTP sizing for IP Phones and other endpoints that support RFC2833
signaling, as is the case for many Cisco phones. For more information about supported phones,
see the Contact Center Enterprise CompatibilityMatrix at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html.

Note

Verify MTP Resource Utilization

Since Unified CM comes preconfigured with Software MTP resources, these resources may sometimes be
used to provide MTP for Mobile Agent calls without proper configuration. Because we don't support the use
of Unified CM based software MTPs, we explicitly quarantined them in the above section, Disabling Unified
CM Based Software MTPs. To ensure that the new IOS-based MTPs are the ones being used for Mobile
Agents, perform the following steps to verify that correct MTPs are used.
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Procedure

Step 1 Install the Unified CM Realtime monitoring tool. This tool can be downloaded under Application > Plugins
within Unified CM Administration.

Step 2 Place a call to a logged-in Mobile Agent.
Step 3 Open the Unified CMRealtimemonitoring tool and navigate to System > Performance >Open Performance

Monitoring.
Step 4 Expand the node(s) that are associated with your IOS-based MTP resources and choose Cisco MTP Device.
Step 5 Double-click Resources Active and choose all of the available resources to monitor. This includes both IOS

and Unified CM-based resources. Ensure that the only resources that are active during the Mobile Agent
phone call are the IOS-based resources. Also, ensure that all UCM-based MTP resources are not active.

Step 6 Repeat the previous step for each node that has MTP resources associated with it.

Enabled Connect Tone Feature
In a nailed connection, the system can play a tone to the Unified Mobile Agent through the agent headset to
let the agent know when a new call is connected. In the default Installation, the Mobile Agent Connect Tone
feature is disabled.

Enable Mobile Agent Connect Tone
If you require Unified Mobile Agent Connect Tone, you must make the following change in the Windows
Registry for the key PlayMAConnectTone under the JTAPI GW PG registry entries.

Perform the following procedure to allow a Mobile Agent in the nailed connection mode to hear a tone when
a new call is connected.

Before you begin

MTP resources must be associated with the CUCM trunk that connects to the Agent Gateway.

Procedure

Step 1 On the PG machine, open the Registry Editor (regedit.exe).
Step 2 Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,

Inc.\ICM\<InstanceName>\PG1A\PG\CurrentVersion\JGWS\jgw1\JGWData\Config\PlayMAConnectTone.

The Edit DWORD Value dialog box appears.

Step 3 In the Value data: field, enter 1 to enable Mobile Agent Connect Tone and click OK.
Step 4 Exit the Registry Editor to save the change, and cycle the PG service.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
93

Mobile Agent
Enabled Connect Tone Feature



Administration and Usage

Cisco Finesse

Sign in to Cisco Finesse Desktop

Procedure

Step 1 In the ID field, enter your agent ID.
Step 2 In the Password field, enter your password.
Step 3 In the Extension field, enter your extension.

For a mobile agent, the extension represents the virtual extension for the agent, also known as the local CTI
port (LCP).

Step 4 Check the Sign in as a Mobile Agent check box.

The Mode and Dial Number fields appear.

Step 5 From the Mode drop-down list, choose the mode you want to use.

In Call by Call mode, your phone is dialed for each incoming call and disconnected when the call ends.

In Nailed Connection mode, your phone is called when you sign in and the line stays connected through
multiple customer calls.

Step 6 In the Dial Number field, enter the number for the phone you are using.

DescriptionOption

The agent ID.ID

Your supervisor assigns this password.Password

The agent's extension.Extension
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DescriptionOption

Select to sign in as a Unified Mobile Agent.Sign in as Unified Mobile Agent

Call by Call or Nailed ConnectionMode

The number of the phone being used.Dial Number

Step 7 Click Sign In.

In Nailed Connection mode, the desktop must receive and answer a setup call before sign-in is
complete.

In Call by Call mode, the dial number provided is not verified. To ensure that the number is
correct, verify the number in the header on the Agent Desktop after sign-in is complete.

Note

Verify Sign-In to Cisco Finesse

Procedure

Check to be sure the Finesse Agent Desktop displays the following in the header:

• Mobile Agent before your agent name

• The mode used (Call by Call or Nailed Connection)

• The dial number you provided

Enable Ready State
You must be in Ready state to process incoming calls.

Procedure

Choose Ready from the drop-down list below the agent name.
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If you are in call-by-call mode, you must answer and end each incoming call on your physical
phone. After you answer a call, you must perform all other call control functions (such as
Conference, Transfer, Hold, Retrieve) using the desktop.

With call-by-call connection, an agent cannot end one leg of a transfer without terminating it at
the other end. The transfer must either be fully completed or both legs completely dropped.

If you are in Nailed Connection mode, after you answer the initial setup call, you must perform
all other call control functions using the desktop.

Note

Make a Call

Procedure

Step 1 From the drop-down list below the agent name, choose Not Ready.

You must be in Not Ready state to make a call.Note

Step 2 Click Make a New Call.
Step 3 Enter the number you want to call on the keypad, and then click Call.

If you are in Call by Call mode, the CTI server sends a setup call to your phone. A message appears on the
keypad that states the following:

A call will be initiated to your phone which must be answered before an
outbound call to your destination can be made.

After the setup call is answered, the system establishes the outbound call to the destination specified.

Serviceability
On a Mobile Agent call flow, CUCM may return a 404 error due to the absence of a agent greeting, leading
to call failure. To fix this issue, do the following:

1. Create a newRun External Script node.Map the backupmedia of the script to the agent greeting recording
(media file).

2. Add the Run External Script node between the failure path of the AgentGreeting Run External Script node
and the End node.

3. Connect the Run External Script node's success path to the existing Release Call node and failure path to
the existing End node.

This fix may add a short delay of one to two seconds to the call flow.

For information about Create Agent Greeting Play Script, on page 28.

Note

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
96

Mobile Agent
Make a Call



C H A P T E R 10
Music on Hold

• Capabilities, on page 97
• Configure Music on Hold, on page 98

Capabilities

Hold and Resume
Agents use Hold to suspend a call temporarily. If Music on Hold resources are available, the caller hears music
while on hold. Otherwise, the caller hears a tone.

Multicast Music-on-Hold
As an alternative to the unicast Music-on-Hold (MOH), you can multicast MOHwith supplementary services
on Unified CM. You have these options when deploying MOH with this feature:

• With Unified CM multicasting the packets on the local LAN

• With the branch gateway multicasting on their local LAN

Use branch gateway multicasting when you have configured survivable remote site telephony (SRST) on the
gateway. This method enables the deployment to use MOH locally and avoid MOH streaming over the WAN
link.

For information about configuring MOH on the Call Manager Enterprise (CME), see https://www.cisco.com/
c/en/us/td/docs/voice_ip_comm/cucme/admin/configuration/manual/cmeadm/cmemoh.html#wpmkr1022205.

Note

Music on Hold with Mobile Agent
You can use Music on Hold (MoH) for mobile agents just as you do for traditional agents. To let callers hear
music, assign MoH resources to the Ingress Voice Gateway. Specify the user or network audio source on the
local CTI port configuration. To let the agent hear music when on hold, assign MoH resources to the Egress
Voice Gateway. Specify the user or network audio source on the remote CTI port configuration.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
97

https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucme/admin/configuration/manual/cmeadm/cmemoh.html#wpmkr1022205
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucme/admin/configuration/manual/cmeadm/cmemoh.html#wpmkr1022205


Always assign the MoH resources to the gateways. Do not assign MoH resources to local and remote CTI
ports. It is unnecessary and can have a performance impact on the system.

Note

A Mobile Agent remote call over a nailed connection is put on hold when there is no active call to the agent.
In general, enable MoH to the mobile agent phone for nailed connection calls. If MoH resources are an issue,
consider multicast MoH services.

For a nailed connection, disabling MoH for the remote phone might lead to the hold tone playing instead.
This depends on the call processing agent that controls the remote phone. For Unified CM, the hold tone is
enabled by default and is similar to the Mobile Agent connect tone. With the Unified CM hold tone enabled,
it is difficult for the agent to identify if a call has arrived by listening for the Mobile Agent connect tone.
Therefore, disable the hold tone for Unified CM by changing the setting of the Tone on Hold Timer service
parameter on Unified CM.

For additional information aboutMoH design, see theCisco Collaboration System Solution Reference Network
Designs.

Configure Music on Hold

Configure Unified Communication Manager
A Unified Communications Manager Music On Hold (MoH) server can generate MoH stream from an audio
file or a fixed source. Either of this can be transmitted as unicast or multicast.

MoH server can be deployed in two modes.

1. Along with Unified CM on the same server for HCS for CC deployments with less than 1250 users in a
CM Cluster.

2. As standalone node (TFTP/MoH Server) for HCS for CC deployments with more than 1250 users in a
CM Cluster

• Configure Music On Hold Server Audio Source, on page 98

• Set up Service Parameters for Music on Hold, on page 99

• Set up Phone Configuration for Music on Hold, on page 99

Configure Music On Hold Server Audio Source

Procedure

Step 1 Login to Cisco Unified Communications Manager Administration page.
Step 2 Select Media Resources > Music On Hold Audio Source.
Step 3 Retain the default sample audio source.
Step 4 Select Initial Announcement from drop down list (optional).
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Step 5 Click Save.
Step 6 Perform the following steps to create new Audio Source.

a) Click Add New.
b) Select MOH audio stream number from the drop down list.
c) Select MOH audio source file from the drop down list.
d) Enter the MOH source name .
e) Choose Initial Announcement from the drop-down list.
f) Click Save.

Set up Service Parameters for Music on Hold

Procedure

Step 1 Login to Cisco Unified Communications Manager Administration page.
Step 2 Select System > Service Parameters.
Step 3 Select the MoH server from the drop-down list .
Step 4 Select the app service from Cisco IP Voice Media Streaming App Service drop-down list.
Step 5 Select the required codec in the Supported MOH Codecs field and click Ok.
Step 6 Click Save.

Set up Phone Configuration for Music on Hold

Procedure

Step 1 Login to Cisco Unified Communications Manager Administration page.
Step 2 Select Device > Phone.
Step 3 Select the phone to configure MOH.
Step 4 Select a audio source from User Hold MOH Audio Source drop-down list.
Step 5 Select a audio source from Network Hold MOH Audio Source drop-down list.
Step 6 Click Save and click Apply and reset the phone.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
99

Music on Hold
Set up Service Parameters for Music on Hold



Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
100

Music on Hold
Set up Phone Configuration for Music on Hold



C H A P T E R 11
Precision Queue

• Precision Queues, on page 101
• Skill Groups or Precision Queues?, on page 102
• Attributes, on page 103
• Precision Queue Call Flow Example, on page 104
• Scripts for Precision Queues, on page 104
• Precision Queue Script Node, on page 105
• Queuing Behavior of the Precision Queue Node, on page 105
• Dynamic Limits for Skill Groups and Precision Queues Per Agent, on page 106
• Initial Setup, on page 107

Precision Queues
Precision routing offers a multidimensional alternative to skill group routing: using Unified CCE scripting,
you can dynamically map the precision queues to direct a call to the agent who best matches the caller's precise
needs. Precision queues are the key components of precision routing.

To configure Precision Routing, you must do the following:

1. Create attributes. Attributes are characteristics that can be assigned a True | False value or a Proficiency
rating from 1 to 10.

2. Assign attributes to agents.

3. Create precision queues.

4. Create routing scripts.

There is no need to add an agent to a precision queue; agents becomemembers of precision queues automatically
based on their attributes. If a precision queue requires an agent who lives in Boston, who speaks fluent Spanish,
and who is proficient in troubleshooting a specific piece of equipment, an agent with the attributes Boston =
True, Spanish = True, and Repair = 10 is automatically part of the precision queue. A Spanish caller in Boston
who needs help with equipment is routed to that agent.

A precision queue includes:

• Terms: A term compares an attribute against a value. For example, you can create the following term:
Spanish == 10. The term of the attribute is the highest proficiency in Spanish.
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Each precision queue can have multiple attributes, and these attributes can be used in multiple terms.
For example, to select an agent with a Spanish proficiency value between 5 and 10, you would create
one term for Spanish > 5 and another for Spanish < 10.

• Expressions: An expression is a collection of one or more terms. The terms in an expression must share
the same operator—they must all be AND or must all be OR relationships.

• Steps: A precision queue step is a time-based routing point within the precision queue. A step is a
collection of one or more expressions.

A step may also include wait time and a Consider If formula. Use wait time to assign a maximum amount
of time to wait for an available agent. Use a Consider If formula to evaluate the step against predefined
criteria, for example, another queue.

Administrators can see and manage attributes. Supervisors can configure attributes for their supervised agents
on the Attributes tab of the Agents tool.

Skill Groups or Precision Queues?
Should you use skill groups or precision queues for the routing needs of your organization? This section
distinguishes the two methods.

Use a Skill Group

A skill group represents a competency or responsibility. For example, it could be a predefined collection of
traits, such as salespeople who are in charge of selling to England. The skill group could be called “English
sales”. If you wanted to divide the agents in this group into two types of proficiencies (perhaps based on
experience), you would need to set up two separate skill groups; for example, English Sales 1 and English
Sales 2. You would then associate an agent with one of them, based on the agent's proficiency. Do this by
accessing the skill group and locating the agent that you want to add to it (or add that skill group to the agent).
To summarize, creating a skill group involves first building a concept of what combinations of traits you want
for each agent, like English Sales 2.
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Use a Precision Queue

In contrast to skill groups, a precision queue breaks down attribute definitions to form a collection of agents
at an attribute level. The agents that match the attribute level of the precision queue become associated with
that precision queue.

With precision queues, the preceding English sales example involves defining the attributes English and Sales,
and associating agents that have those traits to them. The precision queue English Sales would dynamically
map all those agents that had those traits to the precision queue. In addition, you can define more complex
proficiency attributes to associate with those agents. This would allow you to build, in a single precision
queue, multiple proficiency searches like English language proficiency 10 and sales proficiency 5.

To break down the precision queue example into skill groups, you would need to set up two separate skill
groups: English language proficiency 10 and sales proficiency 5.With precision queues, you can refine agents
by attributes. With skill groups, you define a skill group and then assign agents to it.

Decide on Skill Groups or a Precision Queue

Precision routing enhances and can replace traditional routing. Traditional routing looks at all of the skill
groups to which an agent belongs and defines the hierarchy of skills to map business needs. However, traditional
routing is restricted by its single-dimensional nature.

Precision routing provides multidimensional routing with simple configuration, scripting, and reporting.
Agents are represented through multiple attributes with proficiencies so that the capabilities of each agent are
accurately exposed, bringing more value to the business.

If your routing needs are not too complex, consider using one or two skill groups. However, if you want to
conduct a search involving as many as ten different proficiency levels in one easily managed queue, use
precision queues.

Attributes
Attributes identify a call routing requirement, such as language, location, or agent expertise. You can create
two types of attributes: Boolean or Proficiency.

When you create a precision queue, you identify which attributes are part of that queue and then implement
the queue in a script. When you assign a new attribute to an agent and the attribute value matches the precision
queue criteria, the agent is automatically associated with the precision queue.

Youmust take system limits into account when you assign attributes to agents, and satisfy both of the following
conditions:

• A) an agent can have a maximum of 50 attributes

and

• B) an agent can belong to a maximum total of 50 combined precision queues and skill groups

Failure to meet both of these conditions will result in an unsuccessful configuration operation.

For example, if a particular attribute is used in many precision queues, and that attribute is assigned to an
agent, that agent belongs to all of those precision queues. It is therefore possible to exceed condition B by
assigning just a few attributes to an agent, if those attributes are used in many precision queues.

It is therefore prudent to plan carefully and to keep system limits in mind when creating attributes and adding
them to precision queues.
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Navigate to Unified CCE Administration > Organization > Skills > Attributes to configure attributes.

Administrators can see and manage attributes. Supervisors can configure attributes for their supervised agents
on the Attributes tab of the Agents tool.

Precision Queue Call Flow Example
At a high level, consider a 5-step precision queue with a Consider If formula for Caller is Premium Member
attached to the Step 1:

• Step 1 - Attribute: Skill > 8 - Consider If: Caller is Premium Member

• Step 2 - Attribute: Skill > 6

• Step 3 - Attribute: Skill > 4

• Step 4 - Attribute: Skill > 3

• Step 5 - Attribute: Skill >= 1

Caller John, who is not a premium customer, calls 1-800-repairs. John's call is routed to this precision queue.

• Since John is not a premium customer, John is immediately routed out of Step 1 (because of the Consider
If on Step 1) and into Step 2 where John waits for the call to be answered.

• After the Step 2 wait time has expired, John's call moves to Step 3 to wait for an agent.

• After the Step 3 wait time has expired, John's call moves to Step 4 to wait for an agent.

• When it arrives at Step 5, John's call will wait indefinitely for an available agent. This step cannot be
avoided by any call because there is no routing logic past this.

The overarching idea is that customer will use each successive step to expand the pool of available agents.
Eventually, when you reach the "last" step (the step with the highest number), the call is waiting in a potentially
very large pool of agents. With each extra step, the chances of the call being handled increase. This also puts
the most valuable and skilled agents in the earlier precision queue steps. Calls come to them first before
moving on the less appropriate agents in later steps.

When two or more agents have the same proficiently level for the attributes the PQ step leverages the Longest
Available Agent (LLA).

Note

Scripts for Precision Queues
To implement Precision Routing in your contact center, you must create scripts.

You can create and use configured (static) and dynamic precision queue nodes in your scripts.

• Static precision queue nodes target a single, configured precision queue. When the script utilizes a single
precision queue, use static precision queues.

• Dynamic precision queue nodes are used to target one or more previously configured precision queues.
Use dynamic precision queues when you want a single routing script for multiple precision queues (for
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example, when the overall call treatment does not vary from one precision queue to another). Dynamic
precision queues can simplify and reduce the overall number of routing scripts in the system.

Precision Queue Script Node
Use the Precision Queue script node to queue a call based on caller requirements until an agent with desired
proficiency become available. This node contains multiple agent selection criteria which are separated into
steps.

A single call can be queued onmultiple precision queues. If an agent becomes available in one of the precision
queues, the call is routed to that resource. You cannot reference multiple precision queues with a single
Precision Queue node. However, you can run multiple Precision Queue nodes sequentially to achieve this.

The Precision Queue node includes a Priority field, which sets the initial queuing priority for the calls processed
through this node versus other calls queued to the other targets using different nodes. The priority is expressed
as an integer from 1 (top priority) to 10 (least priority). The default value is 5.

If more than one call is queued to a precision queue when an agent becomes available, the queued call with
the lowest priority number is routed to the target first. For example, assume an agent in a precision queue
becomes available and two calls are queued to that precision queue. If one call has priority 3 and the other
has priority 5, the call with priority 3, the lower value, is routed to the precision queue while the other call
continues to wait. If the priorities of the two calls are same, then the call queued first is routed first.

VRU (voice response unit) script instructions are not sent to the VRU. If a call enters the precision queue
node and no resource is available, the call is queued to the precision queue and the node transfers the call to
the default VRU, if the call is not already on a VRU. The script flow then exits immediately through the
success branch. The script should then continue with a run external script node to instruct the VRU what to
do while holding the call until an agent becomes available. Typically, this invokes a network VRU script that
plays music-on-hold, possibly interrupted on a regular basis with an announcement. The script flow can also
use other queuing nodes to queue the same call to other targets, for example, Queue to Skill Group and Queue
to Agent.

Queuing Behavior of the Precision Queue Node
Precision queues internally are configured with one or more time-based steps, each with a configured wait
time. After a call is queued, the first step begins and the timer starts. This occurs although the execution path
of the script exited the success node and a new node may be targeted (for example, Run Ext. Script).

If the timer for the first step expires, control moves to the second step (assuming one exists), and so on. As
long as the call remains in queue and there are steps left to perform, the call internally continues to move
between steps regardless of the path the call takes after it leaves the precision queue node. If a call is queued
to two or more precision queues, the call internally walks through the steps for each precision queue in parallel.
After the call reaches the last step on a precision queue, it remains queued on that step until the call is routed,
abandoned, or ended.

If there is an update to the precision queue definition, then all queued calls in the precision queue are
re-evaluated and the execution begins again from the first step.

For example, consider the wait time for an ongoing call at step 1 to be 1080 seconds, of which 1000 seconds
has already elapsed. Now, suppose the wait time is changed to 900 seconds, then the wait time for this call is
also reset to 900 seconds, even though only 80 more seconds are left to move to the next step.
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Dynamic Limits for Skill Groups and Precision Queues Per Agent
The number of skill groups and precision queues per agent significantly affects the following subcomponents
of Unified CCE:

• Cisco Finesse servers

• Agent PGs

• Router

• Logger

We use queue as a common term for skill groups and precision queues.Note

To maintain the performance of your solution, periodically remove unused queues.

The Reference Designs set a standard limit for the average queues per agent on each PG. On a particular PG,
some agents can have more queues than other agents. As long as the average across all the agents on the PG
is within the limit, you can still have the maximum active agents on that PG.

For example, assume that you have three groups of agents on a PG in a 4000 Agent Reference Design:

• Group A has 500 agents with five queues each.

• Group B has 1000 agents with 15 queues each.

• Group C has 500 agents with 25 queues each.

These three groups average to 15 queues per agent, so you can have them all on a single PG under the standard
limits.

You can also exceed that standard limit if you reduce the number of agents on each PG and on the whole
system.

See the configuration tables in the configuration limits chapter for the standard limits.Note

The Cisco Finesse server doesn’t display statistics for unused queues. So, the active queues affect the
performance of the Cisco Finesse server more than the total configured queues.

The Cisco Finesse desktop updates queue (skill group) statistics at 10-second intervals. The Cisco Finesse
Desktop also supports a fixed number of queue statistics fields. You can’t change these fields.

This table shows the approximate reduction in the number of agents your solution can support with more
queues per agent:
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Table 4: Dynamic Agents and Queues Limits

Maximum Agents for
24000 Agent
Reference Design

Maximum Agents for
12000 Agent
Reference Design

Maximum Agents for
4000 Agent
Reference Design1

Maximum Agents for
2000 Agent
Reference Design

Maximum Agents
per PG

Average Queues per
Agent

240001200040002000200010

160001200040002000200015

12000900030001500150020

8000600020001000100030

60004500150075075040

48003600120060060050

1 You can’t have more than 4000 Agents on a Rogger deployment.

Unified CCE supports a maximum of 50 unique skill groups across all agents on a supervisor’s team, including
the supervisor’s own skill groups. If this number is exceeded, all skill groups that are monitored by the
supervisor still appear on the supervisor desktop. However, exceeding this number can cause performance
issues and isn’t supported.

Each precision queue that you configure creates a skill group for each Agent PG and counts toward the
supported number of skill groups per PG. The skill groups are created in the same Media Routing Domain as
the precision queue.

Note

Initial Setup
When you configure precision queues associated with a large number of agents, the system avoids potential
overload conditions by updating the agent associations as system resources allow. Updates may take a few
minutes. If you submit multiple configuration updates, the system has a threshold of five concurrent
configuration updates, and will reject any updates that exceed the threshold.

Add Attributes

Procedure

Step 1 Navigate to Unified CCE Administration > Organization > Skills > Attributes.
Step 2 In theList of Attributeswindow, clickNew. TheNew Attributeswindow has two tabs: General andMember.
Step 3 Complete the following fields on the General tab:
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DescriptionRequiredField

Type a unique attribute name. For example, to create
an attribute for mortgage insurance, type mortgage.

yesName

Enter a maximum of 255 characters to describe the
attribute.

noDescription

Select the type: Boolean or Proficiency.noType

Select the default (True or False for Boolean, or a
number from 1 to 10 for Proficiency).

noDefault

Step 4 Click Save.

Search for Agents
The Search field in the Agents tool offers an advanced and flexible search.

Click the + icon at the far right of the Search field to open a popup window, where you can:

• Select to search for agents only, supervisors only, or both.

• Enter a username, agent ID, first or last name, or description to search for that string.

• Enter one or more site names separated by spaces. (Site is an OR search.)

• Enter one or more peripheral set names separated by spaces (Peripheral Set is an OR search). The search
is case-insensitive and does not support partial matches.

Search by department is available only when departments are configured.Note

Assign Attributes to Agents

Procedure

Step 1 With the selected agent displayed, click the Attributes tab.
Step 2 Complete the Attributes tab:

This tab shows the attributes associated with this agent and their current values.

Click Add to open a popup list of all attributes, showing the name and current default value for each.

a) Click the attributes you want to add for this agent.
b) Set the attribute value as appropriate for this agent.
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Add Precision Queue

Procedure

Step 1 Navigate to Unified CCE Administration > Organization > Skills > Precision Queues.

This opens a List of Precision Queues window showing all precision queues that are currently configured.

Step 2 Click New to open the New Precision Queue window. Complete the fields.

DescriptionRequiredName

Enter up to 255 characters to
describe the precision queue.

noDescription

MRDs organize how requests for
media are routed. The system routes
calls to skill groups or precision
queues that are associated with a
particular communicationmedium;
for example, voice or email. This
field defaults to Cisco_Voice.

noMedia Routing Domain
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DescriptionRequiredName

Select the service level type used
for reporting on your service level
agreement.

Service level type indicates how
calls that are abandoned before the
service level threshold affect the
service level calculation.

• Ignore Abandoned Calls (the
default): Select this option if
you want to exclude
abandoned calls from the
service level calculation.

• Abandoned Calls have
Negative Impact: Select this
option if you want only those
calls that are answered within
the service level threshold
time to be counted as treated
calls. The service level is
negatively affected by calls
that abandon within the
service level threshold time.

• Abandoned Calls have
Positive Impact: Select this
option if you consider a call
that is abandoned within the
service level threshold time as
a treated call. With this
configuration, abandoned calls
have a positive impact on the
service level.

yesService Level Type

Enter the time in seconds that calls
are to be answered based on your
service level agreement, from 0 to
2,147,483,647.

The time that you enter in this field
is used to report on service level
agreements and does not affect how
long a call remains in a precision
queue. The length of time a call
remains in a step is determined by
the wait time for each individual
step.

yesService Level Threshold
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DescriptionRequiredName

Select an option to determinewhich
agents receive calls from this
queue.

The ordering of agents does not
dictate the agents who are selected
into a Precision Queue step. Agents
are included or excluded based on
the conditions specified for the step.

• Longest Available Agent (the
default): The default method
of agent ordering for a
precision queue. The call is
delivered to the agent who has
been in the available (or
ready) state the longest.

• Most Skilled Agent: The call
is delivered to the agent who
has the highest competency
sum from all the attributes
pertinent to the Precision
Queue step. In an agent-rich
environment, this can mean
that more competent agents
would be utilized more than
less competent agents.

• Least Skilled Agent: The call
is delivered to the agent who
has the lowest competency
sum from all the attributes
pertinent to the Precision
Queue step.

yesAgent Order

Select the bucket interval whose
bounds are to be used to measure
the time slot in which calls are
answered.

The field defaults to the system
default.

To select a different bucket
interval:

noBucket Intervals

Step 3 Click the numbered Step Builder link (Step 1, Step 2, and so on) to build a precision queue step in the Step
Builder popup window.

Step 4 When you have finished adding, click Save.
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Consider If Formula for Precision Queue
If you are not on the last step of the precision queue, then you can enter a Consider If formula for that step.
A Consider If formula evaluates a call (within a step) against additional criteria. Each time a call reaches a
step with a Consider If expression, the expression is evaluated. If the value for the expression returns as true,
the call is considered for the step. If the value returns as false, the call moves to the next step. If no expression
is provided for a step, the step is always considered for calls.

To add a Consider If formula, type the formula into the Consider If box. Alternatively, you can use the Script
Editor to build the formula and then copy and paste it into the Consider If box. Objects used in Consider If
formulas are case-sensitive. All Consider If formulas that you add to a precision queue must be valid. If you
add an invalid formula, you cannot save the precision queue. To ensure that the formula is valid, use Script
Editor to build and validate the formula.

Only the following scripting objects are valid in a Consider If formula:

• Call

• PQ

• Skillgroup

• ECC

• PQ Step

• Call Type

• Custom Functions (You can create custom functions in Script Editor.)

It is possible that a valid Consider If formula can become invalid. For example, if you delete an object used
in the formula after you create or update the precision queue, the formula is no longer valid.

Consider If Formula Examples

• PQ.PQ1.LoggedOn > 1--Evaluates whether there is more than one agent logged in to this queue.

• CallType.CallType1.CallsRoutedToday > 100--Evaluates whether more than 100 calls of this call type
were routed today.

• PQStep.PQ1.1.RouterAgentsLoggedIn > 1--Evaluates whether there is more than one router agent
logged in to this queue for Step 1.

• CustomFunction(Call.PeripheralVariable1) > 10--Evaluates whether this formula using a custom
function returns a value greater than 10.

Build Precision Queue Steps
Every precision queue must have a step, and every step must have an Expression. An Expression is a collection
of attribute terms.

Procedure

Step 1 Click the numbered step link in the Steps panel (Step 1, Step 2, and so on).
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The step number popup window opens.

Step 2 Build the first step as follows.
a) Click the magnifying glass icon to the right of the Select Attribute field in the Expression 1 panel.
b) Select an attribute from the list.
c) Use the two Select fields to establish the terms of the attribute. Click the first Select field to choose an

operator.

• For Boolean attributes, choices are the operators for Equal and Not Equal.

• For Proficiency attributes, choices are the operators for True, False, Less Than, Less Than or Equal
To, Greater Than, and Greater Than or Equal To.

d) Click the second Select field to choose a value.

• For Boolean attributes, values are True and False.

• For Proficiency attributes, values are numbers from 1 to 10.

Your selection creates an attribute term for the Expression.

Step 3 To add a second attribute to the first Expression, click Add Attribute in the Expression 1 row.
a) Select AND or OR to establish the relationship between the first and second attributes.
b) Repeat steps 2b, 2c, and 2d.

Step 4 Continue to add attributes to Expression 1.

All attributes within an expression must be joined by the same logical operator. They must all be ANDs, or
they must all be ORs.

Step 5 To add a second Expression, click the Add Attribute drop-down in the Expression 1 row and select Add
Expression.

Step 6 Select AND or OR to establish the relationship between the first and second Expressions.
Step 7 Add attributes to Expression 2.
Step 8 Continue to add Expressions as needed.
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In this example, a Spanish caller located in the Boston area needs an onsite visit from a technician to repair
his ServerXYZ. An ideal agent should be fluent in Spanish and have the highest proficiency in ServerXYZ.
This can be seen in Expression 1. Expression 2 allows us to specify that the selected agent must also be from
either Boston or the New England area.

Step 9 When you have completed the step, click OK to add it to the precision queue.
Step 10 To build the next step, click Add Step.

Each successive step is prepopulated with the Expressions and attributes of its predecessor. Decrease the
attribute qualifications and competencies in successive steps to lower the bar such that the pool of acceptable
agents increases.

Step 11 When you have created all steps, you can open any step except the last and enter values in the Consider if
and Wait for fields.

• Consider if is a formula that evaluates a call within a step against additional criteria. (See Consider If
Formula for Precision Queue, on page 112 for more information about Consider If.)

• Wait for is a value in seconds to wait for an available agent. A call will queue at a particular step and
wait for an available agent matching that step criteria until the number of seconds specified. A blank
wait time indicates that the call will proceed immediately to the next step if no available agents match
the step criteria. Wait time defaults to 0 and can take a value up to 2147483647.

Configure a Static Precision Queue

Procedure

Step 1 In the Precision Queue Properties dialog box, select the Statically option.
Step 2 From the list, select a precision queue to which to route all calls that enter this node.
Step 3 In the Priority selection box, select the initial queuing priority for calls processed through this node. You

can select from 1 - 10. The default is 5.
Step 4 Check the Enable target requery check box to enable the requery feature for calls processed through this

node.
Step 5 Check the Wait if Agents Not Logged In check box.

If this check box is selected and the agents associated with this step are not logged in, then the router waits
for the time that is configured for that step. Whereas, if this check box is not selected, the router does not wait
on any step.

The router waits indefinitely on the last step, irrespective of the selection of this check box.Note

Step 6 To edit a precision queue, select a precision queue from the list, and then click Edit Precision Queue.
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Configure a Dynamic Precision Queue

Procedure

Step 1 In the Precision Queue Properties dialog box, select the Dynamically option.
Step 2 In the Priority selection section, select the initial queuing priority for calls processed through this node. You

can select from 1 - 10. The default is 5.
Step 3 Check the Enable target requery check box to enable the requery feature for calls processed through this

node.
Step 4 Check the Wait if Agents Not Logged In check box.

If this check box is selected and the agents associated with this step are not logged in, then the router waits
for the time that is configured for that step. Whereas, if this check box is not selected, the router does not wait
on any step.

The router waits indefinitely on the last step, irrespective of the selection of this check box.Note

Step 5 Select a queue option:

• To dynamically route calls that enter this node to a precision queue name, select the Precision Queue
Name option.

• To dynamically route calls that enter this node to a precision queue ID, select the Precision Queue ID
option.

Step 6 Click Formula Editor to create a formula that determines the precision queue name or ID to which to route
calls.
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C H A P T E R 12
Post Call Survey

• Post Call Survey, on page 117
• Configure Post Call Survey in CVP, on page 118
• Configure Unified CCE, on page 118

Post Call Survey
A Post Call Survey takes place after the call. Typically, you use the survey to determine whether a customer
was satisfied with the call experience. You configure a call flow that sends the call to a DNIS for the Post
Call Survey after the agent disconnects from the caller.

Your VRU asks callers whether they want to participate in a Post Call Survey. If they choose to do so, they
are automatically transferred to the Post Call Survey after the call flow completes.

Post Call Survey Use Case
The caller is typically asked if they want to participate in a survey after the call. Your solution can determine
based on dialed numbers to invoke the post call survey at the end of a call. When the customer completes the
conversation with an agent, the customer is automatically redirected to a survey. The hang-up event from the
last agent in the call triggers the post call survey.

A customer can use the keypad on a touch tone phone and voice with ASR/TTS to respond to questions asked
during the survey. For the solution, the post call survey call is just like another regular call. The post call
survey retrieves the call context information from the original customer call.

Post Call Survey Design Impacts
Observe the following conditions when designing a Post Call Survey:

• A Post Call Survey triggers at the hang-up event from the last agent. When the agent ends the call, the
call routing script launches a survey script.

• The mapping of a dialed number pattern to a Post Call Survey number enables the Post Call Survey
feature for the call.

• The value of the expanded call variable user.microapp.isPostCallSurvey controls whether the call
transfers to the Post Call Survey number.
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• If user.microapp.isPostCallSurvey is set to y (the implied default), the call transfers to the mapped
post call survey number.

• If user.microapp.isPostCallSurvey is set to n, the call ends.

• To route all calls in the dialed number pattern to the survey, your script does not have to set the
user.microapp.isPostCallSurvey variable. The variable is set to y by default.

• You cannot have a REFER call flow with Post Call Survey. REFER call flows remove Unified CVP
from the call. But, Post Call Survey needs Unified CVP because the agent has already disconnected.

• For Unified CCE reporting purposes, the Post Call Survey call inherits the call context for the initial call.
When a survey starts, the call context of the customer call that was transferred to the agent replicates
into the call context of the Post Call Survey call.

• The expanded call variable isPostCallSurvey will be cached only when the UCCE router generates a
label for CVP.

Configure Post Call Survey in CVP
Complete the following procedure to configure Post Call Survey in Unified CVP.

Procedure

Step 1 Log in to the Unified CVP Operations Console and choose System > Dialed Number Pattern.
Step 2 Enter the following configuration settings to associate incoming dialed numbers with survey numbers:

• Dialed Number Pattern - Enter the appropriate dialed number.

The incoming Dialed Number for calls being directed to a Post Call Survey Dialed. This is the Dialed
Number you want to redirect to the survey.

• Enable Post Call Survey for Incoming Calls - Select to enable post call survey for incoming calls.
• Survey Dialed Number Pattern - Enter the dialed number of the Post Call Survey. This is the dialed
number to which the calls should be transferred to after the call flow is completed.

• Click Save to save the Dialed Number Pattern.

Step 3 Click Deploy to deploy the configuration to all Unified CVP Call Server devices.

Configure Unified CCE

Configure ECC Variable
You need not configure Unified CCE to use Post Call Survey, however, you can turn the feature off (and then
on again) within an ICM script by using the ECC variable user.microapp.isPostCallSurvey and a value of
n or y (value is case insensitive) to disable and re-enable the feature.
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Configure the ECC variable to a value of n or y before the label node or before the Queue to Skillgroup node.
This sends the correct value to Unified CVP before the agent transfer. This ECC variable is not needed to
initiate a Post Call Survey call, but you can use it to control the feature when the Post Call Survey is configured
using the Operations Console.

When the DN is mapped in the Operations Console for Post Call Survey, the call automatically transfers to
the configured Post Call Survey DN.

Complete the following procedure to enable or disable the Post Call Survey:

Procedure

Step 1 On the Unified CCE Administration Workstation, using configuration manager, select the Expanded Call
Variable List tool.

Step 2 Create a new ECC Variable with Name:user.microapp.isPostCallSurvey.
Step 3 Set Maximum Length to 1.
Step 4 Select the Enabled check box then click Save.
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C H A P T E R 13
Task Routing

• Task Routing, on page 121
• Task Routing API Request Flows, on page 130
• Failover and Failure Recovery, on page 137
• Task Routing Setup, on page 140
• Sample Code for Task Routing, on page 148
• Task Routing Reporting, on page 149

Task Routing
Task Routing describes the system's ability to route requests from different media channels to any agents in
a contact center.

You can configure agents to handle a combination of voice calls, emails, chats, and so on. For example, you
can configure an agent as a member of skill groups or precision queues in three different Media Routing
Domains (MRD) if the agent handles voice, e-mail, and chat. You can design routing scripts to send requests
to these agents based on business rules, regardless of the media. Agents signed into multiple MRDs may
switch media on a task-by-task basis.

Enterprise Chat and Email provides universal queue out of the box. Third-party multichannel applications
can use the universal queue by integrating with CCE through the Task Routing APIs.

Task Routing APIs provide a standard way to request, queue, route, and handle third-party multichannel tasks
in CCE.

Contact Center customers or partners can develop applications using Customer Collaboration Platform and
Finesse APIs in order to use Task Routing. The Customer Collaboration Platform Task API enables applications
to submit nonvoice task requests to CCE. The Finesse APIs enable agents to sign into different types of media
and handle the tasks. Agents sign into and manage their state in each media independently.

Cisco partners can use the sample code available on Cisco DevNet as a guide for building these applications
(https://developer.cisco.com/site/task-routing/).
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Figure 17: Task Routing for Third-party Multichannel Applications Solution Components

Customer Collaboration Platform and Task Routing

Third-party multichannel applications use Customer Collaboration Platform'sTask API to submit nonvoice
tasks to CCE.

The API works in conjunction with Customer Collaboration Platform task feeds, campaigns, and notifications
to pass task requests to the contact center for routing.

The Task API supports the use of Call variables and ECC variables for task requests. Use these variables to
send customer-specific information with the request, including attributes of the media such as the chat room
URL or the email handle.

CCE solutions support only the Latin 1 character set for Expanded Call Context variables and Call variables
when used with Finesse and Customer Collaboration Platform. Arrays are not supported.

Note

CCE and Task Routing

CCE provides the following functionality as part of Task Routing:

• Processes the task request.

• Provides estimated wait time for the task request.

• Notifies Customer Collaboration Platform when an agent has been selected.

• Routes the task request to an agent, using either skill group or precision queue based routing.

• Reports on contact center activity across media.
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Finesse and Task Routing

Finesse provides Task Routing functionality via the Media API and Dialog API.

With the Media API, agents using third-party multichannel applications can:

• Sign into different MRDs.

• Change state in different MRDs.

With the Dialog API, agents using third-party multichannel applications can handle tasks from different
MRDs.

Task Routing Deployment Requirements
Task Routing for third-party multichannel applications deployment requirements:

• Finesse and Customer Collaboration Platform are required. Install and configure Finesse and Customer
Collaboration Platform before configuring the system for Task Routing.

See the Finesse documentation and Customer Collaboration Platform documentation.

By default, access to the Customer Collaboration Platform administration user interface is restricted.
Administrator can provide access by unblocking the IP addresses of the clients. For more details, see the
Control Customer Collaboration Platform Application Access topic in theCisco Customer Collaboration
Platform Installation and Upgrade Guide guide.

• You can install only one Customer Collaboration Platform machine in the deployment.

• Customer Collaboration Platform must be geographically colocated with one side of the Media Routing
Peripheral Gateway (MR PG).

• Install Customer Collaboration Platform in a location from which CCE, Finesse, and the third-party
multichannel Customer Collaboration Platform Task Routing application can access it over the network.

If you install Customer Collaboration Platform in the DMZ, open a port for CCE and Finesse to connect
to it. The default port for CCE to connect to Customer Collaboration Platform is port 38001. Finesse
connects to Customer Collaboration Platform over HTTPS, port 443.

Install the third-party multichannel application locally with Customer Collaboration Platform, or open
a port on the Customer Collaboration Platform server for the application to connect to it.

Supported Functionality for Third-Party Multichannel Tasks
Blind transfer is supported for third-party multichannel tasks submitted through the Task Routing APIs.

We do not support the following functionality for these types of tasks:

• Agent-initiated tasks.

• Direct transfer.

• Consult and conference.
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Plan Task Routing Media Routing Domains
Media Routing Domains (MRDs) organize how requests for each communication medium, such as voice and
email, are routed to agents. You configure an MRD for each media channel in your deployment.

Finesse agents can sign in to any of the multichannel MRDs you create for Task Routing.

Important factors to consider when planning your MRDs include the following:

• Whether the MRD is interactive.

• The maximum number of concurrent tasks that an agent can handle in an MRD.

• Whether the MRDs are interruptible.

• For interruptible MRDs, whether Finesse accepts or ignores interrupt events.

To configure the settings and parameters described in the following sections, see the following documents:

• Cisco Customer Collaboration Platform Developer Guide.

• Cisco Finesse Web Services Developer and JavaScript Guide

• Unified CCE Administration, Unified CCE Configuration Manager, and Unified CCDM Portal
Configuration, on page 146

Interactive and Non-interactive MRDs

Interactive tasks are tasks in which an agent and customer communicate in real time with each other, such as
chats and SMS messages. The customer usually engages with the agent through an application, like a chat
window, and leaves this application open while waiting to be connected to an agent. Non-interactive tasks
are asynchronous, such as email. The customer submits the request and thenmay close the application, checking
later for a response from an agent.

Possible ValuesAPI/ToolAPI Parameter or Setting

Non-interactive
Task/MRD

Interactive Task/MRD

True - customers are not
waiting at an interface
for an agent, and there is
no way to alert them that
there was a problem.
You need to resubmit
these tasks.

False - customers are
waiting at an interface
for an agent and can be
notified if there is a
problem. You don't need
to resubmit these tasks.

Customer
Collaboration Platform
Task Submission API

requeueOnRecovery

Whether Customer
Collaboration Platform
re-queues or discards the task
when Customer Collaboration
Platform recovers from a failure.

Set this parameter when
submitting a task request.
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Possible ValuesAPI/ToolAPI Parameter or Setting

Non-interactive
Task/MRD

Interactive Task/MRD

Transfer - customers are
not engaged with an
agent, and there is no
way to alert them that
the task has ended.

Close- customers are
engaged with an agent,
and can be notified that
the task has ended.

FinesseMedia Sign In
API

dialogLogoutAction

Whether active tasks are closed
or transferred when an agent
signs out or loses presence.

Set this parameter when an
agent signs in to a Media
Routing Domain.

Longer duration -
customer is not waiting
at an interface for an
agent

Shorter duration -
customer is waiting at an
interface for the agent

Media Routing
Domains tool in
Unified CCE
Administration

Start Timeout

The amount of time that the
system waits for an agent to
accept an offered task. When
this time is reached, the system
makes the agent not routable and
re-queues the task.

Set this parameter when
configuring an MRD.

Use Customer
Collaboration Platform
XMPP BOSH eventing
to receive updates on all
contacts/tasks in the
campaign supporting
Universal Queue over
one channel.

Use Customer
Collaboration Platform
Task API status polling
for MRDs when you
want to monitor the
status of a single
contact/task.

Customer
Collaboration Platform
Task API or XMPP
BOSH eventing

Monitoring status of
submitted tasks

You can monitor status of
submitted and queued tasks
using either the Customer
Collaboration Platform Task
API to poll for status or
Customer Collaboration
Platform XMPP BOSH
eventing.

Maximum Concurrent Tasks Per Agent

Specify the maximum number of concurrent tasks for an agent in anMRDwhen an agent signs into the Finesse
application, using the maxDialogLimit parameter in the Finesse Media - Sign In API.

See the Solution Design Guide for Cisco Hosted Collaboration Solution for Contact Center at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-implementation-design-guides-list.html for the maximum number of tasks supported within anMRD
and across MRDs for a single agent.

For agents handling interactive tasks, consider how many concurrent tasks an agent can handle reasonably.
How many simultaneous chat sessions, for example, can an agent handle and provide good customer care? If
you are using precision queue routing, keep in mind that CCE assigns tasks to agents who match attributes
for step one, up to their task limit, until all of those agents are busy. CCE then assigns tasks to agents who
match attributes for step two, up to their task limit, and so on.
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Interruptible and Non-Interruptible MRDs

When you create anMRD in the Unified CCEAdministrationMedia Routing Domains tool, you select whether
the MRD is interruptible.

• Interruptible: Agents handling tasks in the MRD can be interrupted by tasks from other MRDs.
Non-interactive MRDs, such as an email MRD, are typically interruptible.

• Non-interruptible:Agents handling tasks in theMRD cannot be interrupted by tasks from other MRDs.
The agents can be assigned tasks in the same MRD, up to their maximum task limits. For example, an
agent can handle up to three non-interruptible chat tasks; if the agent is currently handling two chat tasks,
CCE can assign the agent another chat, but cannot interrupt the agent with a voice call. InteractiveMRDs,
such as a chat MRD, are typically non-interruptible. Voice is non-interruptible.

When an agent is working on a non-interruptible task, CCE does not assign a task in any other MRD to the
agent. Any application handling the non-voiceMRDsmust follow the same rule. In certain cases, it is possible
that a task from another media routing domain gets assigned to an agent who is working on a non-interruptible
task in an MRD.

For example, if an agent is working on a non-interruptible chat MRD and makes an outbound call (internal
or external) using the desktop or phone, CCE cannot prevent the agent from making that call. Instead, the
system handles this situation differently. CCE marks the agent temp not routable across all media domains
until the agent has completed all non-interruptible tasks the agent is currently working on. Because of this
designation, the agent is not assigned any new tasks from any MRDs until finishing all current tasks. Even if
the agent tries to go ready or routable, the agent's temp not routable status is cleared only after all tasks are
complete.

If you change the MRD from interruptible to non-interruptible or vice versa, the change takes effect once the
agent logs out and then logs back in on that MRD.

Note

Accept and Ignore Interrupts

Specify whether anMRD accepts or ignores interrupt events when an agent signs into the Finesse application,
using the interruptAction parameter in the Finesse Media - Sign In API. This setting controls the agent's
state in an interrupted MRD and ability to work on interrupted tasks. The setting applies only when a task
from a non-interruptible MRD interrupts the agent.

• Accept: When an agent is interrupted by a task from a non-interruptible MRD while working on a task
in an interruptible MRD, Finesse accepts the interrupt event.

The agent, CCE task, and Finesse dialog state in the interrupted MRD change to INTERRUPTED.

The agent cannot perform dialog actions while a task is interrupted.

The application is responsible for disabling all dialog-related activities in the
interface when an agent's state changes to INTERRUPTED.

Important

The agent's time on task stops while the agent is interrupted.

Example: An agent has an email task for 20 minutes, and is interrupted for 3 of those minutes with a chat
task. The handled time for the email task is 17 minutes, and the handled time for the chat task is 3 minutes.
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• Ignore: When an agent is interrupted by another task while working on a task in an interruptible MRD,
Finesse ignores the interrupt event.

The new task does not affect any of the agent's other assigned tasks. The agent, CCE task, and Finesse
dialog state in the interrupted MRDs do not change.

The agent can perform dialog actions on original task and the interrupting task at the same time. The
agent's time on the original task does not stop while the agent is handling the interrupting task.

Example: An agent has an email task for 20 minutes, and is interrupted for 3 of those minutes with a chat
task. The handled time for the email task is 20 minutes, and the handled time for the chat task is 3 minutes.
This means that during a 20-minute interval, the agent handled tasks for 23 minutes.

If an agent is working on a task in an interruptible MRD and is routed a task in another interruptible MRD,
CCE does not send an interrupt event. Therefore, interruptAction setting does not apply.

Plan Dialed Numbers
Dialed numbers, also called script selectors, are the strings or numbers submitted with Task Routing task
requests through Customer Collaboration Platform. Each dialed number is associated with a call type, and
determines which routing script CCE uses to route the request to an agent.

Dialed numbers are media-specific; you associate each one with a Media Routing Domain.

For Task Routing, plan which dialed numbers the custom Customer Collaboration Platform application will
use when submitting new task requests. Consider whether you will use the same dialed numbers for transfer
and tasks that are requeued on RONA, or if you need more dialed numbers.

You must associate each Task Routing dialed number with a call type. The default call type is not supported
for Task Routing.

Important
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Skill Group and Precision Queue Routing for Nonvoice Tasks
Routing to skill groups and precision queues is largely the same for voice calls and nonvoice tasks. However,
the way that contact center enterprise distributes tasks has the following implications for agents who can
handle multiple concurrent tasks:

• Precision queues—In precision queue routing, Unified CCE assigns tasks to agents in order of the
precision queue steps. Unified CCE assigns tasks to agents who match the attributes for step one, up to
their task limit, until all those agents are busy. Unified CCE then assigns tasks to agents who match
attributes for step two, and so on. If you configure agents to handle three concurrent tasks, Unified CCE
assigns three tasks to each agent in the first step. It then moves on to the second step and assigns any
remaining tasks to those agents.

• Overflow skill groups—Routing scripts can specify a preferred skill group and an overflow skill group.
Unified CCE assigns tasks to all agents in the preferred skill group, up to their task limit, before assigning
any tasks in the overflow skill group. If you configure agents to handle three concurrent tasks, Unified
CCE assigns three tasks to each agent in the preferred skill group. It then moves on to the overflow skill
group and assigns any remaining tasks to those agents.

The number of available slots is an important factor in the Longest Available
Agent (LAA) calculation.

The number of available slots =Themaximum concurrent task limit for theMRD
that an Agent has logged into -Current tasks being handled by the Agent or routed
to the Agent.

If there are multiple skill groups that are part of the queue node, then the skill
group that has the higher LAA is picked. Then, the agents within the picked skill
group (or the Precision Queue) who have the highest number of available slots
for non-voice tasks get prioritised.

Agents with the same number of available slots get prioritized based on the time
in the available state or the LAA mechanism.

Note

Agent State and Agent Mode
An agent's state and routable mode in an MRD work together to determine whether CCE routes tasks to the
agent in that MRD.

Agent Routable Mode

The agent's routable mode controls whether CCE can assign the agent tasks in that MRD. If the agent is
routable, CCE can assign tasks to the agent. If the agent is not routable, CCE cannot assign tasks to the agent.

The agent changes to routable/not routable through Finesse Media - Change Agent to Routable/Not Routable
API calls.

Agent State

The agent's state in an MRD indicates the agent's current status and whether the agent is available to handle
a task:
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• Ready: The agent is available to handle a task.

• Reserved/Active/Paused/Work Ready/Interrupted: The agent is available to handle a task if the agent
has not reached their maximum task limit in the MRD.

• Not Ready: The agent is not available to handle a task.

The agent changes to Ready and Not Ready through calls to the Finesse Media - Change Agent State API.
The agent's state while working on a task depends on the actions the agent performs on the Finesse dialog
related to the task, through calls to the Finesse Dialog - Take Action on Participant API.

How Mode and State Work Together to Determine if an Agent Receives Tasks

CCE will route an agent a task in the MRD if ALL of the following are true:

• The agent's mode is routable, and

• The agent is in any state other than NOT_READY, and

• The agent has not reached the maximum task limit in the MRD, and

• The agent is not working on a task in a different and non-interruptible MRD.

CCE will NOT route an agent a task in the MRD if ANY of the following are true:

• The agent's mode is not routable, or

• The agent is NOT_READY, or

• The agent has reached the maximum task limit in the MRD, or

• The agent is working on a task in a different and non-interruptible MRD.

Why Change the Agent's Mode to Not Routable?

By changing the agent's mode to not routable, you stop sending tasks to the agent without changing the agent's
state to Not Ready. You may want to make an agent not routable if the agent is close to ending the shift, and
needs to complete in progress tasks before signing out.

If an agent changes to Not Ready state while still working on tasks, CCE reports show those tasks as ended;
time spent working on the tasks after going Not Ready is not counted. By making the agent not routable
instead of Not Ready, the agent's time on task continues to be counted.

In RONA situations, in which agents do not accept tasks within the Start Timeout threshold for the MRD,
Finesse automatically makes agents not routable. Finesse resubmits the tasks through for routing through
Customer Collaboration Platform. The application must make the agent routable in order for the agent to
receive tasks again.

Customer Collaboration Platform and Finesse Task States
In most cases, Customer Collaboration Platform social contact states do not map directly to Finesse dialog
states. For Customer Collaboration Platform, social contacts are created when the customer submits a task
request. For Finesse, the dialog with which the agent engages with the customer is created when the task is
routed to the agent.
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This table shows the relationships between Customer Collaboration Platform social contact task states and
Finesse dialog states.

Finesse Dialog StateCustomer Collaboration Platform Social Contact Task
State

NoneUnread: The task request has not been submitted to
the contact center.

NoneQueued: The task request is successfully submitted
to the contact center as a result of creating a new task
or resubmitting a task due to agent transfer, automatic
transfer on agent logout, or automatic transfer for
RONA.

Offered: The dialog is being offered to the agent.Reserved: The task is assigned to an agent. This state
includes all work on a task.

Accepted: The agent accepted the dialog but has not
started working on it.

Active: The agent is working on the dialog.

Paused: The agent paused the dialog.

Wrapping Up: The agent is performing wrap up
activity on the dialog.

Interrupted:The agent is interruptedwith a task from
a non-interruptibleMedia Routing Domain. The agent
cannot work on this task until the interrupting task is
complete.

Closed: The agent ended the task. Finesse sends a
handled notification to Customer Collaboration
Platform.

Handled: Customer Collaboration Platform receives
a handled notification from Finesse indicating that
the task ended.

Task Routing API Request Flows

Task Routing API Basic Task Flow
This topic provides the Customer Collaboration Platform and Finesse API calls and events when an active
email task is interrupted by a chat request.

In this scenario, the email MRD is interruptible. When the agent signs into the email MRD, the application
uses the Finesse Media API to accept interrupts. The chat MRD is non-interruptible.

1. The email application submits a new email task request to CCE, and polls for status and Estimated Wait
Time (EWT).
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2. An agent signs in to the email MRD and changes state to Ready.

3. CCE assigns the agent the email task. The Call and ECC variables used to create the task are included in
the dialog's media properties, and contain information such as the handle to the email. The variables can be
used to reply to the email. The agent starts work on the email dialog in Finesse.
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4. The chat application submits a new chat request, and polls for status and EWT. The same agent logs into
the chat MRD.

5. The agent changes state to Ready in the chat MRD. CCE assigns the chat task to the agent. The Call and
ECC variables used to create the task are included in the dialog's media properties, and contain information
such as the chat room URL. The variables can be used to join the chat room with the customer. The agent
starts the chat dialog in Finesse. The Email dialog is interrupted.
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6. The agent completes work on the chat dialog and closes the dialog. Finesse sends a handled event to
Customer Collaboration Platform for the chat task. The application is responsible for closing the chat room.
The agent is not handling other non-interruptible dialogs, and the email dialog becomes active.

7. The agent continues working on the email dialog, including pausing, resuming, and wrapping up the dialog.
The agent closes the dialog. Finesse sends a handle event to Customer Collaboration Platform for the email
task. The application is responsible for sending the email reply to the customer.
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Task Routing API Agent Transfer Flow
This illustration provides the Customer Collaboration Platform and Finesse API calls and events when an
agent transfers a task.

1. The agent transfers the dialog from the Finesse application, selecting the script selector to which to transfer
the task.
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2. Finesse resubmits the task to Customer Collaboration Platform, and the task is queued to the script selector
as a new task.

3. Finesse puts the original dialog in the CLOSED state, with the disposition code
CD_TASK_TRANSFERRED. Finesse does not send a handled notification to Customer Collaboration
Platform.

Task Routing API RONA Flow
This illustration provides the Customer Collaboration Platform and Finesse API calls and events in a RONA
scenario, in which an agent does not accept an offered task within the Start Timeout threshold for the MRD.

1. The task is routed to an agent, and the dialog is offered to the agent.

2. The Media Routing Domain's Start Timeout threshold expires.

3. CCE instructs Finesse to end the dialog. Finesse puts the dialog in the CLOSED state, with the disposition
code CD_RING_NO_ANSWER. Finesse does not send a handled notification to Customer Collaboration
Platform.

4. The Finesse server on which the agent was last signed in resubmits the task to Customer Collaboration
Platform with the original script selector. The task is queued to the script selector as a new task.

5. CCE instructs Finesse to make the agent not routable in that Media Routing Domain, so that the agent is
not routed more tasks.

Task Routing API Agent Sign Out with Tasks Flows
The Finesse Media - Sign Out API allows agents to sign out with assigned tasks. The dialogLogoutAction
parameter set by the Media - Sign In API determines whether those tasks are closed or transferred when the
agent signs out.
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Close Tasks on Sign Out

This illustration provides the Customer Collaboration Platform and Finesse API calls and events when agents
are set to have assigned tasks closed on sign out.

1. The agent requests to sign out of the MRD with an active task.

2. CCE instructs Finesse to end the task. Finesse puts the dialog in CLOSED state, with the disposition code
CD_AGENT_LOGGED_OUT_DURING_DIALOG.

3. The agent is signed out of the MRD.

Transfer Tasks on Sign Out

This illustration provides the Customer Collaboration Platform and Finesse API calls and events when agents
are set to have assigned tasks transferred on sign out.

1. The agent requests to sign out of the MRD with an active task.

2. CCE instructs Finesse to end the dialog. Finesse puts the dialog in the CLOSED state, with the disposition
code CD_TASK_TRANSFERRED_ON_AGENT_LOGOUT. Finesse does not send a handled notification
to Customer Collaboration Platform.

3. The Finesse server on which the agent was signed in resubmits the task to Customer Collaboration Platform
with the original script selector. The task is queued to the script selector as a new task.

4. The agent is signed out of the MRD.
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Failover and Failure Recovery
Queued, Offered, and Active Task ImpactNew Task Request ImpactFailover/Failure

Scenario
Component

Queued tasks:When tasks are submitted,
they can be set to requeue on recovery.
Typically, non-interactive tasks, such as
email, are set to requeue on recovery
because there is not a way to alert the
customer that there was a problem while
in queue. Interactive tasks, such as chat,
are set not to requeue on recovery because
the customer is waiting at an interface for
an agent, and there is a way to alert the
customer that there is a problem.

If tasks are set to requeue on recovery, the
task is resubmitted when the MR
connection is reestablished. The status and
statusReason of the contact does not
change.

If tasks are set NOT to requeue on
recovery, the task's contact's status is
marked discarded. The task's contact's
statusReason is marked as follows:

Customer Collaboration Platform
failure:

NOTIFICATION_CCE_

CUSTOMERCOLLABORATIONPLATFORM_
SYSTEM_FAILURE

MR connection failure:
NOTIFICATION_CCE_CONNECTION_LOST

Offered and active tasks: No impact.

New task requests from
Customer Collaboration
Platform application: New
task requests fail, and the
failures are delivered back
to the application. Details
of these failures are
described in the next
column.

Automatic transfer
request from Finesse (for
transfer on sign out or
RONA): Results in a lost
transfer request.

Agent transfer request:
The request fails, and
Finesse sends an error back
to the application. Finesse
retains the task.

MR connection
fails. For
example, there is
a networking
problem, the PG
loses connection,
or Customer
Collaboration
Platform loses
connection.

Finesse loses
connection with
Customer
Collaboration
Platform.

Customer
Collaboration
Platform

Queued, offered, and active tasks: No
impact.

New task requests from
Customer Collaboration
Platform application:New
task requests are discarded
with the statusReason
NOTIFICATION_RATE_LIMITED.

Automatic or agent
transfer requests: No
impact

Customer
Collaboration
Platform overruns
the new task
queue limit.

For the limit, see
the Cisco
Customer
Collaboration
Platform
Developer Guide.

Customer
Collaboration
Platform
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Queued, Offered, and Active Task ImpactNew Task Request ImpactFailover/Failure
Scenario

Component

Agents signed into media on the failed
Finesse server are put into
WORK_NOT_READY state and made
not routable. Tasks on that server are
preserved in their current state, and time
continues to accrue towards the maximum
task lifetime. The agent fails over to the
secondary Finesse server, and must sign
in to the media again. The agent is put into
the previous state. If the agent doesn't have
tasks, the agent is put in NOT_READY
state.

Queued tasks: No impact.

Offered tasks: These tasks RONA
because the agent cannot accept them.

Active tasks: These tasks fail over to the
other Finesse server and are recovered on
that server.

Any active tasks that were in
INTERRUPTED state at the
time of the lost connection
change are recovered.
However, these tasks change
to the UNKNOWN state
when the task is no longer
INTERRUPTED. The agent
can only close tasks when
they are in the UNKNOWN
state.

Note

New task request from
Customer Collaboration
Platform application: No
impact

Automatic transfer
requests from Finesse (for
transfer on logout or
RONA): Automatic
transfers are initiated on the
Finesse server on which the
agent was signed in. Any
outage on that Finesse
server can result in lost
transfer requests.

Agent transfer request:
The request fails because
Finesse is out of service,
and Finesse retains the task.

Finesse loses
connection with
Agent PG or CTI
Server

Finesse
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Queued, Offered, and Active Task ImpactNew Task Request ImpactFailover/Failure
Scenario

Component

Queued tasks: No impact.

Offered tasks: These tasks fail over to the
other Finesse server and are recovered on
that server. If a task's Start Timeout
threshold is exceeded during failover, the
task RONAs.

Active tasks: If an agent logs out with
active tasks, or agent presence is lost with
active tasks, the tasks are either closed or
transferred to the original script selector
depending on how the agent was
configured when signing into the MRD.

If the tasks are transferred, the disposition
code is
CD_TASK_TRANSFERRED_AGENT_LOGOUT.

If the tasks are closed, the disposition code
is
CD_AGENT_LOGGED_OUT_DURING_
DIALOG.

New task request from
Customer Collaboration
Platform application: No
impact

Automatic or agent
transfer requests: No
impact

Agent logs out, or
presence is lost
while agent has
active tasks

Finesse

Queued tasks: No impact.

Offered tasks: These tasks may RONA
depending on how the application is
structured. A Task Routing application
may prevent an agent from accepting a
dialog when the application down because
the agent cannot handle the dialog while
the application is down. In this case, the
dialog RONAs.

Active tasks: Varies by application.
Applications are responsible for managing
the tasks while the application is down.
Finesse retains the tasks, and the tasks are
recovered once the application is restored.

New task request from
Customer Collaboration
Platform application: No
impact

Automatic or agent
transfer requests: No
impact

Finesse
application fails

Finesse
application
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Queued, Offered, and Active Task ImpactNew Task Request ImpactFailover/Failure
Scenario

Component

Queued tasks: No impact.

Offered tasks: These tasks fail over to the
other Finesse server and are recovered on
that server. If a task's Start Timeout
threshold is exceeded during failover, the
task RONAs.

Active tasks: These tasks fail over to the
other Finesse server and are recovered on
that server.

Any active tasks that were in
INTERRUPTED state at the
time of the lost connection
change are also recovered.
However, these tasks change
to the UNKNOWN state
when the task is no longer
INTERRUPTED. The agent
only can only close tasks
when they are in the
UNKNOWN state.

Note

New task request from
Customer Collaboration
Platform application: No
impact

Automatic transfer
requests from Finesse (for
transfer on logout or
RONA): Results in lost
transfer requests.

Agent transfer request:
The request fails, and
Finesse retains the task.

One CTI Server
or one OPC fails

CTI Server or
OPC

Queued tasks: No impact

Offered and active tasks: These tasks are
lost

New task request from
Customer Collaboration
Platform application: No
impact

Automatic or agent
transfer requests: Results
in lost transfers.

Both OPCs failOPC

Task Routing Setup

Initial Setup
NotesTaskStep

Set up CCE

Configure Finesse with the AW, so that Finesse can access
Customer Collaboration Platform connection information.

See Configure Finesse with the AW, on page 142.

1
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NotesTaskStep

Configure a Network VRU and Network VRU scripts.

See Configure Network VRU and Network VRU Scripts, on
page 143.

2

Configure the MR PG and PIM

See Configure theMedia Routing PG and PIM, on page 143.

3

Set up the MR PG and PIM for Customer Collaboration
Platform.

See Set up the Media Routing PG and PIM, on page 144.

4

The system configures the following
settings automatically in Customer
Collaboration Platform
Administration:

• Enables and configures theCCE
Multichannel Routing settings.

• Configures the Task feed and
the associated campaign and
Connection to CCE notification
needed for the Task Routing
feature.

AddCustomer Collaboration Platform as an ExternalMachine
in the System Inventory.

See Add Customer Collaboration Platform as an External
Machine, on page 145.

5

Configure the following in Unified CCE Administration or
Configuration Manager:

• Media Routing Domains

• Call types

• Dialed numbers

• Skill groups or precision queues

• ECC variables

• Agent desk settings

SeeUnified CCEAdministration, Unified CCEConfiguration
Manager, and Unified CCDM Portal Configuration, on page
146

6

Increase the TCDTimeout registry key value, if you are using
precision queues and will be submitting potentially long
tasks, like email.

See Increase TCDTimeout Value, on page 147.

7

Create routing scripts

See Create Routing Scripts for Task Routing, on page 148.

9
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NotesTaskStep

Create Customer Collaboration Platform and Finesse Applications

Create the Customer Collaboration Platform multichannel
application to begin task requests.

See Sample Customer Collaboration Platform HTML Task
Application, on page 148.

10

Create the Finesse applications to manage nonvoice agent
and dialog states.

See Sample Finesse Code for Task Routing, on page 148.

11

Set up Finesse

Upload the Finesse desktop gadgets to the desktop layout
(optional).

See the Cisco Finesse Administration Guide at
https://www.cisco.com/c/en/us/support/
customer-collaboration/finesse/products-user-guide-list.html.

12

Configure Finesse with the AW
Finesse connects to Customer Collaboration Platform to transfer Task Routing tasks and resubmit tasks for
RONA. The Finesse AWDB user requires special database permissions to access Customer Collaboration
Platform connection information. Map the user to the Side A, AWDB, and primary databases. In these
databases, give the user the db_datareader and public roles.

Before you begin

Configure the Contact Center Administration and Data Server Connection Settings on Finesse. You need the
Finesse AWDB username to complete this procedure.

See the Installing and Configuring Guide for Cisco HCS for CC at https://www.cisco.com/c/en/us/support/
unified-communications/hosted-collaboration-solution-contact-center/products-installation-guides-list.html.

Procedure

Step 1 Determine whether the Finesse AWDB user is a domain user or a SQL user. If the user is a domain user,
proceed to the last step in the procedure (step 7). Otherwise, complete all of the steps.

Step 2 Launch Microsoft SQL Server Management Studio on the Unified CCE Administration Client workstation.
Step 3 Connect to the Side A Logger using the default credentials.
Step 4 Navigate to Security > Logins. Right-click the Finesse AWDB username.

The Login Properties screen opens.
Step 5 Select the User Mapping page, and perform the following:

a) Verify that the databases associated with Side A and AWdb are checked.
b) Check the master database.
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c) Select the Side A database. In theDatabase role membership for section, check the db_datareader and
public roles.

Repeat this step for the AWdb and master databases.

d) Click OK.

Step 6 Repeat these steps on the Side B Logger.
Step 7 Run the following SQL queries as the SQL administrative user "sa" or as a user with sysadmin privileges.

For <user>, enter the Finesse AWDB username. If the Finesse AWDB user is a domain user, rather than a
SQL user, use the <domain\user> format.
USE master
GO
GRANT CONTROL ON CERTIFICATE :: UCCESymmetricKeyCertificate TO "<user>"
GRANT VIEW DEFINITION ON SYMMETRIC KEY :: UCCESymmetricKey TO "<user>"

Configure Network VRU and Network VRU Scripts
The Network VRU is used to queue nonvoice tasks if an agent is not available to handle them. The Network
VRU Script is used to return estimated wait time to customers. For more information on writing routing scripts
that return estimated wait time, see the Scripting and Media Routing Guide for Cisco Unified ICM/Contact
Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

When you configure the Network VRU Script, you specify whether it is interruptible. The Interruptible
setting for the Network VRU Script controls whether the script can be interrupted (for example if an agent
becomes available). This setting is not related to the Media Routing Domain Interruptible setting, which
controls whether an agent working on a task in that MRD can be interrupted by a task from a non-interruptible
MRD.

Procedure

Step 1 In Configuration Manager, use the Network VRU Explorer tool to configure and save a type 2 VRU.
Step 2 Use the Network VRU Script List tool to add a Network VRU Script that references this Network VRU.

You can accept the default values.

Configure the Media Routing PG and PIM

Procedure

Step 1 In Configuration Manager, open the PG Explorer tool to configure a media routing PG.
Step 2 Create a media routing PIM and routing client for Customer Collaboration Platform.

Write down the Logical Controller ID and the Peripheral ID. You will use them when you set up the PG.
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Step 3 On the Peripheral tab in the PG Explorer tool, check the Enable post routing check box.
Step 4 On the Routing Client tab in the PG Explorer tool, select the Multichannel option from the Routing Type

drop-down list box.

TheDefault call type setting is not supported for tasks submitted through the Task Routing APIs.Note

Step 5 On the Advanced tab in the PG Explorer tool, select the type 2 Network VRU that you created.

Set up the Media Routing PG and PIM

Before performing the step to enable the secured connection between the components, ensure that the security
certificate management process is completed.

Caution

Set up the Media Routing PG and PIM

Procedure

Step 1 From Cisco Unified CCE Tools, select Peripheral Gateway Setup.
Step 2 On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If

the PG does not exist, click Add. If it exists, click Edit.
Step 3 In the Peripheral Gateways Properties screen, click Media Routing. Click Next.
Step 4 Click Yes at the prompt to stop the service.
Step 5 From the Peripheral Gateway Component Properties screen, click Add, select the next PIM, and configure

with the Client Type of Media Routing as follows.
a) Check Enabled.
b) In the Peripheral Name field, enter MR.
c) In the Peripheral ID field, enter the Peripheral ID that you recorded when you configured the Media

Routing PG and PIM.
d) For Application Hostname (1), enter the hostname or IP address of Customer Collaboration Platform.
e) By default, Customer Collaboration Platform accepts the MR connection on Application Connection

Port 38001. The Application Connection Port setting on Customer Collaboration Platform must match
the setting on the MR PG. If you change the port on one side of the connection, you must change it on
the other side.

f) Leave the Application Hostname (2), field blank.
g) Keep all other values.
h) Check the Enable Secured Connection option.

This establishes a secured connectionbetween MR PIM and Application Server.

Ensure that you provide the correct information in the Application Hostname (1) and Application
Connection Port (1) fields.

i) Click OK.

Step 6 On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded
when you configured the Media Routing PG and PIM.
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Step 7 Accept defaults and click Next until the Setup Complete screen opens.
Step 8 At the Setup Complete screen, check Yes to start the service. Click Finish.
Step 9 Click Exit Setup.
Step 10 Repeat this procedure for Side B.

Add Customer Collaboration Platform as an External Machine
When you add Customer Collaboration Platform as an External Machine in the Unified CCE Administration
System Inventory, the system automatically performs the following Customer Collaboration Platform
configuration:

• Enables and completes the CCE Configuration for Multichannel Routing settings in Customer
Collaboration Platform Administration.

These settings include the hostnames of the MR PGs and the Application Connection Port you specified
when setting up the MR PG and PIM.

• Configures the Task feed and the associated campaign and Connection to CCE notification needed for
the Task Routing feature, with the following names:

• Task feed: Cisco_Default_Task_Feed

• Campaign: Cisco_Default_Task_Campaign

• Notification: Cisco_Default_Task_Notification

• Tag: cisco_task_tag

If the Task feed has been configured to use a different tag, the Connection to
CCE notification is configured to use that tag.

Note

Procedure

Step 1 Navigate to Unified CCE Administration > Infrastructure > Inventory.
Step 2 Click Add.
Step 3 Select Customer Collaboration Platform from the drop-down list.
Step 4 Enter the fully qualified domain name (FQDN), hostname or IP address in the Hostname field.

The system attempts to convert the value you enter to FQDN.Note

Step 5 Enter the Customer Collaboration Platform Administration username and password.
Step 6 Select the Side A and Side B Media Routing PGs.
Step 7 Enter the Application Port you specified when setting up the MR PG and PIM. The default value is 38001.
Step 8 Click Save.
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Unified CCE Administration, Unified CCE Configuration Manager, and Unified
CCDM Portal Configuration

This topic explains the Unified CCEAdministration, ConfigurationManager, and Unified CCDMportal tools
you need to configure Task Routing.

Before you begin

For details on the procedures for these steps, refer to the Unified CCEAdministration online help, Configuration
Manager online help, and the Unified CCDM portal online help.

Procedure

Step 1 Sign in to Unified CCE Administration.
Step 2 From the Manage menu, configure the following:

DetailsItem to Configure

Create an MRD for each type of task that the third-party multichannel application
submits to CCE (email, chat, and so on).

Media RoutingDomains

Step 3 Launch Configuration Manager.
Step 4 Configure the following:

DetailsItem to Configure

If agents will use a Task Routing gadget in the Finesse desktop, leave the Logout
inactivity time setting for those agents blank, or remove the existing value.

Otherwise, if the agent exceeds the Logout inactivity time in the voice MRD, the
agent is logged out of the Cisco Finesse desktop, even if the agent is actively
working on tasks from nonvoice MRDs. The agent needs to log into the desktop
again to continue working on the nonvoice tasks.

Agent Desk Settings

Step 5 Log in to the Unified CCDM portal as tenant or sub customer user.
Step 6 Configure the following:

DetailsItem to Configure

Create call types for Task Routing.Call Types

Create dialed numbers for Task Routing. Add the numbers or strings that the
third-party multichannel application will use when submitting task requests.

• For Media Routing Domain, select one of the Task Routing MRDs.

• For Call Type, select a call type that you created for Task Routing.

Each dialed number must be associated with a call type. Default
call type is not supported for tasks submitted with Task Routing
APIs.

Important

Dialed Numbers
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DetailsItem to Configure

Configure either skill groups or precision queues.

If you configure skill groups:

• For Media Routing Domain, select one of the Task Routing MRDs you
created.

• Assign agents to the skill group.

Skill Groups

Configure either skill groups or precision queues.

If you configure precision queues:

• For Media Routing Domain, select one of the Task Routing MRDs you
created.

• Associate agents with attributes that are part of the precision queue steps.

Precision Queues

You can use an existing Expanded Call Variable, or you can create an expanded
call variable for Task Routing, depending on the needs of your third-party
multichannel application.

Arrays are not supported with the Task Routing feature.

CCE solutions support the Latin 1 character set only for Expanded
Call Context variables and Call variables when used with Finesse
and Customer Collaboration Platform.

Note

Expanded Call Variable

Increase TCDTimeout Value
Complete this procedure only if you are using precision queues and routing tasks with potentially long durations,
like emails.

Several precision queue fields in the Termination_Call_Detail record are not completed until the end of a
task. These precision queue fields are blank for tasks whose durations exceed the TCDTimeout registry key
value. The default value of theTCDTimeout registry key is 9,000 seconds (2.5 hours).

If you are configuring a system to handle email or other long tasks, you can increase the TCDTimeout registry
key value to a maximum of 86,400 seconds (24 hours).

Change the registry key on either the Side A or B Router.

Procedure

Modify the following registry key: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\Icm\<instance
name>\Router<A/B>\Router\CurrentVersion\Configuration\Global\TCDTimeout.
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Create Routing Scripts for Task Routing
For complete multichannel scripting information, see the Scripting and Media Routing Guide for Cisco Unified
ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

Ensure that the routing scripts include skill groups or precision queues from the appropriate Media Routing
Domains to handle all of the types of tasks that can be routed with the scripts. For example, if a script is used
to route email tasks, be sure that the script includes skill groups or precision queues from an email MRD.

Important

Sample Code for Task Routing
Cisco Systems has made sample Task Routing application code for Customer Collaboration Platform and
Finesse available to use as baselines in building your own applications.

Sample Customer Collaboration Platform HTML Task Application
The sample Customer Collaboration Platform HTML Task application:

• Submits task requests to CCE.

• Retrieves and displays the estimated wait time, if it has been configured in CCE.

You cannot copy and paste this code to achieve a working application. It is only a guideline.Note

The sample application uses the Task API. For more information about how to use the Task API, see the Cisco
Customer Collaboration Platform Developer Guide.

Procedure

Step 1 Download the sample HTML Task application from DevNet: https://developer.cisco.com/site/task-routing/.
Step 2 Read the sample application's readme.txt file to complete the prerequisites and use the sample application.

Sample Finesse Code for Task Routing
The Finesse sample Task Management Gadget application lets agents perform the following actions in
individual nonvoice Media Routing Domains:

• Sign in and out.

• Change state.

• Handle tasks.
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The sample gadget also signals the Customer Context gadget to display a customer record.

You cannot copy and paste this code to achieve a working application. It is only a guideline.Note

For more information about how to use the APIs available for Task Routing, see the Cisco Finesse Web
Services Developer Guide at https://developer.cisco.com/site/finesse/.

Procedure

Step 1 Download the sample TaskManagement Gadget application (TaskManagementGadget-x.x.zip) fromDevNet:
https://developer.cisco.com/site/task-routing/.

Step 2 Read the sample application's readme.txt file to complete the prerequisites and use the sample application.

For more information about uploading third-party gadgets to the Finesse server, see the "Third Party Gadgets"
chapter in the Cisco Finesse Web Services Developer Guide at https://developer.cisco.com/site/finesse/.

For more information about adding third-party gadgets to the Finesse desktop, see the "Manage Third-Party
Gadgets" chapter in the Cisco Finesse Administration Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/finesse/tsd-products-support-series-home.html.

Task Routing Reporting
Cisco Unified Intelligence Center CCE reports include data for voice calls and nonvoice Task Routing tasks.

You can filter these All Fields and Live Data report templates by Media Routing Domain:

• Agent Real Time

• Agent Skill Group Real Time

• Enterprise Skill Group Real Time

• Peripheral Skill Group Real Time All Fields

• Precision Queue Real Time All Fields

• Agent Precision Queue Historical All Fields

• Agent Skill Group Historical All Fields

• Peripheral Skill Group Historical All Fields

• Precision Queue Abandon Answer Distribution Historical

• Precision Queue Interval All Fields

• Skill Group Abandon-Answer Distribution Historical

• Precision Queue - Live Data

• Skill Group - Live Data
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See the Reporting Concepts for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/
en/us/support/customer-collaboration/unified-contact-center-enterprise/products-user-guide-list.html for
information about multichannel reporting data.
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C H A P T E R 14
Unified Communications Manager Extension
Mobility

• Capabilities, on page 151
• Configuration, on page 152

Capabilities
Extension Mobility is a Unified Communications Manager feature that you can use in Unified CCE. The
feature enables users to temporarily configure a phone as their own by logging in to that phone. Once a user
logs in, the phone adopts the individual user device profile information, including line numbers, speed dials,
services links, and other user-specific properties of a phone.

Cisco Extension Mobility (EM) works on phones that are located within the same Cisco Unified
Communications Manager cluster. Cisco Extension Mobility Cross Cluster (EMCC) works on phones that
are located in different Cisco Unified Communications Manager clusters.

The main documentation on this feature is in the Unified CommunicationsManager documentation. For more
information, see the following sources:

SourcesInformation Type

Cisco Collaboration System Solution Reference Network Designs at
https://www.cisco.com/c/en/us/support/unified-communications/
unified-communications-manager-callmanager/
products-implementation-design-guides-list.html

Design considerations

Feature Configuration Guide for Cisco Unified Communications
Manager at https://www.cisco.com/c/en/us/support/
unified-communications/unified-communications-manager-callmanager/
products-maintenance-guides-list.html

Feature description and
configuration

https://developer.cisco.com/site/extension-mobility/Extension Mobility API
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Configuration
You configure EM and EMCC in the Cisco Unified CommunicationsManager. Take into account the following
interactions between Unified CCE and Unified Communications Manager for successful implementation of
EM and EMCC within a Unified CCE solution:

• For Unified CCE configurations with multiline agent phone line control on the PG, configure all directory
numbers for the user profile in Cisco Unified Communications Manager as follows:

ValueSetting

2Maximum Number of Calls

1Busy Trigger

• For Unified CCE configurations with single-line agent phone line control on the PG, configure the
secondary lines (but not the primary ACD line) for the directory number of the user profile in Cisco
Unified Communications Manager as follows:

ValueSetting

4Maximum Number of Calls

2Busy Trigger

• You cannot use phones with an IP Addressing Mode of IPv6 Only for Cisco Extension Mobility. If
you want to use Cisco Extension Mobility with the phone, you must configure the phone with an IP
Addressing Mode of IPv4 Only or IPv4 and IPv6.

• Agents can log in to multiple devices, depending on the Intra-cluster Multiple Login Behavior service
parameter. You can set this parameter for EM implementations. EMCC implementations require that
you set this parameter for multiple logins.

If an agent fails to log out of a device, another agent who attempts to access that device gets a "shared
line" error. Follow these Unified Communications Manager configuration guidelines to avoid shared
line errors:

• For EM implementationswith hard phones, set the Intra-cluster Multiple Login BehaviorExtension
Mobility service parameter to "Auto Logout".

• For EM implementations with a mix of hard and IP phones and for all EMCC implementations,
limit the time that an agent can remain logged in to a device. Set the Intra-cluster Maximum
LoginTime service parameter to the typical time that an agent remains logged in to a device during
a shift.

For more information on ExtensionMobility with Unified CCE, seeUCCE Integration with CM Configuration
Example at https://www.cisco.com/c/en/us/support/docs/customer-collaboration/
unified-contact-center-enterprise/117777-config-ucce-00.html.
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C H A P T E R 15
Webex Experience Management

• Experience Management Overview, on page 153
• Experience Management Voice Survey, on page 154
• Provision Experience Management Service on Cloud Connect, on page 156
• Configure Post Call Survey in CVP, on page 156
• Configure HCS for CC for Experience Management Voice, SMS and Email Survey, on page 157
• Configure Expanded Call Variables, on page 157
• Upload Audio Files for Questions in Experience Management, on page 159
• Configure Call Type, Dialed Number, and Survey Association, on page 159

Experience Management Overview

To enable this feature in HCS for CC, install the following patches:

• ICM 12.5(1)_ES7

• CVP 12.5(1)_ES6

• Cloud Connect 12.5(1)ES1

• Finesse 12.5(1)ES2

Note

Cisco Webex Experience Management is a Customer Experience Management (CEM) platform that allows
you to see your business from your customers' perspective. To know more about Webex Expereince
Management, see https://xm.webex.com/docs/ccoverview/.

With Webex Experience Management, HCS for CC supports:

• Customer experience surveys - Set up and send surveys to customers, after an interaction, to collect
feedback about their interaction.

• Experience Management Post Call Survey

• Customer Experience Journey (CEJ) gadget - Displays all the past survey responses from a customer in
a chronological list. The agent and supervisor use this gadget to gain context about the customers past
experiences with the business and engage with them appropriately.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
153

https://xm.webex.com/docs/ccoverview/


• Customer ExperienceAnalytics (CEA) gadget - Displays the overall experience of the customer interaction
with agents using industry-standard metrics such as NPS, CSAT, and CES or other KPIs tracked within
Experience Management. This gadget is available for agents and supervisors.

Experience Management Voice Survey
Experience Management post-call survey is used to determine whether the customers are satisfied with their
voice call experiences. You can configure Experience Management to initiate this survey when an agent
disconnects from the caller. The survey can be done in three modes—voice, SMS, or email.

The CCE script enables or disables voice call survey for each call by testing for conditions and setting an
expanded call variable that controls Experience Management. For example, the script can invoke a prompt
that asks callers whether they want to participate in a survey. Based on the caller's response, the script sets
the expanded call variable that controls whether the call gets transferred to the voice call survey Dialed Number.

You can send post call survey links through email or SMS also. After every call, the customer is provided
with a choice to participate in the survey and answer few questions over email or their phone. For more
information on how to configure or to associate the survey, refer to the section Configure HCS for CC for
Experience Management Voice, SMS and Email Survey, on page 157 .

The Experience Management Post Call Survey call works just like a regular call from the Unified CCE point
of view. Scripts are invoked, CVP refers the call to ExperienceManagement, and the customer uses the keypad
on a phone to respond to questions asked during the survey. During ExperienceManagement Post Call Survey,
the call context information is retrieved from the original customer call.

Experience Management supports G.711 u-law and G.711 a-law codecs.Note

Experience Management Task Flow
To enable Experience Management Post Call Survey in Cisco HCS for CC, follow this task flow:

Procedure

Step 1 Contact your Cisco representative to purchase Experience Management license. After the purchase, you need
to provide relevant information about your organization to Experience Management Activation Team. To
know more about the information that will be collected, see Prerequisites.

Step 2 Experience Management Activation Team performs the following actions:

a. Creates accounts and provisions the same.

b. Creates default spaces and metric groups for your accounts. To know more about creating spaces, see
Space Creation.

c. Creates standard questionnaires for Experience Management Post Call Survey and publishes the same.
To know more about creating questionnaires, see Questionnaires.
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Step 3 After creating and provisioning the account, youwill receive handover emails from the ExperienceManagement
Activation Team. The email contains credentials and other essential information for your account. To know
more about provisioning details, see Handover.

Step 4 Initially, Spaces and Widgets are created by the Experience Management provisioning team. To know more
about the different default Widgets, how to export and derive meaningful insights from them, see Experience
Management Gadgets.

To know how to configure additional Widgets in Experience Management, see Experience Management
Gadgets.

Step 5 Ensure that the Cloud Connect publisher and subscriber are installed. For more information, see the Create
Golden Template for Cloud Connect section in Cisco Hosted Collaboration Solution for Contact Center
Configuration Guide at https://www.cisco.com/c/en/us/support/unified-communications/
hosted-collaboration-solution-contact-center/products-installation-and-configuration-guides-list.html

Step 6 Provision ExperienceManagement service using CLI on Cloud Connect. For more information, see Provision
Experience Management Service on Cloud Connect, on page 156.

Step 7 Configure Cloud Connect in Operations Console (NOAMP). For details see the sectionConfigure CVP Devices
for Cloud Connect in Administration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/
c/en/us/support/customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

Step 8 Configure Post Call Survey in CVP. For more information, see Configure Post Call Survey in CVP, on page
118.

Step 9 Import the following certificates to the CVP Server:

• Cloud Connect certificate

• Experience Management certificate

For details, see the sections Import Cloud Connect Certificate to Unified CVP Keystore and Import Experience
Management Certificate to Unified CVP Call Server in Configuration Guide for Cisco Unified Customer
Voice Portal at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

Step 10 Ensure that the threshold properties (in ivr.properties and sip.properties files) and proxy settings are configured
in CVP for ExperienceManagement. For details, see the sectionWebex Experience Management Configuration
in Configuration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html.

Step 11 Configure HCS for CC Experience Management. For more information, see the topic Configure HCS for CC
for Experience Management Voice, SMS and Email Survey, on page 157.

Step 12 Configure Dialed Number and Call Type for Incoming Call and Experience Management post call survey
routing script. For more information, see Configure Call Type, Dialed Number, and Survey Association, on
page 159.

Step 13 Modify CCE scripts. For more information, see Modify CCE Scripts for Experience Management Voice, SMS
and Email Surveys in Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise
at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-user-guide-list.html.

Associate the CCE script with the Call Type created in the previous step.

Step 14 Provision Cloud Connect on Cisco Finesse. For more information, see the Cloud Connect Server Settings
topic at the Cisco Finesse Administration Guide.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
155

Webex Experience Management
Experience Management Task Flow

https://xm.webex.com/docs/ccactivation/
https://xm.webex.com/docs/ccgadgets/
https://xm.webex.com/docs/ccgadgets/
https://xm.webex.com/docs/ccgadgets/
https://xm.webex.com/docs/ccgadgets/
https://www.cisco.com/c/en/us/support/unified-communications/hosted-collaboration-solution-contact-center/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/unified-communications/hosted-collaboration-solution-contact-center/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-user-guide-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-user-guide-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/products-maintenance-guides-list.html


Step 15 Add Experience Management gadgets into Finesse desktop layout. For more information, see Cisco Webex
Experience Management Gadgets.

Provision Experience Management Service on Cloud Connect
Provision Experience Management service using the following CLI on Cloud Connect.
set cloudconnect cherrypoint config

For more commands related to Experience Management service, see the Cloud Connect CLI section in the
Cisco Unified Contact Center Enterprise Installation and Upgrade Guide.

The partner hosted module which is a part of Experience Management Invitations solution is required to send
surveys to customers over emails and SMS.

For information about Partner Hosted Module Architecture refer to https://xm.webex.com/docs/cxsetup/
guides/partnerarchitecture/

For information about how to provision the infrastructure required to deploy the partner hosted components
of the ExperienceManagement Invitationsmodule, see https://xm.webex.com/docs/cxsetup/guides/partnerinfra/
.

For information about how to deploy the partner hosted components on the ExperienceManagement Invitations
module once the infrastructure is provisioned, see https://xm.webex.com/docs/cxsetup/guides/
partnerdeployment/.

Configure Post Call Survey in CVP
Complete the following procedure to configure Post Call Survey in Unified CVP.

Procedure

Step 1 Log in to the Unified CVP Operations Console and choose System > Dialed Number Pattern.
Step 2 Enter the following configuration settings to associate incoming dialed numbers with survey numbers:

• Dialed Number Pattern - Enter the appropriate dialed number.

The incoming Dialed Number for calls being directed to a Post Call Survey Dialed. This is the Dialed
Number you want to redirect to the survey.

• Enable Post Call Survey for Incoming Calls - Select to enable post call survey for incoming calls.
• Survey Dialed Number Pattern - Enter the dialed number of the Post Call Survey. This is the dialed
number to which the calls should be transferred to after the call flow is completed.

• Click Save to save the Dialed Number Pattern.

Step 3 Click Deploy to deploy the configuration to all Unified CVP Call Server devices.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.5(1)
156

Webex Experience Management
Provision Experience Management Service on Cloud Connect

https://xm.webex.com/docs/ccgadgets/
https://xm.webex.com/docs/ccgadgets/
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-installation-guides-list.html
https://xm.webex.com/docs/cxsetup/guides/partnerarchitecture/
https://xm.webex.com/docs/cxsetup/guides/partnerarchitecture/
https://xm.webex.com/docs/cxsetup/guides/partnerinfra/
https://xm.webex.com/docs/cxsetup/guides/partnerdeployment/
https://xm.webex.com/docs/cxsetup/guides/partnerdeployment/


Configure HCS for CC for Experience Management Voice, SMS
and Email Survey

Refer to the following procedures to enable the Experience Management voice, SMS and email survey:

• Configure Expanded Call Variables, on page 157

• Upload Audio Files for Questions in Experience Management, on page 159

• Configure Call Type, Dialed Number, and Survey Association, on page 159

• Associate Survey to Call Type in Unified CCE Admin, on page 160

Configure Expanded Call Variables
Procedure

Step 1 In the Configuration Manager menu, select Tools > List Tools > Expanded Call Variables List.
The Expanded Call Variables List window appears.

Step 2 Click Retrieve to view the list of existing ECC variables.
Step 3 Check if the user.microapp.isPostCallSurvey variable exists. If the variable does not exist, do the following

to create a new variable:
a) Click Add.
b) In the Attributes tab that appears, enter user.microapp.isPostCallSurvey in the Name field.
c) Set Max Length to 1.
d) Check the Enabled check box.
e) Click Save.

When your CCE routing scripts starts, the Post Call Survey field is enabled by default even if
user.microapp.isPostCallSurvey has not yet been set in the script. You can turn off Post Call Survey field
in the script by setting user.microapp.isPostCallSurvey to n. You can later enable Post Call Survey in the
same path of the script by setting this variable to y.

To enable Experience Management, user.microapp.isPostCallSurvey must be set to y.Note

Step 4 Check if the user.CxSurveyInfo variable exists. If the variable does not exist, do the following to create a
new variable:
a) Click Add.
b) In the Attributes tab that appears, enter user.CxSurveyInfo in the Name field.
c) Set Max Length to 120.
d) Check the Enabled check box.

Step 5 Click Save.
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The newly created ECC variables are added to the default payload list. If you want to save the
ECC variables to a different payload list, in the Configuration Manager, navigate to Tools >
List Tools > Expanded Call Variable Payload List and add the ECC variables to the payload
list of your choice.

Note

Step 6 Populate the POD. ID variable.
For more information on populating this variable, refer to the topic Configure POD.ID.

Step 7 Restart the active VRU PG (side A or B) to register the new ECC variable.
If the ECC variable already exists, you can skip this step.

The user.microapp.isPostCallSurvey setting takes effect on Unified CVP only when it receives
a connect or temporary connect message. If you do not want the survey to run, without first
reaching an agent (such as 'after hours of treatment'), set the isPostCallSurvey to n before the
initial 'Run script request'.

Note

Configure POD.ID
Cisco provided variables are predefined, but for POD.ID, the maximum length should be set to 120.

You can modify the variables only if you have the edit access.

Populate the value in the script with multiple attributes in a key-value pair format. Each key-value pair is
seperated with a semi-colon. The following table displays the supported attributes:

Table 5: Variables and their descriptions

ApplicableDescriptionAttribute

Chat and Email surveys for Digital
Channels

Unique ID for a customer across
multiple channels

cc_CustomerId

Email survey for voice channelEmail ID of the caller for Email
surveys

Email

SMS survey for voice channelPhone number for SMS surveysMobile

Email, SMS, and Voice surveys for
voice channel

Language of the survey

For the list of supported languages,
refer to the Webex Experience
Management documentation at
https://xm.webex.com/docs/user/
getting-help/
#cloudcherry-language-support

cc_language

Email, SMS, and Voice surveys for
voice channel

Whether to opt in or opt out of the
survey

Optin

Example: cc_CustomerId=xxx;Email=xx;Mobile=xxx;cc_langauge=xxx;Optin=yes/no
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For more information on Expanded Call Context Variables, see the chapter Configure Variables in the
Configuration Guide for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/
support/customer-collaboration/unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html.

You can also configure POD.ID from CVP Call Studio. For more information, refer to the topic Configure
Call Studio App Data Format in the Scripting and Media Routing Guide for Cisco Unified ICM/Contact
Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

Upload Audio Files for Questions in Experience Management
Experience Management allows you to upload the audio files for post call survey.

To run post-call voice survey, you must either configure Text-To-Speech(TTS) in the voice browser or upload
audio prompts in Experience Management.

Note

Create and configure the questionnaires in Experience Management for sending IVR surveys to the customer.
For more information on Experience Management, refer to https://xm.webex.com/docs/ccoverview/

For more information on how to create and modify the questionnaires, refer to https://xm.webex.com/docs/
cxsetup/questionnaires/.

Configure Call Type, Dialed Number, and Survey Association
Procedure

Step 1 In Configuration Manager, navigate to Tools > List Tools > DialedNumber/Script Selector List to create
a Call Type.

Step 2 In DialedNumber/Script Selector List create Incoming Dialed Number and Post Call Survey Dialed
Number.

For more information on how to create a PCS Dialed Number, refer to the section Configure ICM for Post
Call Survey in Configuration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/c/en/
us/support/customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.

Step 3 Click Save. You will be re-directed to the Configuration Manager window.
Step 4 In Configuration Manager, navigate to Tools > List Tools >Call Type List.
Step 5 Associate the survey with the last call type before the call is first connected to an agent.

For more information, refer to the topic Associate Survey to Call Type in Unified CCE Admin, on page 160.
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Associate Survey to Call Type in Unified CCE Admin
You can associate the Call Type to the survey only if you have added Cloud Connect in the Inventory page
and configured the survey in Webex Experience Management portal.

Only one survey can be associated to a Call Type.Note

Call Types are created and managed in Configuration Manager tool and the survey is associated using the
CCE Admin tool.

Procedure

Step 1 In Unified CCE Administration, navigate to Overview > Call Settings > Route Settings > Call Types.

The list of all the Call Types are displayed.

For more information on Call Types, refer to the Help in ConfigManager > List Tools > Call Types.

Step 2 Click on the Call Type which you want to associate to the Survey. Associate the survey with the last call type
before the call is first connected to an agent.

Step 3 Select the Enable Experience Management check box to associate the Webex Experience Management
survey.

The Experience Management tab is enabled with the following options:

• Inline Survey (post-call voice survey)

• Deferred Survey (post-call Email and SMS survey)

Step 4 Click on the magnifying glass icon, and the configured surveys will be populated in the pop-up window.
Step 5 Select the survey from the pop-up window and click Save.
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C H A P T E R 16
Webex Experience Management Digital Channel
Survey

• Overview, on page 161
• Digital Channel Survey , on page 162
• Provision Cloud Connect for Digital Channel Survey, on page 163
• Configure HCS for CC for Digital Channel Survey , on page 163
• Configure Expanded Call Variables , on page 164
• Configure Call Type, Dialed Number, and Survey Association, on page 165

Overview

To enable this feature in HCS for CC, install the following patches:

• ICM 12.5(1)_ES7

• Cloud Connect 12.5(1)ES1

• Finesse 12.5(1)ES3

• ECE 12.5(1) ES1

Note

Digital Channel Survey is initiated when the agent responds to an email/chat from a customer using the
Enterprise Chat and Email gadget. Cisco Webex Experience Management is a Customer Experience
Management (CEM) platform that allows you to see the business from your customers perspective. It provides
customer journey experience using the CEJ omni-channel gadget. To learn more about Webex Experience
Management, see https://xm.webex.com/docs/ccoverview/.

With Webex Experience Management, HCS for CC supports:

• Customer experience surveys - Set up and send surveys to customers, after an interaction, to collect
feedback about their interaction.

• Customer Experience Journey (CEJ) gadget - Displays all the past survey responses from a customer in
a chronological list. The agent and supervisor use this gadget to gain context about the customers past
experiences with the business and engage with them appropriately.
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• Customer ExperienceAnalytics (CEA) gadget - Displays the overall experience of the customer interaction
with agents using industry-standard metrics such as NPS, CSAT, and CES or other KPIs tracked within
Experience Management. This gadget is available for agents and supervisors.

Digital Channel Survey
Email and chat inline surveys are used to determine whether customers are satisfied with their interaction
with the agent in resolving their query over an email or chat. The feedback collected through the survey is
used by the agents to gain context about the customer in their subsequent interactions and to also improve
their own performance. You can configure Enterprise Chat and Email to initiate this survey when the agent
sends an email or terminates a chat conversation with a customer. The survey is sent inline in the agents email
response to customers who contact them via email, and within the chat window for customers who contact
them via chat.

Digital Channel Survey Task Flow (Email/Chat)
To enable Experience Management inline surveys with Enterprise Email and Chat in Cisco HCS for CC,
perform the following procedure:

Procedure

Step 1 Contact your Cisco representative to purchase Experience Management license. Provide relevant information
about your organization to Experience Management Activation Team. To know more about the information
that will be collected, see Prerequisites.

Step 2 Experience Management Activation Team performs the following actions:
a) Creates account and provisions the same.
b) Creates default spaces and metric groups for your accounts. To know more about creating spaces, see

Space Creation.
c) Creates default questionnaires in Expereince Management suited for inline email and chat survey. To

know more about creating your own questionnaires or editing the default ones, see Questionnaires.

Step 3 After creating and provisioning the account, youwill receive handover emails from the ExperienceManagement
Activation Team. The email contains credentials and other essential information for your account. To know
more about provisioning details, see Handover.

Step 4 Initially, Spaces and Widgets are created by the Experience Management provisioning team. To know more
about the different default Widgets and how to export and derive meaningful insights from them, see Cisco
Webex Experience Management Gadgets.

To know how to configure other Widgets in Experience Management, see Basic Widget and Composite
Widgets.

Step 5 Provision ExperienceManagement service using CLI on Cloud Connect. For more information, see Provision
Cloud Connect for Digital Channel Survey, on page 163.

Step 6 Ensure that the Enterprise Chat and Email (ECE) is installed and configured, see the Webex Experience
Manager Integration in Enterprise Chat and Email Administrator’s Guide to Administration Console at
https://www.cisco.com/c/en/us/support/contact-center/enterprise-chat-email-12-5-1/model.html.
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Step 7 Configure HCS for CC Experience Management integration. For more information, see Configure HCS for
CC for Digital Channel Survey , on page 163.

Step 8 Configure Call Type and Dialed Number. For more information, see Configure Call Type, Dialed Number,
and Survey Association, on page 165.

Step 9 Modify CCE Scripts. For more information, see Modify CCE Scripts for Experience Management Digital
Channel Surveys in Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise
at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-user-guide-list.html.

Associate the CCE script with the Call Type created in the previous step.

Step 10 Provision Cloud Connect on Cisco Finesse. For more information, see the Cloud Connect Server Settings
topic at the Cisco Finesse Administration Guide.

Step 11 Add Experience Management gadgets into Finesse desktop layout. For more information, see Cisco Webex
Experience Management Gadgets.

Provision Cloud Connect for Digital Channel Survey
Before provisioning Cloud Connect for Experience Management service, ensure to setup and enable Cloud
Connect. For more information, see the Cloud Connect Administration section in Administration Guide for
Cisco Unified Contact Center Enterprise

Ensure that you have installed the self-signed certificates for Cloud Connect. For more information, see the
Self-Signed Certificates section in the Cisco Unified Contact Center Enterprise Installation and Upgrade
Guide.

Note

Provision Experience Management service using the following CLI on Cloud Connect.
set cloudconnect cherrypoint config

For more commands related to Experience Management service, see the Cloud Connect CLI section in the
Cisco Unified Contact Center Enterprise Installation and Upgrade Guide.

Configure HCS for CC for Digital Channel Survey
Refer to the following procedures to enable the Experience Management email and chat survey:

• Configure Expanded Call Variables , on page 164

• Configure Call Type, Dialed Number, and Survey Association, on page 165

• Associate Survey to Call Type in Unified CCE Admin, on page 166
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Configure Expanded Call Variables
Procedure

Step 1 In the Configuration Manager menu, select Tools > List Tools > Expanded Call Variable List.
The Expanded Call Variable List window appears.

Step 2 Click Retrieve to view the list of existing ECC variables.
Step 3 Check if the user.microapp.isPostCallSurvey variable exists. If the variable does not exist, do the following

to create a new variable:
a) Click Add.
b) In the Attributes tab that appears, enter user.microapp.isPostCallSurvey in the Name field.
c) Set Max Length to 1.
d) Check the Enabled check box.
e) Click Save.

When your CCE routing scripts starts, you can turn off Post Call Survey field in the script by setting
user.microapp.isPostCallSurvey to n. You can later enable Post Call Survey in the same path of the script
by setting this variable to y.

In the script, set the user.microapp.isPostCallSurvey before routing it to the agent.Note

To enable Experience Management, user.microapp.isPostCallSurvey must be set to y.Note

Step 4 Check if the user.CxSurveyInfo variable exists. If the variable does not exist, do the following to create a new
variable:
a) Click Add.
b) In the Attributes tab that appears, enter user.CxSurveyInfo in the Name field.
c) Set Max Length to 80.
d) Check the Enabled check box.

Step 5 Click Save.

The newly created ECC variables are added to the default payload list. If you want to save the
ECC variables to a different payload list, in the Configuration Manager, navigate to Tools >
List Tools > Expanded Call Variable Payload List and add the ECC variables to the payload
list of your choice.

Note

You can use several ECC payloads in the same call flow, but only one ECC payload has scope
at a given moment. For more information, see ECC Payloads sections in Configuration Guide
for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html

Note

Step 6 Populate the POD. ID variable.
For more information on populating this variable, refer to the topic Configure POD.ID , on page 165.
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Configure POD.ID
Cisco provided variables are predefined, but for POD.ID, the maximum length should be set to 120. Enable
the POD.ID variable to edit its length.

You can modify the variables only if you have the edit access.

Populate the value in the script with multiple attributes in a key-value pair format. Each key-value pair is
seperated with a semi-colon. These attributes are sent to the Webex Experience Management as prefills when
ECE initiates the survey. The following table displays the supported attributes:

Table 6: Variables and their descriptions

ApplicableDescriptionAttribute

Chat and Email surveys for Digital
Channels

Unique ID for a customer across
multiple channels

cc_CustomerId

Chat and Email surveys for Digital
Channels

Email ID of the customer for Email
survey across multiple channels

Email

Chat and Email surveys for Digital
Channels

Phone number for Chat surveysMobile

Example: cc_CustomerId=xxx;Email=xx;Mobile=xxx;

For more information on setting the ECC variables used in the example, seeModify CCE Scripts for Experience
Management Digital Channel Surveys in Scripting and Media Routing Guide for Cisco Unified ICM/Contact
Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

For more information on Expanded Call Context Variables, see the chapter Configuring Variables in the
Configuration Guide for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/
support/customer-collaboration/unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html.

Configure Call Type, Dialed Number, and Survey Association
Procedure

Step 1 In ICM Configuration Manager, navigate to Tools > List Tools > Call Type List to create a Call Type.
Step 2 Associate the survey with the last call type before the email/chat is handled by the agent.

For more information, refer to the topic Associate Survey to Call Type in Unified CCE Admin, on page 166.

Step 3 Create a Dial Number in ICM Configuration Manager and associate it with Call type (created in Step 1) for
email and chat.
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Associate Survey to Call Type in Unified CCE Admin
You can associate the survey to the Call Type only if you have added Cloud Connect to the Inventory page
in CCE Admin and configured the survey in Webex Experience Management portal.

Only inline surveys can be associated to a Call Type associated with digital channels.Note

Call Types are created and managed in Configuration Manager tool and the survey is associated using the
CCE Admin tool.

Procedure

Step 1 In Unified CCE Administration, navigate to Overview > Call Settings > Route Settings > Call Type.

The list of all the Call Type are displayed.

For more information on Call Types, refer to the Help in Configuration Manager > Tools > List Tool >
Call Type List.

Step 2 Click on the Call Type which you want to associate to the Survey.
Step 3 Select the Enable Experience Management check box to associate the Webex Experience Management

survey.
a) The Experience Management tab is enabled with the following options:

• Inline Survey

• Deferred Survey

Step 4 Select Inline Survey for email and chat.

• Click on themagnifying glass icon, and the configured surveys will be populated in the pop-up window.

Step 5 Select the survey from the pop-up window and click Save.
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C H A P T E R 17
Whisper Announcement

• Capabilities, on page 167
• Configure Whisper Announcement, on page 169
• Reporting and Serviceability, on page 176

Capabilities
Whisper Announcement plays a brief, prerecorded message to an agent just before the agent connects with
each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ring tone
patterns) while the announcement plays.

The content of the announcement can contain information about the caller that helps prepare the agent to
handle the call. The information can include caller language preference, choices the caller made from a menu
(Sales, Service), customer status (Platinum, Gold, Regular), and so on.

After Whisper Announcement is enabled, the played announcements are specified in the call routing scripts.
The determination of which announcement to play is controlled in the script and is based on various inputs,
such as the dialed number, a customer ID look up in your customer database, or selections you made from a
VRU menu.

While a Whisper Announcement Is Playing
Only one Whisper Announcement can play for each call. While a Whisper Announcement is playing, you
cannot put the call on hold, transfer, conference, or release the call, or request supervisor assistance. These
features become available again after the whisper is complete.
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Whisper Announcement Call Flows
Figure 18: Whisper Announcement Call Flow

The standard call flow with Whisper Announcement is as follows:

1. Incoming call arrives at CVP from the carrier.

2. CVP sends the call to Unified CCE.

3. Unified CCE instructs CVP to queue the call.

4. CVP sends the call to the Voice Browser.

5. Unified CCE sends the agent label with the whisper announcement prompt.

6. CVP sends the call to Unified CM.

7. Unified CM sends the call to the agent phone.

8. The caller continues to hear ringback. The agent hears the whisper announcement.

9. When the whisper announcement ends, the caller connects to the agent.

Whisper Announcement Design Impacts
Whisper Announcement has these limitations:

• Announcements do not play for outbound calls made by an agent. The announcement plays for inbound
calls only.

• For Whisper Announcement to work with agent-to-agent calls, use the SendToVRU node before you
transfer the call to the agent. Transfer the call to Unified CVP before you transfer the call to another
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agent. Then, Unified CVP can control the call and play the announcement, regardless of which node
transfers the call to Unified CVP.

• Announcements do not play when the router selects the agent through a label node.

• CVP Refer Transfers do not support Whisper Announcement.

• Whisper Announcement supports Silent Monitoring. However, for Unified Communications
Manager-based SilentMonitoring, supervisors cannot hear the announcements themselves. The supervisor
desktop dims the Silent Monitor button while an announcement plays.

• Only one announcement can play for each call. While an announcement plays, you cannot put the call
on hold, transfer, or conference; release the call; or request supervisor assistance. These features become
available again after the announcement completes.

• The codec settings forWhisper Announcement recording and the agent's phone must match. For example,
if Whisper Announcement is recorded in G.711 ALAW, the phone must also be at G.711 ALAW. If
Whisper Announcement is recorded in G.729, the phone must support or connect using G.729.

• In an IPv6-enabled environment, Whisper Announcement might require extra Media Termination Points
(MTPs).

Whisper Announcement Media Files
You store and serve your Whisper Announcement audio files from the Unified Contact Center Enterprise
(Unified CCE) media server. This feature supports only the wave (.wav) file type. The maximum play time
for a Whisper Announcement is subject to a timeout. Playback terminates at the timeout regardless of the
actual length of the audio file. The timeout is 15 seconds. In practice, you may want your messages to be
much shorter than that, 5 seconds or less, to shorten your call-handling time.

Whisper Announcement with Transfers and Conferences
When an agent transfers or starts a conference call to another agent, the second agent hears an announcement
if the second agent's number supports Whisper Announcement. For consultative transfers or conferences,
while the announcement plays, the caller hears whatever generally plays during hold. The first agent hears
ringing. In the case of blind transfers, the caller hears ringing while the announcement plays.

Whisper Announcement Sizing Considerations
The impact ofWhisper Announcement on solution component sizing is not as significant as the impact caused
by Agent Greeting.

Configure Whisper Announcement
Complete the following procedures for Whisper Announcement configuration:

• Configure Gateway, on page 170

• Configure Unified CVP, on page 170

• Configure Unified CCE, on page 172
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Configure Gateway
Gateway uses two different dialed numbers for Whisper Announcement.

• 91919191 number calls the ring tone that the caller hears while the whisper plays to the agent

• 9191919100 number calls the whisper itself

Configure a dial peer for incoming number 9191919100 and 91919191 as follows:

dial-peer voice 919191 voip
description CVP SIP ringtone dial-peer
service ringtone
incoming called-number 9191T
voice-class sip rel1xx disable
dtmf-relay rtp-nte
codec g711ulaw
no vad

Configure Unified CVP

Create Whisper Announcement Audio Files
You must create audio files for each different Whisper Announcement you want to use on your system; for
example, “Sales, English” or “Soporte Técnico en Español.” Create the files using the recording tool of your
choice.

When recording your files, follow these rules:

• The media files must be in wave (.wav) format. Your wave files must match Unified CVP encoding and
format requirements (G729, CCITT G.711 A-Law and U-law 8 kHz, 8 bit, mono).

• To avoid cutting off files when they are played, make sure they do not exceed theWhisper Announcement
play limit (15 seconds).

• Test your audio files. Ensure that they are not cut off and that they are consistent in volume and tone.

• To reduce the likelihood of scripting errors, decide ahead of time on a file-naming convention that is
easy for you and others to remember. For example, en_sales.wav, sp_support.wav.

Deploy Whisper Announcement Audio Files to Media Server
Deploy your whisper audio files to your Unified CVP media server using whatever file-transfer method you
prefer. The most important consideration is where on the server to place the files. HTTP requests for media
server audio files are constructed as
http://<media_server>/<locale_directory>/<application_directory>/<file_name>.

The CVP defaults for the locale and application directories are en-us/app. Unified CCE automatically
adds en-us/app to the server name when making HTTP requests for media files.

For example, if:

• The script node that defines the media server has a value of http://myserver.mydomain.com
and
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• The script node that defines the audio file to play has a value of en_sales.wav

Then the HTTP request for the file is automatically constructed as
http://myserver.mydomain.com/en-us/app/en_sales.wav

If you store your files in a different locale and application directory, your routing scripts must include variable
nodes that define those alternate locations. Make note of the directories in which you place your files and
communicate the locations to your script authors.

Make sure that the directories in which you deploy your files have the appropriate permissions to allow Read
access.

CVP with the Streaming Audio (Helix) and Whisper Announcement

You must set the user.microapp.media_server variable, to point to the whisper announcement .wav file, for
the CVP Whisper Announcement feature to work while Streaming Audio feature (using Helix) is also on.
This is achieved by setting the Call.WhisperAnnouncement variable to the complete URL of the whisper
announcement wav file. The Call.WhisperAnnouncement variable should be put in using the
http://<VXMLserverip>:7000/CVP/audio/XXX.wav URL format.

Using a Default Media Server

Optionally, CVP lets you define a default media server. (You do this in the CVP Operations Console; see
your CVP documentation for more information.) If a default media server is defined in CVP, script authors
need not identify the media server in their call routing scripts provided the files that they request are available
from that server.

Configure the Whisper Announcement Service Dialed Numbers
Unified CVP uses two different dialed numbers for Whisper Announcement:

The first number calls the ring tone service that the caller hears while the whisper plays to the agent. The
Unified CVP default for this number is 91919191.

The second number calls the whisper itself. The Unified CVP default for this number is 9191919100.

For Whisper Announcement to work, your dial number pattern must cover both of these numbers. The easiest
way to ensure coverage is through the use of wild cards such as 9191*. However, if you decide to use an exact
dialed number match, then you must specify both 91919191 and 9191919100.

Configure Dialed Numbers
You configure the dialed numbers for Whisper Announcement in the Unified CVP Operations Console at
System > Dialed Number Pattern > Add new. For the Dialed Number Pattern Types, select Enable Local
Static Route. Once Enable Local Static Route is checked, select either Route to Device or Route to SIP
Server Group for VXML gateways. Then save and deploy the dialed number.

It may be necessary to override the dialed number plan for the default Whisper DN, if the default DN conflicts
with the overall dial number plan.

Change the Whisper Announcement Default Dialed Number

To override the DN pattern from the SIP subsystem level in CVP OAMP:
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Procedure

Step 1 Select Device Management > Unified CVP Server.
Step 2 Select the Call Server on which to override the default whisper DN.
Step 3 Select the SIP tab.
Step 4 Override the default value of 91919191 configured under theDN on the Gateway to play the ringtone field.
Step 5 Click Save & Deploy.

Configure Unified CCE

Create Whisper Announcement Script
It is very important to deploy Whisper Announcement with the Call. Whisper Announcement variable and to
set .wav file in your Unified CCE routing scripts.

Figure 19: Whisper Announcement Script

Specify WhisperAnnouncement Call Variable
To include Whisper Announcement in a script, insert a Set Variable node that references the
WhisperAnnouncement call variable. The WhisperAnnouncement variable causes a whisper to play and
specifies the audio file it should use. Typically, you use a single whisper prompt for a single call type. As a
result, you use only one WhisperAnnouncement set node for each script. However, as needed, you can set
the variable at multiple places in your scripts to allow different announcements to play for different endpoints.
For example, for skills-based routing, you can specify the variable at each decision point used to select a
particular skill group or Precision Queue.
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Only one Whisper Announcement can play for each call. If a script references and sets the
WhisperAnnouncement variable more than once in a single path through a script, the last value to be set is
the one that plays.

Note

Use these settings in the Set Variable node for Whisper Announcement:

• Object Type: Call.

• Variable: Must use the WhisperAnnouncement variable.

• Value: Specify the filename of the whisper file. For example: “my_whisper.wav” or “my_whisper”.

• Specify the filename only, not its path.

• You must enclose the filename in quotation marks.

• The filename is not case sensitive.

• The filename cannot include spaces or characters that require URL encoding.

• The .wav extension is optional. If you omit it, Unified CVP adds it automatically in the HTTP
request.

Specify Whisper File Locale and Application Directories
CVP uses a default storage directory for media files: <web_server_root>/en-us/app. To take advantage of
this, Unified CCE call routing scripts automatically add “en-us/app,” to the server name when constructing
HTTP requests for media files. For example:

• If the script node that defines the media server has a value of “http://myserver.mydomain.com” and...

• The script node that defines which audio file to play has a value of “en_sales.wav,” then...

• The HTTP request for the file is automatically constructed as

http://myserver.mydomain.com/en-us/app/en_sales.wav

If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your
script that identifies the locale directory. Similarly, if your whisper files are stored in a different application
directory, you must add a Set Variable node that identifies that directory.

Specify Locale Directory

Use these settings in the Set Variable node to specify your locale directory:

• Object Type: Call.

• Variable: Must use the user.microapp.locale ECC variable.

• Value: Specify the directory name. For example: “pt-br,” You must enclose the path in quotes.

Specify Application Directory

Use these settings in the Set Variable node to specify your application directory:
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• Object Type: Call.

• Variable: Must use the user.microapp.app_media_lib ECC variable.

• Value: Specify the directory name. For example: to use a directory “wav_files” in place of the default
directory “app,” enter “wav_files.” To use a sub-directory “wav_files” “app,” enter “app/wav_files.”
You must enclose the path in quotes.

Variable Length for Media Server Locale and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the
values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of
“http://mysubdomain.mydomain.co.uk,” the string is 33 characters long. Therefore, the Maximum Length
setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you must increase
the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and
the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools
> Expanded Call Variables List.

Test Whisper Announcement File Path
To test the path to the whisper file that you defined in you script variables, enter the complete URL into a
browser. The .wav file should play. For example:

• If your script includes: default media server + default locale + default application directory + whisper.wav,
then the path is “http://<default_media_server>/en-us/app/whisper.wav”

• If your script includes: http://my_server.my_domain.com + default locale + “app/wav_files” +
whisper.wav, then the path is “http://my_server.my_domain.com/en-us/app/wav_files/whisper.wav”

Other Script Settings That Are Required for Whisper Announcement
These additional settings are required for Whisper Announcement to work:

• Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target an
agent. These include Queue (to Skill Group or Precision Queue), Queue Agent, Route Select, and Select.
If Target Requery is not enabled, the Whisper Announcement does not play.

Fail-Safe Timeout for Whisper Announcement in Unified CCE
Unified CVP sends one message to Unified CCE each time a Whisper Announcement begins and a second
message when the announcement ends. The time stamps from these messages are used to calculate Whisper
Announcement data in Unified CCE reports.

If Unified CVP fails to send a Whisper Announcement end message toUnified CCE, the following occurs:

• Unified CCE cannot accurately calculate the whisper length, thus skewing report data.
• The agent cannot control the call (for example, put it on hold or transfer it) because these controls are
disabled while a Whisper Announcement is playing.
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Whisper Announcement Sample Scripts
Unified CCE includes sample routing scripts that demonstrate Whisper Announcement. You can use them as
learning tools and as models for your own Whisper Announcement scripts. They are the following:

• WA.ICMS—This script plays a Whisper Announcement.

• WA_AG.ICMS—This script plays both a Whisper Announcement and an Agent Greeting to play on
the same call flow.

The script files are located in the c:\icm\bin directory. In Unified CCE Script Editor, they are installed
to the application root directory.

To use these scripts you must have a default media server configured in Unified CVP, and have the Whisper
file stored in the default location on the media server. For that reason, they do not include variables that specify
the media server, locale, or application directories.

Note

WA.ICMS Script

This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the desired
wave file and then queuing the call to a skill group or Precision Queue. After an agent is selected from the
skill group or Precision Queue and the call routed to the agent, the whisper plays to the agent.

WA_AG.ICMS Script

This script causes both a Whisper Announcement and an Agent Greeting to play.
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Import Sample Whisper Announcement Scripts

To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE
Script Editor. Follow this procedure to import the scripts:

Procedure

Step 1 Open Script Editor.
Step 2 Select File > Import Script and select the first of the two scripts to import.

In addition to importing the script, Script Editor tries to map imported objects. Some objects that are referenced
in the sample scripts, such as the external Network VRU scripts or the skill groups or Precision Queues, do
not map successfully. You must create these maps manually or change these references to point to existing
Network VRU scripts, skill groups, and Precision Queues in your system.

Step 3 Repeat steps 2 and 3 for the remaining script.

Reporting and Serviceability
Whisper time is not specifically broken out in Unified CCE reports. In agent, skill group, and Precision Queue
reports, the period during which the announcement plays is reported as Reserved agent state time. In the
Termination Call Detail records, it is treated as Ring Time.

Serviceability for Whisper Announcement includes system events to indicate reasons for Whisper
Announcement failures and counters to track the number of failed whisper events.

Component Failure and Whisper Announcement

Failure to Access CVP Media Server
If the connection to the CVP media server fails, or if a requested whisper audio file cannot be found, the call
proceeds without Whisper Announcement.
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Whisper Announcement in Agent Desktop Software
No configuration is needed to integrateWhisper Announcement with agent desktop software.While a whisper
is playing, software on the agent desktop shows the call in the Ring state. Desk phones show the call in the
Talking state.

Using Agent Greeting with Whisper Announcement
You can use Agent Greeting along with the Whisper Announcement feature. Consider the following when
you use them together:

• On the call, the Whisper Announcement always plays first before the greeting.

• To shorten your call-handling time, you may want to use shorter whispers and greetings than you might
if you were using either feature by itself. A long whisper followed by a long greeting means a long wait
before an agent handles a call.

• Usually, agents that use Whisper Announcement handle different types of calls: for example, "English,
Gold Member, Activate Card, Spanish, Gold Member, Report Lost Card, English, Platinum Member,
Account Inquiry." Ensure the greetings your agents record are generic enough to cover the range of
customer calls they handle.
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